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About VMware vCenter Server™ and Host
Management

vCenter Server and Host Management describes how to start and stop the VMware” vSphere Client components,
build your vSphere environment, monitor and manage the information generated about the components, and
set up roles and permissions for users and groups using the vSphere environment.

In addition, vCenter Server and Host Management provides brief introductions to the various tasks you can
perform within the system as well as cross-references to the documentation that describes all the tasks in detail.

vCenter Server and Host Management covers ESXi and vCenter Server.

Intended Audience

vCenter Server and Host Management is intended for system administrators who are experienced Windows or
Linux system administrators and who are familiar with virtual machine technology and datacenter operations.
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Updated Information

This vCenter Server and Host Management is updated with each release of the product or when necessary.

This table provides the update history of the vCenter Server and Host Management.

Revision Description

00787-02  ®m  Updated “Configure the vSphere Web Client Timeout Value,” on page 35 to fix error in filepath.
®  Upated “Configure Inventory Size for the VMware vCenter Server Appliance,” on page 73 to remove
incorrect task information.
B Updated “Migrate a Virtual Machine with Cross-Host Storage vMotion in the vSphere Web Client,” on
page 168 to clarify that disk format changes are preserved only if you select a different datastore.
000787-01 ®m “vMotion Shared Storage Requirements,” on page 153 has been updated to include a requirement to
maintain consistent LUN IDs for RDMs when using vMotion with RDMs.
B “Configure the vSphere Web Client to Bypass vCenter Single Sign On,” on page 35 has been added to
provide instructions for accessing vCenter Server 5.0 systems when vCenter Single Sign On in unavailable.
=

Updated the following topics to clarify that version 5.0.x vCenter Servers can only be linked with other 5.0.x
vCenter Servers, and 5.1.x vCenter Servers can only be linked with other 5.1.x vCenter Servers: “Linked
Mode Considerations for vCenter Server,” on page 78, “Linked Mode Prerequisites for vCenter Server,”
on page 77, and “Join a Linked Mode Group After Installation,” on page 79.

000787-00 Initial release.

VMware, Inc.
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vSphere Concepts and Features

VMware vSphere™ leverages the power of virtualization to transform datacenters into simplified cloud
computing infrastructures and enables IT organizations to deliver flexible and reliable IT services.

The two core components of vSphere are VMware ESXi™ and VMware vCenter Server™. ESXi is the
virtualization platform on which you create and run virtual machines. vCenter Server is a service that acts as
a central administrator for ESXi hosts that are connected on a network. vCenter Server allows you to pool and
manage the resources of multiple hosts. vCenter Server provides many features that allow you to monitor and
manage your physical and virtual infrastructure.

Additional vSphere components are available as plugins that extend the functionality of the vSphere product.
This chapter includes the following topics:

B “Virtualization Basics,” on page 15

B “Physical Topology of vSphere Datacenter,” on page 16

B “ySphere Software Components,” on page 17

B “ySphere Client Interfaces,” on page 19

B “ySphere Managed Inventory Objects,” on page 20

B “Optional vCenter Server Components,” on page 22

®  “yCenter Server Plug-Ins,” on page 23

Virtualization Basics

A virtual machine is a software computer that, like a physical computer, runs an operating system and
applications. The hypervisor serves as a platform for running virtual machines and allows for the consolidation
of computing resources.

Each virtual machine contains its own virtual, or software-based, hardware, including a virtual CPU, memory,
hard disk, and network interface card.

Software called the hypervisor is installed on the physical hardware in a virtualized datacenter, and acts as a
platform for virtual machines. ESXi is the hypervisor in a vSphere environment. The hypervisor provides
physical hardware resources dynamically to virtual machines as needed to support the operation of the virtual
machines. The hypervisor allows virtual machines to operate with a degree of independence from the
underlying physical hardware. For example, a virtual machine can be moved from one physical host to another,
or its virtual disks can be moved from one type of storage to another, without affecting the functioning of the
virtual machine.

VMware, Inc. 15
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Because virtual machines are decoupled from specific underlying physical hardware, virtualization allows you
to consolidate physical computing resources such as CPUs, memory, storage, and networking into pools of
resources that can be dynamically and flexibly made available to virtual machines. With appropriate
management software, such as vCenter Server, you can also use a number of features that increase the
availability and security of your virtual infrastructure.

Physical Topology of vSphere Datacenter

A typical VMware vSphere datacenter consists of basic physical building blocks such as x86 virtualization
servers, storage networks and arrays, IP networks, a management server, and desktop clients.

The vSphere datacenter topology includes the following components.

Compute servers

Storage networks and

arrays

IP networks

vCenter Server

Management clients

16

Industry standard x86 servers that run ESXi on the bare metal. ESXi software
provides resources for and runs the virtual machines. Each computing server
is referred to as a standalone host in the virtual environment. You can group a
number of similarly configured x86 servers with connections to the same
network and storage subsystems to provide an aggregate set of resources in
the virtual environment, called a cluster.

Fibre Channel SAN arrays, iSCSI SAN arrays, and NAS arrays are widely used
storage technologies supported by VMware vSphere to meet different
datacenter storage needs. The storage arrays are connected to and shared
between groups of servers through storage area networks. This arrangement
allows aggregation of the storage resources and provides more flexibility in
provisioning them to virtual machines.

Each compute server can have multiplephysical network adapters to provide
high bandwidth and reliable networking to the entire VMware vSphere
datacenter.

vCenter Server provides a single point of control to the datacenter. It provides
essential datacenter services such as access control, performance monitoring,
and configuration. It unifies the resources from the individual computing
servers to be shared among virtual machines in the entire datacenter. It does
this by managing the assignment of virtual machines to the computing servers
and the assignment of resources to the virtual machines within a given
computing server based on the policies that the system administrator sets.

Computing servers continue to function even in the unlikely event that
vCenter Server becomes unreachable (for example, if the network is severed).
Servers can be managed separately and continue to run the virtual machines
assigned to them based on the resource assignment that was last set. After
connection to vCenter Server is restored, it can manage the datacenter as a
whole again.

VMware vSphere provides several interfaces for datacenter management and
virtual machine access. These interfaces include VMware vSphere Client
(vSphere Client), vSphere Web Client for access through a web browser, or
vSphere Command-Line Interface (vSphere CLI).

VMware, Inc.



Chapter 1 vSphere Concepts and Features

Figure 1-1. VMware vSphere Datacenter Physical Topology
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vSphere Software Components

VMware vSphere is a suite of software components for virtualization. These include ESXi, vCenter Server, and
other software components that fulfill a number of different functions in the vSphere environment.

vSphere includes the following software components:

ESXi

vCenter Server

VMware, Inc.

A virtualization platform that you use to create the virtual machines as a set of
configuration and disk files that together perform all the functions of a physical
machine.

Through ESXi, you run the virtual machines, install operating systems, run
applications, and configure the virtual machines. Configuration includes
identifying the virtual machine’s resources, such as storage devices.

The server provides bootstrapping, management, and other services that
manage your virtual machines.

Each ESXihost has a vSphere Client available for your management use. If your
ESXi host is registered with vCenter Server, a vSphere Client that
accommodates vCenter Server features is available.

A service that acts as a central administrator for VMware ESXi hosts that are
connected on a network. vCenter Server directs actions on the virtual machines
and the virtual machine hosts (the ESXi hosts).

17
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vCenter Single Sign On

vCenter Server plug-ins

vCenter Server is a single Windows Service and is installed to run
automatically. vCenter Server runs continuously in the background. It
performsits monitoring and managing activities even when no vSphere Clients
are connected and when no one is logged on to the computer where it resides.
It must have network access to all the hosts it manages and be available for
network access from any machine where the vSphere Client is run.

You can install vCenter Server in a Windows virtual machine on an ESXi host,
allowing it to take advantage of the high-availability that is provided by
VMware HA. See the vSphere Installation and Setup documentation for details
about setting up this configuration.

You canjoin multiple vCenter Server systems using Linked Mode to allow them
to be managed using a single vSphere Client connection.

A service that is part of the vCenter Server management infrastructure. The
vCenter Single Sign On authentication service makes the VMware cloud
infrastructure platform more secure by allowing the various vSphere software
components to communicate with each other through a secure token exchange
mechanism, instead of requiring each component to authenticate a user
separately with a directory service like Active Directory.

When you install vCenter Single Sign-On, the following components are
deployed.

STS (Security The STS service issues Security Assertion Markup

Token Service) Language (SAML) tokens. These security tokens pass
information about a system user between an identity
provider and a web service. This service enables a user
who has logged on through vCenter Single Sign-On to
use multiple web-service delivered applications
without authenticating to each one.

Administration The Administration Server configures the vCenter
server Single Sign-On server and manages users and groups.
vCenter Lookup The Lookup Service contains topology information
Service about the vSphere infrastructure, enabling vSphere

components to connect to each other securely.

RSA SSPI The Security Support Provider Interface is a Microsoft

service Windows-based API used to perform authentication
against Security Support Providers such as NTLM and
Kerberos.

Applications that provide additional features and functionality to

vCenter Server. Typically, plug-ins consist of a server component and a client
component. After the plug-in server is installed, it is registered with

vCenter Server and the plug-in client is available to vSphere clients for
download. After a plug-in is installed on a vSphere client, it might alter the
interface by adding views, tabs, toolbar buttons, or menu options related to the
added functionality.

Plug-ins leverage core vCenter Server capabilities, such as authentication and
permission management, but can have their own types of events, tasks,
metadata, and privileges.

VMware, Inc.



vCenter Server database

Tomcat Web server

vCenter Server agent

Host agent

LDAP
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Some vCenter Server features are implemented as plug-ins, and can be
managed using the vSphere Client Plug-in Manager. These features include
vCenter Storage Monitoring, vCenter Hardware Status, and vCenter Service
Status.

A persistent storage area for maintaining the status of each virtual machine,
host, and user managed in the vCenter Server environment. The
vCenter Server database can be remote or local to the vCenter Server system.

The database is installed and configured during vCenter Server installation.

If you are accessing your ESXi host directly through a vSphere Client, and not
through a vCenter Server system and associated vSphere Client, you do not
use a vCenter Server database.

Many vCenter Server functions are implemented as Web services that require
the Tomcat Web server. The Tomcat Web server is installed on the vCenter
Server machine as part of the vCenter Server installation.

Features that require the Tomcat Web server to be running include: Linked

Mode, CIM/Hardware Status tab, Performance charts, WebAccess, vCenter

Storage Monitoring/Storage Views tab, Storage profile services,and vCenter
Service status.

On each managed host, the software that collects, communicates, and executes
the actions received from vCenter Server. The vCenter Server agent is installed
the first time any host is added to the vCenter Server inventory.

On each managed host, the software that collects, communicates, and executes
the actions received through the vSphere Client. It is installed as part of the
ESXi installation.

vCenter Server uses LDAP (Lightweight Directory Access Protocol) to
synchronize data such as license and role information across vCenter Server
systems joined in Linked Mode.

vSphere Client Interfaces

You have several ways to access vSphere components through vSphere interface options.

vSphere interface options include:

vSphere Web Client

vSphere Client

vSphere Command-Line
Interface

The vSphere Web Client is a Web application installed on a machine with
network access to your vCenter Server installation. The vSphere Web Client is
the primary interface for connecting to and managing vCenter Server instances.

The vSphere Client is installed on a Windows machine with network access to
your ESXi or vCenter Server system installation. The interface displays slightly
different options depending on which type of server you are connected to. A
single vCenter Server system or ESXi host can support multiple,
simultaneously connected vSphere Clients.

A command-line interface for configuring an ESXi host.

See Chapter 10, “Starting and Stopping the vSphere Components,” on page 141 for information and
instructions about starting and stopping ESXi hosts and vCenter Server.

VMware, Inc.
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In vSphere, the inventory is a collection of virtual and physical objects on which you can place permissions,

monitor tasks and events, and set alarms. You can group most inventory objects by using folders to more easily

manage them.

All inventory objects, with the exception of hosts, can be renamed to represent their purposes. For example,

they can be named after company departments or locations or functions. vCenter Server monitors and manages
the following components of your virtual and physical infrastructure:

Clusters

Datacenters

Datastores

A collection of ESXi hosts and associated virtual machines intended to work
together as a unit. When you add a host to a cluster, the host’s resources become
part of the cluster’s resources. The cluster manages the resources of all hosts.

If you enable VMware EVC on a cluster, you can ensure that migrations with
vMotion do not fail because of CPU compatibility errors. If you enable vSphere
DRS on a cluster, the resources of the hosts in the cluster are merged to allow
resource balancing for the hosts in the cluster. If you enable vSphere HA on a
cluster, the resources of the cluster are managed as a pool of capacity to allow
rapid recovery from host hardware failures.

Unlike a folder, which is used to organize a specific object type, a datacenter is
an aggregation of all the different types of objects needed to do work in virtual
infrastructure: hosts, virtual machines, networks, and datastores.

Within a datacenter there are four separate hierarchies.
B Virtual machines (and templates)

B Hosts (and clusters)

B Networks

B Datastores

The datacenter defines the namespace for networks and datastores. The names
for these objects must be unique within a datacenter. For example, you cannot
have two datastores with the same name within a single datacenter, but you
can have two datastores with the same name in two different datacenters.
Virtual machines, templates, and clusters need not be unique within the
datacenter, but must be unique within their folder.

Objects with the same name in two different datacenters are not necessarily the
same object. Because of this, moving objects between datacenters can create
unpredictable results. For example, a network named networkA in
datacenter A might not be the same network as a network named networkA in
datacenterB. Moving a virtual machine connected to networkA from
datacenterA to datacenterB results in the virtual machine changing the network
it is connected to.

Managed objects also cannot exceed 214 bytes (UTF-8 encoded).

A virtual representation of underlying physical storage resources in the
datacenter. A datastore is the storage location for virtual machine files. These
physical storage resources can come from the local SCSI disk of the ESXi host,
the Fibre Channel SAN disk arrays, the iSCSI SAN disk arrays, or Network
Attached Storage (NAS) arrays. Datastores hide the idiosyncrasies of the
underlying physical storage and present a uniform model for the storage
resources required by virtual machines.
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Folders Folders allow you to group objects of the same type so you can easily manage
them. For example, you can use folders to set permissions across objects, to set
alarms across objects, and to organize objects in a meaningful way.

A folder can contain other folders, or a group of objects of the same type:
datacenters, clusters, datastores, networks, virtual machines, templates, or
hosts. For example, one folder can contain hosts and a folder containing hosts,
but it cannot contain hosts and a folder containing virtual machines.

Datacenter folders form a hierarchy directly under the root vCenter Server and
allow users to group their datacenters in any convenient way. Within each
datacenter is one hierarchy of folders with virtual machines and templates, one
with hosts and clusters, one with datastores, and one with networks.

Hosts The physical computer on which ESXi is installed. All virtual machines run on
hosts. If the vSphere Client is connected directly to an ESXi host, only that host
is available for management.

Networks A set of virtual network interface cards (virtual NICs), distributed switches or
vSphere Distributed Switches, and port groups or distributed port groups that
connect virtual machines to each other or to the physical network outside of
the virtual datacenter. All virtual machines that connect to the same port group
belong to the same network in the virtual environment, even if they are on
different physical servers. You can monitor networks and set permissions and
alarms on port groups and distributed port groups.

Resource pools Resource pools are used to compartmentalize the CPU and memory resources
of a host or cluster. Virtual machines execute in, and draw their resources from,
resource pools. You can create multiple resource pools as direct children of a
standalone host or cluster and then delegate control over them to other
individuals or organizations.

vCenter Server provides, through the DRS components, various options in
monitoring the status of the resources and adjusting or suggesting adjustments
to the virtual machines using the resources. You can monitor resources and set
alarms on them.

Templates A master copy of a virtual machine that can be used to create and provision
new virtual machines. Templates can have a guest operating system and
application software installed, and can be customized during deployment to
ensure that the new virtual machine has a unique name and network settings.

Virtual machines A virtualized computer environment in which a guest operating system and
associated application software can run. Multiple virtual machines can operate
on the same managed host machine concurrently.

vApps vSphere vApp is a format for packaging and managing applications. A vApp
can contain multiple virtual machines.
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Optional vCenter Server Components

Optional vCenter Server components are packaged and installed with the base product, but might require a
separate license.

Optional vCenter Server features include:

vMotion A feature that enables you to move running virtual machines from one ESXi
host to another ESXi host without service interruption. It requires licensing on
both the source and target host. vCenter Server centrally coordinates all
vMotion activities.

Storage vMotion A feature that allows you to move the disks and configuration file of a running
virtual machine from one datastore to another without service interruption. It
requires licensing on the virtual machine's host.

vSphere HA A feature that enables a cluster with High Availability. If a host goes down, all
virtual machines that were running on the host are promptly restarted on
different hosts in the same cluster.

When you enable the cluster for vSphere HA, you specify the number of hosts
you want to be able to recover. If you specify the number of host failures
allowed as 1, vSphere HA maintains enough capacity across the cluster to
tolerate the failure of one host. All running virtual machines on that host can
be restarted on remaining hosts. By default, you cannot turn on a virtual
machine if doing so violates required failover capacity. See the vSphere
Awailability documentation for more information.

vSphere DRS A feature that helps improve resource allocation and power consumption
across all hosts and resource pools. vSphere DRS collects resource usage
information for all hosts and virtual machines in the cluster and gives
recommendations (or migrates virtual machines) in one of two situations:

B [nitial placement — When you first power on a virtual machine in the
cluster, DRS either places the virtual machine or makes arecommendation.

B Load balancing — DRS attempts to improve resource utilization across the
cluster by performing automatic migrations of virtual machines (vMotion)
or by providing a recommendation for virtual machine migrations.

vSphere DRS includes distributed power management (DPM) capabilities.
When DPM is enabled, the system compares cluster-level and host-level
capacity to the demands of virtual machines running in the cluster. Based on
the results of the comparison, DPM recommends (or implements) actions that
can reduce the power consumption of the cluster.

Storage DRS A feature that enables you to manage multiple datastores as a single compute
resource, called a datastore cluster. A datastore cluster is an aggregation of
multiple datastores into a single logical, load-balanced pool. You can treat the
datastore cluster as a single flexible storage resource for resource management
purposes. You can assign a virtual disk to a datastore cluster, and Storage DRS
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finds an appropriate datastore for it. The load balancer takes care of initial

placement and future migrations based on workload measurements. Storage
space balancing and I/O balancing minimize the risk of running out of space
and the risk of I/O bottlenecks slowing the performance of virtual machines.

vSphere Fault Tolerance provides continuous availability for virtual machines
by creating and maintaining a Secondary VM that is identical to, and
continuously available to replace, the Primary VM in the event of a failover
situation.

vCenter Server Plug-Ins

vCenter Server plug-ins extend the capabilities of vCenter Server by providing more features and functions.

Some plug-ins are installed as part of the base vCenter Server product.

vCenter Storage
Monitoring

vCenter Hardware
Status

vCenter Service Status

Allows you to review information on storage usage and to visually map
relationships between all storage entities available in vCenter Server.

Uses CIM monitoring to display the hardware status of hosts that
vCenter Server manages.

Displays the status of vCenter services.

Some plug-ins are packaged separately from the base product and require separate installation. You can update

plug-ins and the base product independently of each other. VMware modules include:

vSphere Update

Manager (VUM)

vShield Zones

vCenter Orchestrator

VMware, Inc.

Enables administrators to apply updates and patches across ESXi hosts and all
managed virtual machines. Administrators can create user-defined security
baselines that represent a set of security standards. Security administrators can
compare hosts and virtual machines against these baselines to identify and
remediate systems that are not in compliance.

An application-aware firewall built for vCenter Server integration. vShield
Zones inspects client-server communications and communications between
virtual machines to provide detailed traffic analytics and application-aware
firewall partitioning. vShield Zones is a critical security component for
protecting virtualized datacenters from network-based attacks and misuse.

A workflow engine that enables you to create and run automated workflows
in your vSphere environment. vCenter Orchestrator coordinates workflow
tasks across multiple VMware products and third-party management and
administration solutions through its open plug-in architecture. vCenter
Orchestrator provides a library of workflows that are extensible. You can use
any operation available in the vCenter Server API to customize vCenter
Orchestrator workflows.
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Using the vSphere Web Client

Use the vSphere Web Client to connect to vCenter Server systems and manage vSphere inventory objects.
Use of the vSphere Web Client requires a supported Web browser. Supported browsers include:

B Microsoft Internet Explorer 7, 8, and 9

B Mozilla Firefox 3.6 and higher

B Google Chrome 14 and higher

The vSphere Web Client also requires Adobe Flash Player version 10.1.0 or later to be installed in your browser.
This chapter includes the following topics:

B “Using the vSphere Web Client Administration Tool,” on page 25

B “Understanding vCenter Single Sign On,” on page 28

B “Log in to vCenter Server using the vSphere Web Client,” on page 29

B “Log Out of vCenter Server Using the vSphere Web Client,” on page 30

B “Use the vSphere Web Client Navigator,” on page 30

B “Use the vSphere Web Client Inventory Tree,” on page 30

B “Install the Client Integration Plug-In in the vSphere Web Client,” on page 31

B “Pause and Resume a Task in Progress in the vSphere Web Client,” on page 32

B “Refresh Data in the vSphere Web Client,” on page 32

B “Searching the Inventory in the vSphere Web Client,” on page 32

B “Configure the vSphere Web Client Timeout Value,” on page 35

B “Configure the vSphere Web Client to Bypass vCenter Single Sign On,” on page 35

B “Remove Stored User Data in the vSphere Web Client,” on page 36

Using the vSphere Web Client Administration Tool

Use the vSphere Web Client Administration Tool to register or unregister vCenter Server 5.0 systems with an
instance of the vSphere Web Client.

The vSphere Web Client is a Web application that can reside either on the same system as vCenter Server or a
separate system. Before you can connect to a vCenter Server 5.0 system with the vSphere Web Client, you must
register the vCenter Server 5.0 system with the vSphere Web Client. Unregister a vCenter Server system when
you no longer want users to be able to access that vCenter Server system using a particular instance of the
vSphere Web Client.
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You do not need to register vCenter Server 5.1 systems that use the same vCenter Single Sign On server as the
vSphere Web Client. The vSphere Web Client can locate such vCenter Server systems by using VMware Lookup
Service.

vSphere Web Client does not support vCenter Sever systems earlier than 5.0.

Norte If vCenter Server uses IPv6, you must specify the server address using the fully-qualified domain name.

Register a vCenter Server System with the vSphere Web Client

Before you can connect to a vCenter Server 5.0 system with vSphere Web Client 5.1, you must register it with
the vSphere Web Client.

You can register multiple vCenter Server systems with a single vSphere Web Client.

Register a given vCenter Server system with only one vSphere Web Client instance, rather than using multiple
vSphere Web Client instances to manage that vCenter Server system.

To register a vCenter Server system with the vSphere Web Client installed as part of a vCenter Server
Appliance, you must use the admin-app command-line script rather than the Web-based administration tool.

Prerequisites

B Log-in to the system on which the vSphere Web Client is installed. You cannot register a vCenter Server
system with the client from a remote system.

B Ensure that you have login credentials with Administrator privileges for the vCenter Server system that
you are registering.

B [fyou will use the server IP address to access the vSphere Web Client and your browser uses a proxy, add
the server IP address to the list of proxy exceptions.

Procedure

1  Open a Web browser and enter the URL for the administration tool: https://localhost: port/admin-app
or https://127.0.0.1: port/admin-app.

Use the localhost or loopback address to access the administration tool instead of using the server IP
address. Replace port with the port used by the vSphere Web Client. By default, this is 9443, but can be
changed during installation.

2 Click Register vCenter Server.

3  In the vCenter Server name or IP text box, enter the server name or IP address of the vCenter Server
system.

Do not include http:// or https://.

4 In the User name text box, enter the user name that you will use to connect to the vCenter Server system.

5 In the Password text box, enter the password.

6 Inthe vSphere Web Client server name or IP text box, enter the IP address or host name of the machine
where the vSphere Web Client is installed.

For example: hostname.example.com or 10.112.178.xx.

Do not use the localhost URL for the vSphere Web Client. If you enter the localhost URL, the license
reporting functionality will not be available in the vSphere Client unless the vSphere Web Client and
vCenter Server are installed on the same system.

7  Click Register.

You can now use this instance of the client to log in to the vCenter Server system.
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What to do next

In the Web browser, open https://client-hostname:port/vsphere-client/ to access the vSphere Web Client and log
in to the client, where client-hostname is the host name or IP address of the machine where
vSphere Web Client is installed, and port is the port used by vSphere Web Client

(by default, the port is 9443).

Register vCenter Server with the vSphere Web Client from the Command-line

If you are using the VMware vCenter Server Apppliance, you must register a vCenter Server 5.0 system with
the vSphere Web Client from the command-line.

Because the admin-app user interface is not available on the vCenter Server Appliance, to register a vCenter
Server system with the vSphere Web Client, you must register from the command-line using admin-cmd. sh.

Procedure

€ Enter the following command on the vCenter Server Appliance:
/usr/1lib/vmware-vsphere-client/scripts/admin-cmd.sh register
https://<WebClient_IPorHostName>:<WebClient_HttpsPort>/vsphere-client <VC_IP> <VC_Admin-User>
<VC_Admin-Passwd>

Example: Passwords with Special Characters

If you use any special characters for the administrator password, you must enclose the password in single
quotes.

/usr/lib/vmware-vsphere-client/scripts/admin-cmd.sh register https://webclient.mydomain.com:
9443 /vsphere-client vc.mydomain.com administrator 'CENSORED'

Unregister a vCenter Server System from the vSphere Web Client

You can unregister a vCenter Server system from the vSphere Web Client if you no longer want users to use
that vSphere Web Client instance to connect to the vCenter Server system.

Prerequisites

B Log-in to the system on which the vSphere Web Client is installed. You cannot unregister a vCenter Server
system from a remote system.

B Ensure that you have login credentials with Administrator privileges for the vCenter Server system that
you are registering.

Procedure

1 Open a Web browser and enter the URL for the administration tool: https://localhost:9443/admin-app
or https://127.0.0.1:9443/admin-app.

Use the localhost or loopback address to access the administration tool instead of using the server IP
address.

2 Select the vCenter Server system to unregister.
3  Click Unregister vCenter Server.

4  Type the username and password and click Unregister.
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Unregister vCenter Server from the vSphere Web Client Using the Command-line

If you are using the VMware vCenter Server Apppliance, you must unregister a vCenter Server 5.0 system
from the vSphere Web Client using the command-line.

Because the admin-app user interface is not available on the vCenter Server Appliance, to unregister a vCenter
Server system with the vSphere Web Client, you must unregister from the command-line using admin-
cmd. sh.

Procedure
¢ Enter the following command on the vCenter Server Appliance:
/usr/1lib/vmware-vsphere-client/scripts/admin-cmd.sh unregister

https://<WebClient_IPorHostName>:<WebClient_HttpsPort>/vsphere-client <VC_IP> <VC_Admin-User>
<VC_Admin-Passwd>

Understanding vCenter Single Sign On

28

vSphere 5.1 introduces vCenter Single Sign On service as part of the vCenter Server management infrastructure.
This change affects vCenter Server installation, upgrading, and operation. The vCenter Single Sign On
authentication service makes the VMware cloud infrastructure platform more secure by allowing the various
vSphere software components to communicate with each other through a secure token exchange mechanism,
instead of requiring each component to authenticate a user separately with a directory service like Active
Directory.

Where to Begin

For the first installation of vCenter Server with vCenter Single Sign-On, you must install all three components,
Single Sign-On Server, Inventory Service, and vCenter Server, in the vSphere environment. In subsequent
installations of vCenter Server in your environment, you do not need to install Single Sign-On. One Single
Sign-On server can serve your entire vSphere environment. After you install vCenter Single Sign-On once, you
can connect all new vCenter Server instances to the same authentication server. However, you must install a
Inventory Service instance for each vCenter Server instance.

The vCenter Single Sign-On installer also deploys the VMware Lookup Service on the same address and port.
The Lookup Service enables different components of vSphere to find one another in a secure way. When you
install vCenter Server components after vCenter Single Sign-On, you must provide the Lookup Service URL.
The Inventory Service and the vCenter Server installers ask for the Lookup Service URL and then contact the
Lookup Service to find vCenter Single Sign-On. After installation, the Inventory Service and vCenter Server
are registered in Lookup Service so other vSphere components, like the vSphere Web Client, can find them.

Users can log in to vCenter Server with the vSphere Client or the vSphere Web Client.

B Using the vSphere Client, the user logs in to each vCenter Server separately. All linked vCenter Server
instances are visible on the left pane of the vSphere Client. The vSphere Client does not show vCenter
Server systems that are not linked to the vCenter Server that the user logged in to unless the user connects
to those vCenter Server systems explicitly. This behavior is unchanged from vCenter Server versions
earlier than version 5.1.

B Using the vSphere Web Client, users authenticate to vCenter Single Sign-On, and are connected to the
vSphere Web Client. Users can view all the vCenter Server instances that the user has permissions on.
After users connect to vCenter Server, no further authentication is required. The actions users can perform
on objects depend on the user's vCenter Server permissions on those objects.
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Setting the vCenter Server Administrator User

In vSphere versions before vSphere 5.1, vCenter Server administrators are the users that belong to the local
operating system administrators group.

In vSphere 5.1, when you install vCenter Server, you must provide the default (initial) vCenter Server
administrator user or group. For small deployments where vCenter Server and vCenter Single Sign-On are
deployed on the same host machine, you can designate the local operating system group Administrators as
vCenter Server administrative users. This option is the default. This behavior is unchanged from vCenter Server
5.0.

For larger installations, where vCenter Single Sign-On and vCenter Server are deployed on different hosts,
you cannot preserve the same behavior as in vCenter Server 5.0. Instead, assign the vCenter Server
administrator role to a user or group from an identity source that is registered in the vCenter Single Sign-On
server: Active Directory, OpenLDAP, or the system identity source.

Log in to vCenter Server using the vSphere Web Client

Log in to vCenter Server using the vSphere Web Client to manage your vSphere inventory.

Prerequisites

If you want to use vCenter Server 5.0 with vSphere Web Client, verify that the vCenter Server 5.0 system is
registered with vSphere Web Client.

If you want to use vCenter Server 5.1 with vSphere Web Client, verify that vCenter Server is installed and that
both vCenter Server and vSphere Web Client point to the same vCenter Single Sign On instance.

Procedure

1  Open a Web browser and enter the URL for the vSphere Web Client:
https://client-hostname: port/vsphere-client.

By default the port is 9443, but this can be changed during vSphere Web Client installation.

2 In the Username text box, enter the user name that is on the vCenter Single Sign On and has permissions
on vCenter Server.

3 Inthe Password text box, enter the password.
4  Click Login.

5 If a warning message about an untrusted SSL certificate appears, select the appropriate action based on
your security policy.

Option Action

Ignore the security warning for this  Click Ignore.
login session only.

Ignore the security warning for this  Select Install this certificate and do not display any security warnings for
login session, and install the default this server and click Ignore.

certificate so that the warning does  geject this option only if using the default certificate does not present a

not appear again. security problem in your environment.
Cancel and install a signed Click Cancel and ensure that a signed certificate is installed on the vCenter
certificate before proceeding. Server system before you attempt to connect again.

The vSphere Web Client connects to all the vCenter Server systems that the specified user has permissions,
allowing you to view and manage your inventory.
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Log Out of vCenter Server Using the vSphere Web Client

Log out of your vSphere Web Client to disconnect from the vCenter Server system.

Procedure

¢ Click the username at the top of the vSphere Web Client window and select Logout.

Use the vSphere Web Client Navigator

You can use the navigator to browse and select objects in the vSphere Web Client inventory as an alternative
to the hierarchical inventory tree.

Unlike the inventory tree, which presents hierarchical arrangements of parent and child objects arranged in
the Hosts and Clusters, VMs and Templates, Storage, and Networking views, the navigator presents a graph-
based view of the inventory, which allows you to navigate from an object to its related objects, regardless of

type.

Procedure

1 From the vSphere Web Client Home, click vCenter.

2 Under Inventory Lists, click one of the object categories to view objects of that type.
For example, click Hosts to view hosts in the vSphere Web Client inventory.

3 Click an object in the list once to display information about the object in the center pane of the
vSphere Web Client.

4  (Optional) Click the object again to open it.
Opening an object brings it to the top of the navigator and displays related object categories beneath it.

For example, opening a host allows you to see the child resource pools, virtual machines, vApps,
datastores, standard networks, distributed switches, and distributed port groups associated with this host.

5  Click one of the tabs in the center pane to access additional information and actions.

Option Description

Getting Started View introductory information and access basic actions.

Summary View basic status and configuration for an object.

Monitor View alarms, performance data, resource allocation, events, and other status
information for an object.

Manage Configure settings, alarm definitions, tags, and permissions.

Related Objects View related objects.

Use the vSphere Web Client Inventory Tree

30

You can use the inventory tree in the vSphere Web Client to browse and select objects as an alternative to the
navigator.

The inventory tree shows a hierarchical arrangement of objects in four different views: Hosts and Clusters,
VMs and Templates, Storage, or Networking.

Procedure
1 From the vSphere Web Client Home, click vCenter.

2 Under Inventory Trees, click one of the four categories to display one of the tree views.
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3  Click the triangle next to any object to expand the tree and show the child objects.
4  Select an object in the inventory tree to display information about the object in the center pane.
5  (Optional) Click the selected object to shift to the navigator and bring the object into focus.
6  Click one of the tabs in the center pane to access additional information and actions.
Option Description
Getting Started View introductory information and access basic actions.
Summary View basic status and configuration for an object.
Monitor View alarms, performance data, resource allocation, events, and other status
information for an object.
Manage Configure settings, alarm definitions, tags, and permissions.
Related Objects View related objects.

Install the Client Integration Plug-In in the vSphere Web Client

The Client Integration Plug-in provides access to a virtual machine's console in the vSphere Web Client, and
provides access to other vSphere infrastructure tasks.

You use the Client Integration Plug-in to deploy OVF or OVA templates and transfer files with the datastore
browser. You can also use the Client Integration Plug-in to connect virtual devices that reside on a client
computer to a virtual machine.

You install the Client Integration Plug-in only once to connect virtual devices to virtual machines that you
access through an instance of the vSphere Web Client. You must restart the browser after you install the plug-
in.

If you install the Client Integration Plug-in from an Internet Explorer browser, you must first disable Protected

Mode. Internet Explorer identifies the Client Integration Plug-in as being on the Internet instead of on the local
intranet. In such cases, the plug-in does not install correctly because Protected Mode is enabled for the Internet.

The Client Integration Plug-in also enables you to log in to the vSphere Web Client using Windows session
credentials.

For information about supported browsers and operating systems, see the vSphere Installation and Setup
documentation.

Procedure
1  Disable Internet Protected Mode for Internet Explorer browsers.
a  Open the browser and select Tools > Internet Options.
b  Click the Security tab and deselect Enable Protected Mode for the Internet and Local intranet zones.

2 Click the Download the client integration plug-in link.

Option Description

vSphere Web Client login page a Open a Web browser and enter the URL for the vSphere Web Client.

b At the bottom of the vSphere Web Client login page, click Download
Client Integration Plug-in.

Guest OS Details panel a Select a virtual machine in the inventory and click the Summary tab.
b Click Download Client Integration Plug-in.

3 If the browser blocks the installation, either by issuing certificate errors or with pop-up blocking, follow
the Help instructions for your browser to resolve the problem.
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What to do next

You can open the virtual machine console to configure operating system settings, run applications, monitor
performance, and so on.

Pause and Resume a Task in Progress in the vSphere Web Client

You can pause many tasks in the vSphere Web Client and later resume them from the Work in Progress pane.
Procedure
1 Inadialog box or wizard, click the minimize button.

The task is paused and minimized to the Work in Progress pane. Any changes that you have made in the
dialog box or wizard are saved, but not yet applied to the object you are working with.

2 When you are ready to resume the task, click it in the Work in Progress pane.

The dialog box or wizard opens and you can resume the task from where you left off.

Refresh Data in the vSphere Web Client

You must manually refresh the data in the vSphere Web Client to see changes made to objects by other users
during your session.

For performance reasons, the vSphere Web Client does not continuously refresh data on all objects in the
inventory. All changes that you make during your current session are immediately reflected in the client user
interface. Change made by other users or in other sessions are not reflected until you manually refresh the
data.

Procedure

To update all data in the current vSphere Web Client view, click the refresh icon ().

The client view is updated. The date and time of the last refresh are displayed next to the refresh icon.

Searching the Inventory in the vSphere Web Client

32

With vSphere Web Client, you can search the inventory for objects that match specified criteria. If the
vSphere Web Client is connected to a vCenter Server system that is part of a Linked Mode group, you can
search the inventories of all vCenter Server systems in that group.

You can only view and search for inventory objects that you have permission to view. Because the search
service queries Active Directory for information about user permissions, you must be logged in to a domain
account to search all vCenter Server systems in a Linked Mode group. If you log in using a local account,

searches return results only for the local vCenter Server system, even if it is joined to other servers in Linked
Mode.

Norte If your permissions change while you are logged in, the search service might not immediately recognize
these changes. To ensure that your search is performed with up-to-date permissions, log out of all your open
sessions and log in again before you perform the search.

B Perform a Quick Search in the vSphere Web Client on page 33

A quick search searches all types of objects for the specified search term in the name or other properties
of the object.

B Perform a Simple Search in the vSphere Web Client on page 33

A simple search searches all types of objects for the specified search term in the name of the object.
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B Perform an Advanced Search in the vSphere Web Client on page 33

With Advanced search, you can search for managed objects that meet multiple criteria.

B Save a Search in the vSphere Web Client on page 34

You can save search queries so that you can retrieve them to rerun later.

B Load a Saved Search in the vSphere Web Client on page 34

You can load a saved search query to rerun the search.

Perform a Quick Search in the vSphere Web Client

A quick search searches all types of objects for the specified search term in the name or other properties of the
object.

Procedure
1 Type the search term in the search box at the top right of the client window.

Multiple search terms in a quick or simple search are treated as if they are connected by ORs. For example,
searching for example machine finds all objects with names containing either "example" or "machine".

The search results appear below the search box as you type. The number of items displayed is limited to
10.

2 (Optional) Click any item in the search results to display that item in the inventory.

3 (Optional) To see more search results or more details about the search results, click Show All Results.
a (Optional) Select an object in the results table to see additional information about the object.
b  (Optional) Double-click any item in the search results to display that item in the inventory.

The search results are listed in a table. If differing types of objects are found, the table contains tabs for
each type of object. For example, if a search finds hosts and datastores, the following tabs appear:
Datastore, showing only datastore results and Host, showing only host results.

Perform a Simple Search in the vSphere Web Client

A simple search searches all types of objects for the specified search term in the name of the object.

Procedure
1 From the vSphere Web Client Home screen, click New Search
2 Type the search term in the search box and press Enter.

Multiple search terms in a quick or simple search are treated as if they are connected by ORs. For example,
searching for example machine finds all objects with names containing either "example" or "machine".

The search results are listed in a table. If differing types of objects are found, the table contains tabs for
each type of object. For example, if a search finds hosts and datastores, the following tabs appear:
Datastore, showing only datastore results and Host, showing only host results.

3 (Optional) Select an object in the results table to see additional information about the object.

4  (Optional) Double-click any item in the search results to display that item in the inventory.

Perform an Advanced Search in the vSphere Web Client
With Advanced search, you can search for managed objects that meet multiple criteria.

For example, you can search for virtual machines whose name contains a particular string that reside on a
particular host.
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Procedure
1  From the vSphere Web Client Home, click New Search and then click Advanced Search.
2 Select the type of object to search for from the Search for drop-down menu.

3  Select how to combine the search criteria.

Option Description
any The search returns results that match any of the specified criteria.
all The search returns only results that match all of the specified criteria.

4  Select a property to search for from the drop-down menu.
The properties available depend on the type of object you are searching for.
5  Select the relationship between the search term and the property from the drop-down menu.

The options available in this step depend on the property selected in the previous step. For example, if
you select a Name property, the options available are contains, is, and is not.

Type or select the search term.
(Optional) To add additional search criteria, click Add new criteria and repeat Step 4 to Step 6.

(Optional) To add an additional search, click Add another object type and repeat Step 2 to Step 7.

O o0 N O

Click Search.
Search results are displayed in the details pane and in the navigator.
10 (Optional) Click any item in the navigator to see its details without leaving the context of the search.

11 (Optional) Double-click any item in the details pane to display that item in the inventory.

Save a Search in the vSphere Web Client
You can save search queries so that you can retrieve them to rerun later.
Procedure
1  Enter a query for either a simple or advanced search.
2 Click Save.
3  Type a name for the search and click OK.

The search query you entered is saved. You can reload that query later and repeat the search.

Load a Saved Search in the vSphere Web Client

You can load a saved search query to rerun the search.

The vSphere Web Client saves search queries, not search results. When you load a saved search, the search
query is run again and new results are displayed.

Procedure
1 From the vSphere Web Client Home, click Saved Searches.
2 Click the saved search.

The search runs and the results are displayed.
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Configure the vSphere Web Client Timeout Value

By default, vSphere Web Client sessions terminate after 30 minutes of idle time, requiring the user to log in
again to resume using the client. You can change the timeout value by editing the webclient.properties file.

Procedure
1 On the computer where the vSphere Web Client is installed, locate the webclient.properties file.

The location of this file depends on the operating system on which the vSphere Web Client is installed.

Operating System File path

Windows 2003 HSALLUSERSPROFILE%Application Data\VMware\vSphere Web Client
Windows 2008 ZALLUSERSPROFILEZX\VMware\vSphere Web Client

vCenter Server Appliance /var/lib/vmware/vsphere-client

2 Edit the file to include the line session.timeout = value where value is the timeout value in minutes.
To set the client to never time out, specify a negative or 0 value for the timeout.
For example, to set the timeout value to 60 minutes, include the line session.timeout = 60.

3 Restart the vSphere Web Client service.
B On Windows operating systems, restart the VMware vSphere Web Client service.

B On the vCenter Server Appliance, restart the vSphere-client service.

Configure the vSphere Web Client to Bypass vCenter Single Sign On

You can configure the vSphere Web Client to bypass the vCenter Single Sign On server. This allows the vSphere
Web Client to connect directly to vCenter Server 5.0 systems that are registered with the vSphere Web Client.

If your environment contains both vCenter Server 5.0 and vCenter Server 5.1 system, you can use this setting
to access the vCenter Server 5.0 systems if the vCenter Single Sign On Server becomes unavailable.

vCenter Single Sign On is required to connect to vCenter Server 5.1 systems. If you configure the vSphere Web
Client to bypass Single Sign On, you cannot use it to connect to any vCenter Server 5.1 systems until you undo
this configuration change.

Procedure

1  On the computer where the vSphere Web Client is installed, locate the webclient.properties file.

The location of this file depends on the operating system on which the vSphere Web Client is installed.

Operating System File path

Windows 2003 HALLUSERPROFILE#Application Data\VMware\vSphere Web Client
Windows 2008 SALLUSERPROFILEZ\VMware\vSphere Web Client

vCenter Server Appliance /var/lib/vmware/vsphere-client

2 Edit the file to include the line sso.enabled = false.
3 Restart the vSphere Web Client service.
B On Windows operating systems, restart the VMware vSphere Web Client service.

B On the vCenter Server Appliance, restart the vSphere-client service by typing
service vsphere-client restart.
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After you have restarted the vSphere Web Client, you can select the vCenter Server 5.0 system to log in to from
the login page.

What to do next

To return the vSphere Web Client to using vCenter Single Sign On, edit thewebclient.properties file to remove
the sso.enabled = false line, and restart the vSphere Web Client service.

Remove Stored User Data in the vSphere Web Client

36

The vSphere Web Client stores user data including saved searches, Work In Progress items, and Getting Started
Pages preferences. You can remove this stored data to reset these items to the initial defaults and remove stored
data that you no longer need.

You can remove data only for the currently logged-in user. Data stored by other users is not affected.
Procedure

1  In the vSphere Web Client, click the name of the currently logged-in user and select Remove Stored
Data.

2 Select the data to remove.

Option Description

"Work in progress" items All current Work In Progress items for this user are removed.

Getting Started Pages preferences All Getting Started pages preferences for this user are removed. All Getting
Started pages will be displayed in the vSphere Web Client.

Saved Searches All Saved Searches for this user are removed.

3 Click OK.
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The vSphere Client is the principal interface for administering vCenter Server and ESXi.

The vSphere Client user interface is configured based on the server to which it is connected:

When the server is a vCenter Server system, the vSphere Client displays all the options available to the
vSphere environment, according to the licensing configuration and the user permissions.

When the server is an ESXi host, the vSphere Client displays only the options appropriate to single host
management.

When you first log in to the vSphere Client, it displays a Home page with icons that you select to access vSphere

Client functions. When you log out of the vSphere Client, the client application retains the view that was

displayed when it closed, and returns you to that view when you next log in.

You perform many management tasks from the Inventory view, which consists of a single window containing

a menu bar, a navigation bar, a toolbar, a status bar, a panel section, and pop-up menus.

This chapter includes the following topics:

VMware, Inc.

“Start the vSphere Client and Log In,” on page 38
“Stop the vSphere Client and Log Out,” on page 38
“Getting Started Tabs,” on page 38

“Status Bar, Recent Tasks, and Triggered Alarms,” on page 39
“Panel Sections,” on page 39

“View Virtual Machine Console,” on page 40
“Searching the vSphere Inventory,” on page 40
“Using Lists,” on page 41

“Custom Attributes,” on page 42

“Select Objects,” on page 43

“Manage vCenter Server Plug-Ins,” on page 44
“Save vSphere Client Data,” on page 45

“Working with Active Sessions,” on page 45
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Start the vSphere Client and Log In

The vSphere Client is a graphical user interface to vCenter Server and to hosts.

A login screen appears when you start the vSphere Client. After you log in, the client displays the objects and
functionality appropriate to the server you are accessing and the permissions available to the user you logged
in as.

Procedure
1 Login to your Windows system.
If this is the first time you are starting the vSphere Client, log in as the administrator.

B [f the managed host is not a domain controller, log in as either Iocal_host_name\user or user, where
user is a member of the local Administrators group.

B [f the managed host is a domain controller, you must log in as domaim\userdomain\user, where
domain is the domain name for which the managed host is a controller and useris a member of that
domain’s Domain Administrators group. VMware does not recommend running on a domain
controller.

2 Double-click a shortcut or select the vSphere Client from Start > Programs > VMware > vSphere Client.
3 Enter the server name, your user name, and your password.

If you are logging in to a vCenter Server system that is part of a Connected Group, logging in to that server
connects you to all servers in that group.

Note Only previously entered server names appear in the Server drop-down menu.

4  Click Login to continue.

You are now connected to the host or vCenter Server system.

Stop the vSphere Client and Log Out

When you no longer need to view or alter the activities that the vCenter Server system is performing, log out
of the vSphere Client.

Note Closing a vSphere Client session does not stop the server.

Procedure
€ Click the close box (X), or select File > Exit.
The vSphere Client shuts down. The vSphere Client is logged out of the vCenter Server system. The server

continues to run all its normal activities in the background. Any scheduled tasks are saved and performed by
vCenter Server.

Getting Started Tabs

38

In the case where vCenter Server is newly installed and no inventory objects have been added, the Getting
Started tabs guide you through the steps of adding items to the inventory and setting up the virtual
environment.

B  Disable Getting Started Tabs on page 39
You can disable the Getting Started tabs if you do not want to display them.
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B Restore Getting Started Tabs on page 39

If you turned off the display of the Getting Started tabs, you can restore the settings to display these tabs
for all inventory objects.

Disable Getting Started Tabs

You can disable the Getting Started tabs if you do not want to display them.

You can disable the tabs in the following ways.

Procedure
B (Click the Close Tab link to disable Getting Started tabs for the type of object selected.
B Change the vSphere Client settings to hide all Getting Started tabs.

a  Select Edit > Client Settings.

b Select the General tab.

¢ Deselect the Show Getting Started Tabs check box and click OK.

Restore Getting Started Tabs

If you turned off the display of the Getting Started tabs, you can restore the settings to display these tabs for
all inventory objects.

Procedure

1  Select Edit > Client Settings.

2 Click the General tab.

3 Select Show Getting Started Tabs and click OK.

Status Bar, Recent Tasks, and Triggered Alarms

Use the status bar to view information about alarms and recently completed or active tasks.

The status bar appears at the bottom of the window. It contains icons to view triggered alarms or recent tasks.
The Tasks button displays any currently running or recently completed active tasks. Included is a progress
bar indicating the percentage complete of each task. The recent tasks and the triggered alarm panels display
across the bottom of the vSphere Client window.

Panel Sections

The body of the vSphere Client page has a panel section. Most views have a left and a right panel: the Inventory
panel and the Information panel.

You can resize these panels.

Inventory panel Displays a hierarchical list of vSphere objects when an Inventory or Maps view
appears.
Information panels Display lists and charts. Depending on the navigation items or Inventory item

selected, the Information panel is divided into tabbed elements.
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View Virtual Machine Console

The console of a powered-on virtual machine is available through a connected server. All console connections
to the virtual machine see the same information. The message line indicates if others are viewing the virtual
machine.

Procedure
1  Select a powered-on virtual machine.
2 In the Information panel, click the Console tab.

3 (Optional) Click the pop-out icon in the navigation bar to show the virtual machine console in a separate
window.

4  (Optional) Press Ctrl+Alt+Enter to enter or exit full screen mode.

Searching the vSphere Inventory

The vSphere Client allows you to search your vSphere inventory for virtual machines, hosts, datastores,
networks, or folders that match specified criteria.

If the vSphere Client is connected to a vCenter Server system that is part of a connected group in vCenter
Linked Mode, you can search the inventories of all vCenter Server systems in that group. You can view and
search only for inventory objects that you have permission to view. Because the search service queries Active
Directory for information about user permissions, you must be logged in to a domain account to search all
vCenter Server systems in Linked Mode. If you log in using a local account, searches return results only for
the local vCenter Server system, even if it is joined to other servers in Linked Mode.

Norte If your permissions change while you are logged in, the search service might not immediately recognize
these changes. To ensure that your search is performed with up-to-date permissions, log out of all your open
sessions and log in again before performing the search.

Perform a Simple Search
A simple search searches all the properties of the specified type or types of objects for the entered search term.
Procedure

1  Click the icon in the search field at the top right of the vSphere Client window and select the type of
inventory item to search for.

®  Virtual Machines

®  Folders

B Hosts

B Datastores

®  Networks

B Inventory, which finds matches to the search criteria in any of the available managed object types.
2 Type one or more search terms into the search field and press Enter.

3  (Optional) If more items are found than can be displayed in the results pane, click Show all.
What to do next

If you are not satisfied with the results of the simple search, perform an advanced search.
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Perform an Advanced Search

Using advanced search allows you to search for managed objects that meet multiple criteria.

For example, you can search for virtual machines matching a search string. The virtual machines reside on

hosts whose names match a second search string.

Procedure

1  Select View > Inventory > Search to display the advanced search page.

2 Click the icon in the search field at the top right of the vSphere Client window and select the type of
inventory item to search for.

Virtual Machines
Folders

Hosts

Datastores
Networks

Inventory, which finds matches to the search criteria in any of the available managed object types.

3  Type one or more search terms into the search box.

4  Refine the search based on additional properties.

a

b

Click Show options.

From the drop-down menu, select the additional property that you want to use to restrict the search
results.

The available properties depend on the type of object you are searching for.
Select or type the appropriate options for the property you have selected.
To add more properties, click Add and repeat steps Step 4b through Step 4c.

An advanced search always finds objects that match all the properties in the list.

5  Click Search.

The search results appear below the search specification.

Using Lists

Many vSphere Client inventory tabs display lists of information.

For example, the Virtual Machines tab displays a list of all the virtual machines associated with a host or a

cluster. Sort any list in the vSphere Client by clicking the column label heading. A triangle in the column head

shows the sort order as ascending or descending.

You can also filter a list, sorting and including only selected items. A filter is sorted by a keyword. Select the
columns to include in the search for the keyword.

VMware, Inc.
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Filter a List View

You can filter a list if it is too long, or if you are looking for specific items in the list (alarms that begin with the
word "datastore," for example). You can show and hide the filter field by using the Filtering option in the
View menu.

The list is updated based on whether filtering is on or off. For example, if you are in the Virtual Machines tab,
you have filtered the list and the filtered text is “powered on." You see a list of virtual machines whose state
is set to powered on. If the state of any virtual machine changes, the virtual machine is removed from the list.
Virtual machines that are added to the list are also filtered.

Procedure

1  Onany inventory panel that displays a list, click the arrow next to the filter box at the top right of the pane.
2 Select the attributes on which to filter.

3 Enter search criteria into the filter field.

The search automatically starts after a pause of more than one second. Neither boolean expressions nor
special characters are supported. Filtering is not case-sensitive.

4  (Optional) Click Clear to clear the filter field.

Export a List
You can export a list to a file.
Procedure
1 Select the list to export.

Select File > Export > Export List.

Type a filename and select a file type.
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Click Save.

Custom Attributes

You can use custom attributes to associate user-specific meta-information with virtual machines and managed
hosts.

Attributes are the resources that are monitored and managed for all the managed hosts and virtual machines
in your vSphere environment. Attributes’ status and states appear on the inventory panels.

After you create the attributes, set the value for the attribute on each virtual machine or managed host, as
appropriate. This value is stored with vCenter Server and not with the virtual machine or managed host. Use
the new attribute to filter information about your virtual machines and managed hosts. If you no longer need
the custom attribute, remove it. A custom attribute is always a string.

For example, suppose you have a set of products and you want to sort them by sales representative. Create a
custom attribute for sales person name, Name. Add the custom attribute, Name, column to one of the list views.
Add the appropriate name to each product entry. Click the column title Name to sort alphabetically.

The custom attributes feature is available only when you are connected to a vCenter Server system.
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Add Custom Attributes

You can create custom attributes to associate with virtual machines or managed hosts.

Procedure
1  Select Administration > Custom Attributes.
This option is not available when connected only to an ESXi host.
2 Click Add.
3 Enter the values for the custom attribute.
a  Type the name of the attribute in the Name text box.
b Select the attribute type from the Type drop-down menu:Virtual Machine, Host, or Global.
¢ Inthe Value text box, type the value you want to give to the attribute for the currently selected object.
d Click OK.

After you have defined an attribute on a single virtual machine or host, it is available to all objects of
that type in the inventory. However, the value you specify is applied only to the currently selected
object.

4  (Optional) To change the attribute name, click in the Name field and type the name you want to assign to
the attribute.

5 Click OK.

Edit a Custom Attribute

You can edit custom attributes and add annotations for a virtual machine or host from the Summary tab for
the object. Use annotations to provide additional descriptive text or comments for an object.

Procedure
1  Select the virtual machine or host in the inventory.
Click the Summary tab for the virtual machine or host.

In the Annotations box, click the Edit link.
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To edit the value of an attribute that is already defined, double-click the Value field for that attribute and
enter the new value.

5 Click OK to save your changes.

Select Objects

vCenter Server objects are datacenters, networks, datastores, resource pools, clusters, hosts, and virtual
machines. Selecting an object allows you to view the status of the object and enables the menus so you can
select actions to take on the object.

Procedure
€ Locate the object by browsing or search.

B From the vSphere Client Home page, click the icon for the appropriate inventory view, and browse
through the inventory hierarchy to select the object.

B Perform a search for the object, and double-click it in the search results.
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Manage vCenter Server Plug-Ins

After the server component of a plug-in is installed and registered with vCenter Server, its client component
is available to vSphere clients. Client component installation and enablement are managed through the Plug-
in Manager dialog box.

The Plug-in Manager lets you perform the following actions:

View available plug-ins that are not currently installed on the client.
View installed plug-ins.
Download and install available plug-ins.

Enable and disable installed plug-ins.

Install Plug-Ins

You can install plug-ins using the Plug-in Manager.

Procedure

1
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Launch the vSphere Client and log in to a vCenter Server system.

Select Plug-ins > Manage Plug-ins.

Select the Available tab in the Plug-in Manager dialog box.

Click Download and Install for the plug-in you want.

Follow the prompts in the installation wizard.

After installation is complete, verify that the plug-in is listed under the Installed tab and that it is enabled.

There might be short delay between the completion of the installation and the plug-in appearing in the
list of installed plug-ins.

Disable and Enable Plug-Ins

You can disable or enable plug-ins using the Plug-in Manager.

Disabling a plug-in does not remove it from the client. You must uninstall the plug-in to remove it.

Procedure

1
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Launch the vSphere Client and log in to a vCenter Server system.
Select Plug-ins > Manage Plug-ins.
Select the Installed tab in the Plug-in Manager dialog box.

Select Enable to enable a plug-in, or deselect Enable to disable it.

Remove Plug-Ins

You can remove plug-ins through the operating system’s control panel.

Procedure

¢ Consultyour operating system’s documentation for instructions on how to use the Add/Remove Programs

44

control panel.
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Troubleshooting vCenter Server Plug-Ins
In cases where vCenter Server plug-ins are not working, you have several options to correct the problem.

vCenter Server plug-ins that run on the Tomcat server have extension.xml files, which contain the URL where
the corresponding Web application can be accessed. These files are located in C:\Program
Files\VMware\Infrastructure\VirtualCenter Server\extensions. Extension installers populate these XML
files using the DNS name for the machine.

Example from the stats extension.xml file: <url>https://SPULOV-XP-VM12.vmware.com:
8443/statsreport/vicr.do</url>.

vCenter Server, plug-in servers, and the clients that use them must be located on systems under the same
domain. If they are not under the same domain, or if the DNS of the plug-in server is changed, the plug-in
clients will not be able to access the URL, and the plug-in will not work.

You can edit the XML files manually by replacing the DNS name with an IP address. Reregister the plug-in
after you edit its extension.xml file.

Save vSphere Client Data

The vSphere Client user interface is similar to a browser. Most user actions are persistent in vCenter Server
data that appears. You typically do not have to save the data.

Procedure

€  You can save the client data by either printing a copy of the window or exporting the server data.

Option Description

Copy the window Use the Microsoft Windows Print Screen option to print a copy of the
vSphere Client window.

Export server data Select File > Export and select a format in which to save the vCenter Server
data. Open the data in an appropriate application and print from that
application.

Working with Active Sessions

You can view alist of users who are logged in to a vCenter Server system when your vSphere Client is connected
to that server. You can end sessions, and you can send a message to all users logged on to an active session.

These features are not available when your vSphere Client is connected to an ESXi host.

View Active Sessions

You can view active sessions on the home page of a vSphere Client.

Procedure

4 From the Home page of a vSphere Client connected to a vCenter Server system, click the Sessions button.

Terminate Active Sessions

Terminating an active session ends the vSphere Client session and any remote console connections started by
the user during the session.

Procedure

1  On the Home page of a vSphere Client connected to a vCenter Server system, click the Sessions button.
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2 Right-click a session and select Terminate.

3  Click OK to confirm the termination.

Send a Message to All Active Users

You can send a Message of the Day to all active session users and to new users when they log into the vSphere
Client.

The Message of the day text is sent as a notice message to all active session users and to new users when they
log in.

Procedure

1 On the Home page of a vSphere Client connected to a vCenter Server system, click the Sessions button.
2 Type a message in the Message of the day field.
3 Click Change.

The message is broadcast to all users logged into the vSphere Client.
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Configuring ESXi hosts, vCenter Server systems, and the vSphere Client involves several tasks.
This chapter includes the following topics:

B “Host Configuration,” on page 47

B “Synchronizing Clocks on the vSphere Network,” on page 47

B “Configuring vCenter Server in the vSphere Client,” on page 49

B “Configuring vCenter Server in the vSphere Web Client,” on page 59

B “Configuring the VMware vCenter Server Appliance,” on page 67

B “Configuring Communication Among ESXi, vCenter Server, and the vSphere Client,” on page 75

Host Configuration

Before you create virtual machines on your hosts, you must configure the hosts to ensure that they have correct
licensing, network and storage access, and security settings. Each type of host has a manual that provides
information on the configuration for that host.

For information on configuring a host, see the configuration information for the specific vSphere component
in the vSphere Security documentation, the vSphere Storage documentation, or the vSphere Networking
documentation.

Synchronizing Clocks on the vSphere Network

Before you install vCenter Single Sign On, install the vSphere Web Client, or deploy the vCenter Server
appliance, make sure all machines on the vSphere network have their clocks synchronized.

If the clocks on vCenter Server network machines are not synchronized, SSL certificates, which are time-
sensitive, might not be recognized as valid in communications between network machines. Unsynchronized
clocks can result in authentication problems, which can cause the vSphere Web Client installation to fail or
prevent the vCenter Server Appliance vpxd service from starting.

Edit Time Configuration for a Host in the vSphere Web Client

You can configure the time settings on a host manually, or you can synchronize the time and date of the host
by using an NTP server.

Procedure

1  In the vSphere Web Client, navigate to the host in the vSphere inventory.

2 Select Manage, and select Settings.
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3 Under System, select Time configuration and click Edit.

4  Select an option for setting the time and date of the host.

Option Description

Manually configure the date and time  Set the time and date for the host manually.
on this host

Use Network Time Protocol (Enable  Synchronize the time and date of the host with an NTP server. The NTP
NTP client) service on the host periodically takes the time and date from the NTP server.
a Inthe NTP Servers text box, type the IP addresses or host names of the
NTP servers that you want to use.
b  From the NTP Service Startup Policy drop-down list, select an option
for starting and stopping the NTP service on the host.
B Start and stop with port usage - Starts or stops the NTP service when
the NTP client port is enabled or disabled for access in the security
profile of the host.

B Start and stop with host - Starts and stops the NTP service when the
host powers on or shuts down.

B Start and stop manually - Enables manual starting and stopping of
the NTP service.

You can use the Start, Stop, or Restart buttons to control the status of the
NTP service on the host manually at any time no matter of the selected
startup policy for the NTP service. For the Start and stop manually policy,
you always use the buttons to control the status of the NTP service.

5 Click OK.

Synchronize the vCenter Server Appliance Clock with an NTP Server

Before you deploy the vCenter Server Appliance or install vCenter Single Sign On on Windows, make sure all
machines on the network have their clocks synchronized. Unsynchonized clocks can cause installation and
authentication errors.

On systems joined to a Windows domain, the vCenter Server Appliance clock is synchronized automatically
with the domain controller. On other systems, you can enable synchronizing the clock through VMware Tools.
See the Installing and Configuring VMuware Tools Guide. As an alternative, you can use this procedure.

Procedure
1 Log into the vCenter Server Appliance as root.

2 From a command line, enter the following commands to configure and start an NTP client.

yast2 ntp-client add server=your_chosen_time_server
yast2 ntp-client enable

3 Enter the following command to request immediate synchronization with the time server.

sntp -P no -r your_chosen_time_server

The vCenter Server Appliance clock is synchronized with the NTP server.

Configure a Windows NTP Client for Network Clock Synchronization

The clocks of all servers on the vSphere network must be synchronized. You can configure a Windows NTP
client as a source for clock synchronization on Windows servers.

Use the registry editor on the Windows server to make the configuration changes.
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Procedure

1

Enable NTP mode.

a  Go to the registry setting
HKEY_LOCAL_MACHINE\SYSTEM \ CurrentControlSet\ Services\ W32Time \ Parameters

b  Set the Type value to NTP.
Enable the NTP client.

a  Go to the registry setting
HKEY_LOCAL_MACHINE\SYSTEM \ CurrentControlSet\ Services\ W32Time\ Config

b Set the AnnounceFlags value to 5.
Enter the upstream NTP servers to synchronize from.

a  Go to the registry setting
HKEY_LOCAL_MACHINE\SYSTEM \ CurrentControlSet\ Services\ W32Time \ TimeProviders.

b Set the NtpServer value to a list of at least three NTP servers.
For example, you might set the value to 0x1 1.pool.ntp.org,0x1 2.pool.ntp.org,0x1 3.pool.ntp.org.
Specify a 150-minute update interval.

a  Go to the registry setting
HKEY_LOCAL_MACHINE\SYSTEM \ CurrentControlSet\ Services\ W32Time \ TimeProviders\ Nt
pClient,

b  Set the SpecialPollInterval value to 900.

Restart the W32time service for the changes to take effect.

Configuring vCenter Server in the vSphere Client

Use the vCenter Server Settings dialog box to configure vCenter Server, including settings such as licensing,
statistics collection, logging and other settings.

VMware, Inc.

Configure License Settings for vCenter Server on page 50

You must configure a license to use vCenter Server. License keys are required for various vSphere
components and features.

Configuring Statistics Settings on page 51

To set up how statistical data is recorded, you configure statistics collection intervals. You can access the
stored statistical information through command-line monitoring utilities or by viewing performance
charts in the vSphere Client.

Configure Runtime Settings on page 53

You can change the port number the server is using for communications. You can also change the
vCenter Server ID and the vCenter Server Managed IP address. Usually, you do not need to change these
settings, but you might need to make changes if you run multiple vCenter Server systems in the same
environment.

Configure Active Directory Settings on page 53

You can configure some of the ways vCenter Server interacts with the Active Directory server.

Configure Mail Sender Settings on page 54

You must configure the email address of the sender account in order to enable vCenter Server operations,
such as sending email notifications as alarm actions.
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Configure SNMP Settings on page 55

You can configure up to four receivers to receive SNMP traps from vCenter Server. For each receiver,
specify a host name, port, and community.

View Ports Settings on page 55

You can view the ports used by the Web service to communicate with other applications. You can no
longer configure these port settings.

Configure Timeout Settings on page 55

You can configure the timeout intervals for vCenter Server operations. These intervals specify the amount
of time after which the vSphere Client times out.

Configure Logging Options on page 56

You can configure the amount of detail that vCenter Server collects in log files.

Configure the Maximum Number of Database Connections on page 56

You can configure the maxiumum number of database connections that can occur simultaneously.

Configure Database Retention Policy on page 57

In order to limit the growth of the vCenter Server database and conserve storage space, you can configure
the database to discard information about tasks or events after a specified period of time.

Configure SSL Settings on page 57

You can configure vCenter Server to check the SSL certificates of hosts to which it connects. If you select
this option, vCenter Server and the vSphere Client check for valid SSL certificates before connecting to
a host for such operations as adding a host or making a remote console connection to a virtual machine.
Configure Advanced Settings on page 58

You can use the Advanced Settings page to modify the vCenter Server configuration file, vpxd. cfg.

Configure License Settings for vCenter Server

You must configure a license to use vCenter Server. License keys are required for various vSphere components
and features.

Prerequisites

To configure licenses, the vSphere Client must be connected to a vCenter Server system.

Required privilege: Global.Settings

Procedure

1  Ifnecessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog
box.

2 If the vCenter Server system is part of a connected group, select the server you want to configure from the
Current vCenter Serverdrop-down menu.

3 Select the type of license key to assign to this vCenter Server.

B Select Assign an existing license key to this vCenter Serverand select a license key from the Product
list.

B Select Assign a new license key to this vCenter Server, click Enter Key, and enter a vCenter Server
license key and an optional label for the key.

Note To enter ESX 4.0/ESXi 4.0 keys, select Home > Administration > Licensing.
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4  (Optional) Enter the fully qualified domain name or the IP address of a license server and, optionally, a
port.

A license server is required if this vCenter Server system manages ESX 3.x/ESXi 3.5 hosts or if you have
additional vCenter modules that require a license server.

If you do not specify a port, the default port, 27000, is used.

For example, with the default license server port 27000 on a license server called license, your entry might
look like this:

27000@1license.example.com

If you do not use the fully qualified domain name or the IP address of the license server, legacy hosts
might not be able to resolve the license server host name.

5 (Optional) Select Reconfigure ESX 3 hosts using license servers to use this server if you want each
ESX 3.x/ESXi 3.5 host that you add to the vCenter Server inventory to use the same license server as this
vCenter Server system.

The settings on the host are altered by vCenter Server only when the host is added or when the license
server used by vCenter Server is changed. If you leave this option unselected, you can either configure
another license server for the ESX 3.x/ESXi 3.5 hosts or configure the hosts to use host-based license files.

Configuring Statistics Settings

To set up how statistical data is recorded, you configure statistics collection intervals. You can access the stored
statistical information through command-line monitoring utilities or by viewing performance charts in the
vSphere Client.
B Configure Statistics Intervals on page 51
Statistic intervals determine the frequency at which statistic queries occur, the length of time statistical
data is stored in the database, and the type of statistical data collected.
B Enable or Disable a Statistics Interval on page 52

Enabling a statistics interval increases the number of statistics stored in the vCenter Server database.
Disabling a statistics interval disables all subsequent intervals and decreases the number of statistics
stored in the vCenter Server database.

B Estimate the Effect of Statistics Collection on the Database on page 52

The impact of the statistics collection on your vCenter Server database is based on the current
vCenter Server and inventory size.
Configure Statistics Intervals

Statistic intervals determine the frequency at which statistic queries occur, the length of time statistical data is
stored in the database, and the type of statistical data collected.

Required privilege: Global.Settings

Note Not all interval attributes are configurable.

Prerequisites
To configure statistics settings, the vSphere Client must be connected to a vCenter Server system.
Procedure

1  If necessary, select Administration > Settings to open the vCenter Server Settings dialog
boxvCenter Server.

2 If your environment uses multiple vCenter Servers, in Current vCenter Server, select the server.
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3 Inthe navigation panel, select Statistics.
4 In the Statistics Intervals section, select or deselect a collection interval to enable or disable it.

Enabling a longer interval automatically enables all shorter intervals.

5 To change a collection interval attribute, select its row in the Statistics Interval section and click Edit to

open the Edit Collection Interval dialog box.
a InKeep Samples for, select an archive length.
This option is configurable only for the Day and Year intervals.
b  In Statistics Interval, select an interval duration.
This option is configurable only for the Day interval.
¢ In Statistics Level select a new level interval level.

Level 4 uses the highest number of statistics counters. Use it only for debugging purposes.

The statistics level must be less than or equal to the statistics level set for the preceeding statistics

interval. This is a vCenter Server dependency.
6  (Optional) In the Database Size section, estimate the effect of the statistics settings on the database.
a  Enter the number of Physical Hosts.

b  Enter the number of Virtual Machines.

The estimated space required and number of database rows required are calculated and displayed.

¢ If necessary, make changes to your statistics collection settings.

7  Click OK.

Enable or Disable a Statistics Interval

Enabling a statistics interval increases the number of statistics stored in the vCenter Server database. Disabling

a statistics interval disables all subsequent intervals and decreases the number of statistics stored in the
vCenter Server database.

Required privilege: Global.Settings

Prerequisites

To configure statistics settings, the vSphere Client must be connected to a vCenter Server system.
Procedure

1  Select or deselect the statistics interval check box.

2 Click OK.

Estimate the Effect of Statistics Collection on the Database

The impact of the statistics collection on your vCenter Server database is based on the current
vCenter Server and inventory size.

Required privilege: Global.Settings

Prerequisites

To configure statistics settings, the vSphere Client must be connected to a vCenter Server system.
Procedure

1  If necessary, configure the statistics intervals.
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2 In the database calculator pane, specify the number of hosts and virtual machines in your datacenter.
a  Enter the number of Physical Hosts.
b  Enter the number of Virtual Machines.
The estimated space required and number of database rows required are calculated and displayed.
¢ If necessary, make changes to your statistics collection settings.

3 Click OK.

Configure Runtime Settings

You can change the port number the server is using for communications. You can also change the
vCenter Server ID and the vCenter Server Managed IP address. Usually, you do not need to change these
settings, but you might need to make changes if you run multiple vCenter Server systems in the same
environment.

Required privilege: Global.Settings

Prerequisites

To configure runtime settings, the vSphere Client must be connected to the vCenter Server system.

Procedure

1  Ifnecessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog
box.

2 If the vCenter Server system is part of a connected group, select the server you want to configure from the
Current vCenter Serverdrop-down menu.

3 Inthe navigation panel, select Runtime Settings.
4 InvCenter Server Unique ID, enter a unique ID.

You can change this value to a number from 0 through 63 to uniquely identify each vCenter Server system
running in a common environment. By default, an ID value is generated randomly.

5 InvCenter Server Managed IP, enter the vCenter Server system IP address.
6 InvCenter Server Name, enter the name of the vCenter Server system.

If you change the DNS name of the vCenter Server, use this option to modify the vCenter Server name to
match.

7 Click OK to save your changes and close the dialog box.
What to do next
If you made changes to the vCenter Server system Unique ID, you must restart the vCenter Server system for

these changes to take effect.

Configure Active Directory Settings
You can configure some of the ways vCenter Server interacts with the Active Directory server.

Required privilege: Global.Settings

Prerequisites

To configure active directory settings, the vSphere Client must be connected to the vCenter Server system.

VMware, Inc. 53



vCenter Server and Host Management

54

Procedure

1  Ifnecessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog
box.

2 If the vCenter Server system is part of a connected group, select the server you want to configure from the
Current vCenter Server drop-down menu.

3  Inthe navigation pane, select Active Directory.

4  In Active Directory Timeout, enter the timeout interval in seconds for connecting to the Active Directory
server.

5  Select Enable Query Limit to limit the number of users and groups displayed in the Add Permissions
dialog box.

6 In Users & Groups, enter the maximum number of users and groups to display.
If you enter 0 (zero), all users and groups appear.

7  Select Enable Validation to have vCenter Server periodically check its known users and groups against
the Active Directory server.

8 In Validation Period, enter the number of minutes between instances of synchronization.

9  (lick OK to save your changes and close the dialog box.

Configure Mail Sender Settings

You must configure the email address of the sender account in order to enable vCenter Server operations, such

as sending email notifications as alarm actions.

Required privilege: Global.Settings

Prerequisites

To configure SMTP notifications, the vSphere Client must be connected to the vCenter Server system.

Procedure
1  Ifnecessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog
box.
2 If the vCenter Server system is part of a connected group, select the server you want to configure from the
Current vCenter Serverdrop-down menu.
3  Inthe navigation pane, select Mail.
4  Enter the SMTP server information.
The SMTP Server is the DNS name or IP address of the SMTP gateway to use for sending email messages
5  Enter the sender account information.
The Sender Account is the email message address of the sender.
Note The full email address must be entered, including the domain name (the information after the @
sign).
For example, mail_server@datacenter.com.
6 Click OK.

What to do next

To test the mail settings, create an alarm that can be triggered by a user action, such as an alarm triggered by

powering off a virtual machine, and verify that you receive an email when the alarm is triggered.
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Configure SNMP Settings

You can configure up to four receivers to receive SNMP traps from vCenter Server. For each receiver, specify
a host name, port, and community.

Prerequisites
To configure SNMP settings, the vSphere Client must be connected to a vCenter Server system.

Required privilege: Global.Settings

Procedure

1  Ifnecessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog
box.

2 If the vCenter Server system is part of a connected group, select the server you want to configure from the
Current vCenter Server drop-down menu.

3 In the settings list, select SNMP.

4  In Receiver URL, enter the host name or IP address of the SNMP receiver.

5 In the field next to the Receiver URL field, enter the port number of the receiver.
The port number must be a value between 1 and 65535.

6 In Community, enter the community identifier.

7  Click OK.

View Ports Settings

You can view the ports used by the Web service to communicate with other applications. You can no longer
configure these port settings.

The Web Service is installed as part of the VMware vCenter Server installation. The Web Service is a required
component for third-party applications that use the VMware SDK application programming interface (API).
For information about Web Service installation, see the vSphere Installation and Setup documentation.

Procedure

1  Ifnecessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog
box.

2 If the vCenter Server system is part of a connected group, select the server you want to configure from the
Current vCenter Serverdrop-down menu.

3 In the settings list, select Ports.
The ports used by the Web service are displayed.
4  Click OK.

Configure Timeout Settings

You can configure the timeout intervals for vCenter Server operations. These intervals specify the amount of
time after which the vSphere Client times out.

Required privilege: Global.Settings

Prerequisites

To configure timeout settings, the vSphere Client must be connected to the vCenter Server system.
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Procedure

1  Ifnecessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog
box.

2 If the vCenter Server system is part of a connected group, select the server you want to configure from the
Current vCenter Serverdrop-down menu.

3 Inthe settings list, select Timeout Settings.

4  In Normal Operations, enter the timeout interval in seconds for normal operations.
Do not set the value to zero (0).

5 In Long Operations, enter the timeout interval in minutes for long operations.
Do not set the value to zero (0).

6 Click OK.

7  Restart the vCenter Server system for the changes to take effect.

Configure Logging Options

You can configure the amount of detail that vCenter Server collects in log files.

Required privilege: Global.Settings

Prerequisites

To configure statistics settings, the vSphere Client must be connected to a vCenter Server system.

Procedure
1  Ifnecessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog
box.
2 If the vCenter Server system is part of a connected group, select the server you want to configure from the
Current vCenter Serverdrop-down menu.
3 In the settings list, select Logging Options.
4 From the vCenter Server Logging list, select logging options.
Option Description
None (Disable logging) Turn off logging
Error (Errors only) Display only error log entries
Warning (Errors and warnings) Display warning and error log entries
Info (Normal logging) Displays information, error, and warning log entries
Verbose (Verbose) Displays information, error, warning, and verbose log entries
Trivia (Extended verbose) Displays information, error, warning, verbose, and trivia log entries
5 Click OK.

Changes to the logging settings take effect immediately. You do not need to restart vCenter Server system.

Configure the Maximum Number of Database Connections

You can configure the maxiumum number of database connections that can occur simultaneously.

Prerequisites

To configure database settings, the vSphere Client must be connected to a vCenter Server system.
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Procedure

1  Ifnecessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog
box.

2 If the vCenter Server system is part of a connected group, select the server you want to configure from the
Current vCenter Serverdrop-down menu.

3 In the settings list, select Database.
4  In Maximum number, type the number.

Generally, you do not need to change this value. You might want to increase this number if your
vCenter Server system frequently performs many operations and performance is critical. You might want
to decrease this number, if the database is shared and connections to the database are costly. VMware
recommends that you not change this value unless one of these issues pertains to your system.

5 Click OK.

Configure Database Retention Policy

In order to limit the growth of the vCenter Server database and conserve storage space, you can configure the
database to discard information about tasks or events after a specified period of time.

Do not use these options if you want to retain a complete history of tasks and events for your vCenter Server.

Prerequisites

To configure the database retention policy, the vSphere Client must be connected to a vCenter Server system.

Procedure

1  Ifnecessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog
box.

2 Select Database Retention Policy.
3  (Optional) SelectTasks retained for, and enter a value in days in the text box.

Information about tasks performed on this vCenter Server system will be discarded after the specified
number of days.

4  (Optional) SelectEvents retained for, and enter a value in days in the text box.

Information about events for this vCenter Server system will be discarded after the specified number of
days.

Configure SSL Settings

You can configure vCenter Server to check the SSL certificates of hosts to which it connects. If you select this
option, vCenter Server and the vSphere Client check for valid SSL certificates before connecting to a host for
such operations as adding a host or making a remote console connection to a virtual machine.

Required privilege: Global.Settings

Prerequisites

To configure SSL settings, the vSphere Client must be connected to a vCenter Server system.
Procedure

1  Ifnecessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog
box.
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2 If the vCenter Server system is part of a connected group, select the server you want to configure from the
Current vCenter Server drop-down menu.

3 In Current vCenter Server, select the appropriate server.
4 In the settings list, select SSL Settings.
5  Select vCenter requires verified host certificates.

If there are hosts that require manual validation, these hosts appear in the host list at the bottom of the
dialog box.

6  Determine the host thumbprint for each host that requires validation.
a Log into the direct console.
b Select View Support Information on the System Customization menu.
The thumbprint is displayed in the column on the right.

7  Compare the thumbprint you obtained from the host with the thumbprint listed in the vCenter Server
Settings dialog box.

8  If the thumbprints match, select the check box for the host.
Hosts that are not selected will be disconnected after you click OK.

9 Click OK.

Configure Advanced Settings

You can use the Advanced Settings page to modify the vCenter Server configuration file, vpxd. cfg.

This page can be used to add entries to the vpxd. cfg file, but not to edit or delete them. VMware recommends
that you change these settings only when instructed to do so by VMware technical support or when you are
following specific instructions in VMware documentation.

Required privilege: Global.Settings

Prerequisites

To configure statistics settings, the VI Client must be connected to a vCenter Server system.

Procedure

1  Ifnecessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog
box.

2 If the vCenter Server system is part of a connected group, select the server you want to configure from the
Current vCenter Server drop-down menu.

In the settings list, select Advanced Settings.

In the Key field, type a key.

In the Value field, type the value for the specified key.
Click Add.
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Click OK.

What to do next

Many advanced options changes require that the vCenter Server system be restarted before they take effect.
Consult VMware technical support to determine if your changes require a restart.
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Configuring vCenter Server in the vSphere Web Client

You can configure vCenter Server from the vSphere Web Client, including settings such as licensing, statistics
collection, logging, and other settings.

Configure License Settings for vCenter Server in the vSphere Web Client

You must assign a license key to vCenter Server after its evaluation period expires or its currently assigned
license key expires. Various vSphere components and features are unlocked by using license keys.

Prerequisites
Required privileges:
B Global.Settings
B Global.Licenses
Procedure

1  In the vSphere Web Client, navigate to the vCenter Server instance.

2 Select the Manage tab.

3 Under Settings, select Licensing.

4  Select Assign License Key.

5 From the drop-down list, select an option.

Option Description

Assign an existing license key Select from the license keys that already exist in the inventory of the vCenter
Server system.

Assign a new license key Enter a new license key and assign it to vCenter Server. You can click
Decode to verify that the license key is valid, and that it belongs to the correct
product.

6  Click OK.

The license key is assigned to the vCenter Server system, and one instance from the license capacity is allocated
for the vCenter Server system.

Configuring Statistics Settings in the vSphere Web Client

To set up how statistical data is recorded, you configure collection intervals for statistics. You can access the
stored statistical information through command-line monitoring utilities or by viewing performance charts in
the vSphere Web Client.

Configure Statistics Collection Intervals in the vSphere Web Client

Statistic collection intervals determine the frequency at which statistic queries occur, the length of time
statistical data is stored in the database, and the type of statistical data that is collected. You can view the
collected statistics through the performance charts in the vSphere Web Client or through command-line
monitoring utilities.

Note Not all interval attributes are configurable.

Prerequisites

Required privilege: Performance.ModifyIntervals
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Procedure

1  Inthe vSphere Web Client, navigate to the vCenter Server instance.
Select the Manage tab.

Under Settings, select General.

Click Edit.
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From Statistics intervals, click a statistics interval attribute to edit its value.

a In Interval duration, select the time interval in which statistics data is collected.
b  In Save for, select for how long the archived statistics are kept in the database.
¢ In Statistics level, select a new level for collecting statistics.

The lower the level is, the fewer number of statistic counters are used. Level 4 uses all statistics
counters. Use it only for debugging purposes.

The statistics level must be less than or equal to the statistics level that is set for the preceding statistics
interval. This is a vCenter Server dependency.

6  (Optional) In Database Size, estimate the effect of the statistics settings on the database.
a  Enter the number of Physical Hosts.
b  Enter the number of Virtual Machines.
The estimated space required and number of database rows required are calculated and displayed.
¢ If necessary, make changes to your statistics collection settings.
7 Click OK.
Example: Relationships Between the Default Settings for Statistics Intervals
B Samples that are collected every 5 minutes are stored for 1 day.
B Samples that are collected every 30 minutes are stored for 1 week.
B Samples that are collected every 2 hours are stored for 1 month.
B Samples that are collected on 1 day are stored for 1 year.
For all statistics intervals, the default level is 1. It uses the Cluster Services, CPU, Disk, Memory, Network,

System, and Virtual Machine Operations counters.

Estimate the Effect of Statistics Collection on the Database in the
vSphere Web Client

The impact of the statistics collection on your vCenter Server database depends on the current inventory size
of vCenter Server.

Prerequisites

Required privilege: Global.Settings

Procedure

1  (Optional) If necessary, configure the statistics intervals.
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2 In Database Size, estimate the effect of the statistics settings on the database.

a

b

C

Enter the number of Physical Hosts.

Enter the number of Virtual Machines.

The estimated space required and number of database rows required are calculated and displayed.

If necessary, make changes to your statistics collection settings.

3 Click OK.

Data Collection Levels

Each collection interval has a default collection level that determines the amount of data gathered and which
counters are available for display in charts. Collection levels are also refered to as statistics levels.

Table 4-1. Statistics Levels

Level Metrics Best Practice
Level 1 ®  Cluster Services (VMware Distributed Resource Scheduler) -  Use for long-term performance
all metrics monitoring when device statistics are
CPU - cpuentitlement, totalmhz, usage (average), usagemhz ~ not required.
B Disk — capacity, maxTotalLatency, provisioned, unshared, Level 1 is the default Collection Level
usage (average), used for all Collection Intervals.
B Memory — consumed, mementitlement, overhead,
swapinRate, swapoutRate, swapused, totalmb, usage
(average), vmmemctl (balloon)
Network — usage (average), IPv6
System — heartbeat, uptime
B Virtual Machine Operations - numChangeDS,
numChangeHost, numChangeHostDS
Level 2 ®  Level 1 metrics Use for long-term performance
B CPU -idle, reservedCapacity monitoring when device statistics are
®  Disk — All metrics, excluding numberRead and numberWrite. not required but you we?nt. to monitor
. . . more than the basic statistics.
B Memory — All metrics, excluding memUsed and maximum
and minimum rollup values.
B Virtual Machine Operations — All metrics
Level 3 Level 1 and Level 2 metrics Use for short-term performance
Metrics for all counters, excluding minimum and maximum  monitoring after encountering
rollup values. problems or when device statistics are
B Device metrics required.
Because of the large quantity of
troubleshooting data retrieved and
recorded, use level 3 for the shortest
time period ( Day or Week collection
interval).
Level 4 All metrics supported by the vCenter Server, including minimum  Use for short-term performance

and maximum rollup values.

monitoring after encountering
problems or when device statistics are
required.

Because of the large quantity of
troubleshooting data retrieved and
recorded, use level 4 for the shortest
amount of time.

VMware, Inc.
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Configure Runtime Settings for vCenter Server in the vSphere Web Client

You can change the vCenter Server ID, managed address, and name. Usually, you do not need to change these
settings, but you might need to make changes if you run multiple vCenter Server systems in the same
environment.

Prerequisites

Required privilege: Global.Settings

Procedure

1  In the vSphere Web Client, navigate to the vCenter Server instance.
Select the Manage tab.

Under Settings, select General.

In the Edit vCenter Server Settings dialog box, select Runtime Settings.
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In vCenter Server unique ID, type a unique ID.

You can change this value to a number from 0 through 63 to uniquely identify each vCenter Server system
running in a common environment. By default, an ID value is generated randomly.

6 InvCenter Server managed address, type the vCenter Server system address.
The address can be IPv4, IPv6, a fully qualified domain name, an IP address, or another address format.
7  InvCenter Server name, type the name of the vCenter Server system.

If you change the DNS name of the vCenter Server, use this option to modify the vCenter Server name to
match.

8 (Click OK to save your changes and close the dialog box.
What to do next

If you made changes to the vCenter Server system unique ID, you must restart the vCenter Server system for
these changes to take effect.

Configure User Directory Settings in the vSphere Web Client

You can configure some of the ways vCenter Server interacts with the user directory server that is configured
as identity source. For details about identity sources, see vSphere Security.

Prerequisites

Required privilege: Global.Settings

Procedure

1  In the vSphere Web Client, navigate to the vCenter Server instance.
Select the Manage tab.

Under Settings, select General.

Click Edit.

Select User directory.
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In User directory timeout, type the timeout interval in seconds for connecting to the user directory server.
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In Query Limit, type the number of users and groups for which you can associate permissions on the child
inventory objects of the vCenter Server system.

You can associate permissions with users and groups from the Add Permissions dialog box that displays
when you click Add permissions in Manage > Permissions for a vSphere inventory object.

Select the Enabled check box next to Validation to have vCenter Server periodically check its known users
and groups against the user directory server.

In Validation Period, enter the number of minutes between instances of synchronization.

Click OK.

Configure Mail Sender Settings in the vSphere Web Client

You must configure the email address of the sender account if you want to enable vCenter Server operations,

such as sending email notifications as alarm actions.

Prerequisites

Required privilege: Global.Settings

Procedure

1
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In the vSphere Web Client, navigate to the vCenter Server instance.

Select the Manage tab.

Under Settings, select General.

Click Edit.

Select Mail.

In Mail server, type the SMTP server information.

The SMTP server is the DNS name or IP address of the SMTP gateway to use for sending email messages.
In Mail sender, type the sender account information.

The sender account is the email address of the sender.

Note You must type the full email address, including the domain name.

For example, mail_server@example.com.

Click OK.

What to do next

To test the mail settings, create an alarm that can be triggered by a user action, such as by powering off a virtual
machine, and verify that you receive an email when the alarm is triggered.

Configure SNMP Settings in the vSphere Web Client

You can configure up to four receivers to receive SNMP traps from vCenter Server. For each receiver, specify

a host name, port, and community.

Prerequisites

Required privilege: Global.Settings

Procedure

1
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In the vSphere Web Client, navigate to the vCenter Server instance.
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Select the Manage tab.

Under Settings, select General.

Click Edit.

Select SNMP receivers.

In Receiver URL, type the host name or IP address of the SNMP receiver.

Select the Enabled check box next to Enable receiver.
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In Receiver port, type the port number of the receiver.
The port number must be a value between 1 and 65535.
9 In Community string, type the community identifier.

10 Click OK.

View Port Settings in the vSphere Web Client

You can view the ports used by the Web service to communicate with other applications. You cannot configure
these port settings.

The Web service is installed as part of the VMware vCenter Server installation. The Web service is a required
component for third-party applications that use the VMware SDK application programming interface (API).
For information about installing the Web service, see the vSphere Installation and Setup documentation.

Procedure

1  Inthe vSphere Web Client, navigate to the vCenter Server instance.
Select the Manage tab.

Under Settings, select General.

Click Edit.
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Select Ports.
The ports used by the Web service are displayed.
6 Click OK.

Configure Timeout Settings in the vSphere Web Client

You can configure the timeout intervals for vCenter Server operations. These intervals specify the amount of
time after which the vSphere Web Client times out.

Prerequisites

Required privilege: Global.Settings

Procedure

1  In the vSphere Web Client, navigate to the vCenter Server instance.
Select the Manage tab.

Under Settings, select General.

Click Edit.

Select Timeout settings.
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In Normal operations, type the timeout interval in seconds for normal operations.

Do not set the value to zero (0).
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7 InLong operations, enter the timeout interval in minutes for long operations.
Do not set the value to zero (0).
8 Click OK.

9  Restart the vCenter Server system for the changes to take effect.

Configure Logging Options in the vSphere Web Client

You can configure the amount of detail that vCenter Server collects in log files.

Prerequisites
Required privilege: Global.Settings
Procedure

1  In the vSphere Web Client, navigate to the vCenter Server instance.

2 Select the Manage tab.
3 Under Settings, select General.
4  Click Edit.
5  Select Logging settings.
6  Select the logging options.
Option Description
None (Disable logging) Turns off logging
Error (Errors only) Displays only error log entries
Warning (Errors and warnings) Displays warning and error log entries
Info (Normal logging) Displays information, error, and warning log entries
Verbose (Verbose) Displays information, error, warning, and verbose log entries
Trivia (Extended verbose) Displays information, error, warning, verbose, and trivia log entries
7  Click OK.

Changes to the logging settings take effect immediately. You do not need to restart vCenter Server system.

Configure Database Settings in the vSphere Web Client

You can configure the maximum number of database connections that can occur simultaneously. To limit the
growth of the vCenter Server database and save storage space, you can configure the database to discard
information about tasks or events periodically.

Note Do not use the database retention options if you want to keep a complete history of tasks and events
for your vCenter Server.

Procedure

1  In the vSphere Web Client, navigate to the vCenter Server instance.
Select the Manage tab.

Under Settings, select General.

Click Edit.
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Select Database.

VMware, Inc. 65



vCenter Server and Host Management

66

10

11

In Maximum connections, type a number.

Increase this number if your vCenter Server system performs many operations frequently and
performance is critical. Decrease this number if the database is shared and connections to the database are
costly. Do not change this value unless one of these issues pertains to your system.

Select the Enabled check box next to Task cleanup to have vCenter Server periodically delete the retained
tasks.

(Optional) In Tasks retained for, type a value in days.

Information about tasks that are performed on this vCenter Server system is discarded after the specified
number of days.

Select the Enabled check box next to Event cleanup to have vCenter Server periodically clean up the
retained events.

(Optional) In Events retention, type a value in days.
Information about events for this vCenter Server system are discarded after the specified number of days.

Click OK.

Configure SSL Settings in the vSphere Web Client

You can configure vCenter Server to check the SSL certificates of hosts to which it connects. If you configure

this setting, vCenter Server and the vSphere Web Client check for valid SSL certificates before connecting to a

host for operations such as adding a host or making a remote console connection to a virtual machine.

Note Configuring SSL settings is available only for vCenter Server 5.0 systems.

vCenter Server 5.1 always connects through SSL with ESXi hosts.

Procedure
1  In the vSphere Web Client, navigate to the vCenter Server instance.
2 Select the Manage tab.
3 Under Settings, select General.
4  Click Edit.
5  Select SSL settings.
6  Determine the host thumbprint for each host that requires validation.
a Login to the direct console.
b Select View Support Information on the System Customization menu.
The thumbprint is displayed in the column on the right.
7 Compare the thumbprint you obtained from the host with the thumbprint listed in the vCenter Server
Settings dialog box.
8  If the thumbprints match, select the check box for the host.
Hosts that are not selected will be disconnected after you click OK.
9 Click OK.
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Configure Advanced Settings in the vSphere Web Client
In Advanced Settings, you can modify the vCenter Server configuration file, vpxd. cfg.

You can use Advanced Settings to add entries to the vpxd. cfg file, but not to edit or delete them. VMware
recommends that you change these settings only when instructed to do so by VMware technical support or
when you are following specific instructions in VMware documentation.

Prerequisites

Required privilege: Global.Settings

Procedure

1 In the vSphere Web Client, navigate to the vCenter Server instance.
Select the Manage tab.

Select Advanced Settings.

Click Edit.

In the Key, type a key.

In the Value field, type the value for the specified key.

Click Add.
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Click OK.

Newly added advanced settings have config. appended to the setting keys in the vpxd.cfg file. For example:

config.example.setting = exampleValue

What to do next

Many advanced settings changes require that the vCenter Server system be restarted before they take effect.
Consult VMware technical support to determine if your changes require a restart.

Send a Message to Other Logged In Users in the vSphere Web Client

You might sometimes need to send messages to users who are currently logged in to a vCenter Server system.
For example, if you need to perform maintenance on a desktop, you can ask the user to log out temporarily,
or warn them of a future interruption of service.

Procedure
1  In the vSphere Web Client, navigate to the vCenter Server instance.
Select the Manage tab.

Under Settings, select Message of the Day, and click Edit.
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Type the Message of the Day, and click OK.

A warning appears at the top of the vSphere Web Client in every active user session advising users to read the
Message of the Day that is set in the relevant vCenter Server system.

Configuring the VMware vCenter Server Appliance

The VMware vCenter Server Appliance is a preconfigured Linux-based virtual machine that is optimized for
running vCenter Server and associated services.

For VMware vCenter Server Appliance installation, see the vSphere Installation and Setup publication.
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The following features are not supported by the VMware vCenter Server Appliance.

Linked Mode
Microsoft SQL Server as a supported local or remote database

DB2 as a supported remote database

The vCenter Sever Appliance is supported only on ESX/ESXi 4.0 and 4.1 andESXi 5.0 and 5.1.

Log In to the VMware vCenter Server Appliance Web Console on page 69

Log in to the VMware vCenter Server Appliance Web console to access VMware vCenter Server
Appliance configuration settings.

Configure Database Settings for the VMware vCenter Server Appliance on page 69

Configure database settings, such as database type and log in, for the VMware vCenter Server Appliance.

Configure Network Settings for the VMware vCenter Server Appliance on page 70

Configure network settings for the VMware vCenter Server Appliance to specify static IP and proxy
settings.

Start vCenter Server in the VMware vCenter Server Appliance on page 70

Start vCenter Server from the VMware vCenter Server Appliance.

Stop vCenter Server in the VMware vCenter Server Appliance on page 71

Stop vCenter Server from the VMware vCenter Server Appliance. A restart of vCenter Server is required
for some setting changes to take effect.

Start or Stop ESXi Services in the VMware vCenter Server Appliance on page 71

Some VMware vCenter Server Appliance configuration changes require a restart of ESXi services to take
effect.

Configuring vCenter Single Sign On in the VMware vCenter Server Appliance on page 71

An instance of vCenter Single Sign On runs on the vCenter Server Appliance. By default, vCenter Server
uses this embedded Single Sign On instance. You can configure the Single Sign On database settings and
change the deployment type from embedded to external.

Change the vCenter Single Sign On Mode in the VMware vCenter Virtual Appliance on page 72

An instance of vCenter Single Sign On runs on the vCenter Server Appliance. By default, vCenter Server
uses the embedded Single Sign On instance, but you can change this configuration by pointing to an
external instance of Single Sign On running on another system. Multiple instances of vCenter Server can
point to the same instance of Single Sign On.

Change the Administrator Password for the VMware vCenter Server Appliance on page 72

You can change the vCenter Server administrator password in the VMware vCenter Server Appliance.

Enable or Disable SSH Administrator Login on the VMware vCenter Server Appliance on page 73
You can enable or disable the ability to log in to the VMware vCenter Server Appliance using SSH.

Configure Inventory Size for the VMware vCenter Server Appliance on page 73

Set the inventory size of the VMware vCenter Server Appliance based on the number of hosts and virtual
machines that you plan to have in the VMware vCenter Server Appliance inventory.

Configure ESXi Dump Collector on the VMware vCenter Server Appliance on page 73

You can use ESXi Dump Collector to configure and dump a host's kernel core to a network server on the
datacenter when the system fails. ESXi Dump Collector is installed and enabled by default on the VMware
vCenter Server Appliance.
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Configure ESXi Auto Deploy Settings on the VMware vCenter Server Appliance on page 74

If you are using the VMware vCenter Server appliance for Auto Deploy, you can change the server port
and maximum repository size for Auto Deploy.

Configure NFS Storage on the VMware vCenter Server Appliance on page 74

Enable storing VMware vCenter Server Appliance log and core files on NFS to store VMware vCenter
Server Appliance files on an NFS datastore.

Configure Authentication Settings on the VMware vCenter Server Appliance on page 75

You can configure authentication settings on the VMware vCenter Server Appliance.

Log In to the VMware vCenter Server Appliance Web Console

Log in to the VMware vCenter Server Appliance Web console to access VMware vCenter Server Appliance
configuration settings.

Prerequisites

Install the VMware vCenter Server Appliance. See the vSphere Installation and Setup documentation.

Procedure

1

Go to the configuration address that your VMware vCenter Server Appliance virtual machine provides:
https://VMuware vCenter Server Appliance IP address:5480.

Type your user name and password, and click Login.

The initial default user name is root, and the default password is vmware.

What to do next

The first time you log in to the VMware vCenter Server Appliance, accept the End-User License Agreement
by clicking Accept EULA and set the database type. See “Configure Database Settings for the VMware vCenter
Server Appliance,” on page 69.

Configure Database Settings for the VMware vCenter Server Appliance

Configure database settings, such as database type and log in, for the VMware vCenter Server Appliance.

Prerequisites

Install the VMware vCenter Server Appliance. See the vSphere Installation and Setup documentation.

Procedure

1 Login to the VMware vCenter Server Appliance Web console.

2 On the vCenter Server tab, select Database.

3 Select the Database Type from the drop-down menu.
Option Description
embedded Use the embedded database. This option is available only for a small

inventory size, with fewer than 5 hosts and 50 virtual machines.

oracle Use an external Oracle database.

4  Type the server and port information.
This option is disabled if the database type is set to embedded.
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5 Type the instance name.
This option is disabled if the Database Type is set to embedded.
6  Type the database login and password.
This option is disabled if the Database Type is set to embedded.
7 Click Test Settings to verify that the settings you entered are valid.
8  Click Save Settings to save your changes.
9  (Optional) Click Reset database contents.

10 Start or restart vCenter Server.

Configure Network Settings for the VMware vCenter Server Appliance

Configure network settings for the VMware vCenter Server Appliance to specify static IP and proxy settings.

Prerequisites

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings
for the VMware vCenter Server Appliance,” on page 69 and the vSphere Installation and Setup documentation.

Procedure

1 Log in to the VMware vCenter Server Appliance Web console.
2 On the Network tab, click Address.

3 Select the method by which vCenter Server obtains IP settings.

Option Description

DHCP vCenter Server obtains IP settings from a DHCP server. This is the default
setting.

Static vCenter Server uses static IP settings. Specify the IP address, netmask, and
gateway.

(Optional) Specify DNS configuration information.

Click Save Settings.

(Optional) Select Proxy, and select Use a proxy server to use a proxy server for vCenter Server.
(Optional) Specify a proxy server and proxy port. .

(Optional) Specify a proxy username and proxy password if your proxy server requires them.
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Click Save Settings.

Start vCenter Server in the VMware vCenter Server Appliance

Start vCenter Server from the VMware vCenter Server Appliance.

Prerequisites

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings
for the VMware vCenter Server Appliance,” on page 69 and the vSphere Installation and Setup documentation.

You should also configure vCenter Single Sign On. See “Configuring vCenter Single Sign On in the VMware
vCenter Server Appliance,” on page 71.

Procedure

1 Login to the VMware vCenter Server Appliance Web console.
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On the vCenter Server tab, select Summary.

Click Start vCenter.

You can now connect to vCenter Server using either the vSphere Client or the vSphere Web Client.

Stop vCenter Server in the VMware vCenter Server Appliance

Stop vCenter Server from the VMware vCenter Server Appliance. A restart of vCenter Server is required for

some setting changes to take effect.

Procedure

1
2
3

Log in to the VMware vCenter Server Appliance Web console.
On the vCenter Server tab, select Summary.

Click Stop for vCenter Server.

Start or Stop ESXi Services in the VMware vCenter Server Appliance

Some VMware vCenter Server Appliance configuration changes require a restart of ESXi services to take effect.

Procedure

1
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Log in to the VMware vCenter Server Appliance web console.
On the vCenter Server tab, click Summary.
(Optional) Under Services, click Stop to stop a particular ESXi services.

Click Start to start ESXi services.

Configuring vCenter Single Sign On in the VMware vCenter Server Appliance

An instance of vCenter Single Sign On runs on the vCenter Server Appliance. By default, vCenter Server uses
this embedded Single Sign On instance. You can configure the Single Sign On database settings and change
the deployment type from embedded to external.

For information about changing the Single Sign On mode from embedded to external, see “Change the vCenter
Single Sign On Mode in the VMware vCenter Virtual Appliance,” on page 72.

Prerequisites

Before you make changes to the Single Sign On configuration, you must stop the vCenter Server service.

Procedure

1  Log in to the VMware vCenter Server Appliance Web console.
2 On the vCenter Server tab, click SSO.

3 Select a Single Sign On database type.

A

CautioN When you change the database type, information in the Single Sign On database is deleted.
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Option Description
embedded Connect to the database that is running on this vCenter Server Appliance.
oracle Connect to an external, existing database.

Enter the external database information.
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5 Click Test Settings.
6  Click Save Settings.
What to do next

Start the vCenter Server service.

Change the vCenter Single Sign On Mode in the VMware vCenter Virtual Appliance

An instance of vCenter Single Sign On runs on the vCenter Server Appliance. By default, vCenter Server uses
the embedded Single Sign On instance, but you can change this configuration by pointing to an external
instance of Single Sign On running on another system. Multiple instances of vCenter Server can point to the
same instance of Single Sign On.

Prerequisites

Before you make changes to the Single Sign On configuration, you must stop the vCenter Server service on the
Summary tab of the vCenter Server Appliance Web console.

Procedure
1 Login to the VMware vCenter Server Appliance Web console.
On the vCenter Server tab, click SSO.

Select the deployment type external.
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Type the user name and password of a user with administrator privileges on the external instance of Single
Sign On.

This user is the Single Sign On administrator user (typically admin@System-Domain for a Single Sign On
instance running on WIndows and root@localos for a Single Sign On instance running on another vCenter
Server Appliance).

5 Type the name of the user or group who is the administrator of the vCenter Server system.
The user or group must exist on the external instance of Single Sign On.
6  Type the URL of the Lookup Service for the target instance of vCenter Single Sign On.

The format is typically https://external SSO IP or host name:7444/lookupservice/sdk, where 7444 is the
default HTTPS port for vCenter Single Sign On.

7 Click the Accept Certificate check box.
8  Click Test Settings.
9  Click Save Settings.

The instance of vCenter Server, the Inventory Service, and the vSphere Web Client are registered with the
external instances of Single Sign On and the Lookup Service.

What to do next

Start the vCenter Server service.

Change the Administrator Password for the VMware vCenter Server Appliance

You can change the vCenter Server administrator password in the VMware vCenter Server Appliance.

Procedure
1 Login to the VMware vCenter Server Appliance Web console.

2 On the Admin tab, type your current password in the Current administrator password text box.
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Type the new password in the New administrator password and Retype new administrator password
text boxes.

Click Change password.

Enable or Disable SSH Administrator Login on the VMware vCenter Server

Appliance
You can enable or disable the ability to log in to the VMware vCenter Server Appliance using SSH.
Procedure
1 Log in to the VMware vCenter Server Appliance web console.
2 Onthe Admin tab, click Toggle SSH login to allow log in to the VMware vCenter Server Appliance using
SSH..
3 (Optional) Click Toggle SSH login again to prevent log in to the VMware vCenter Server Appliance using

SSH.

Configure Inventory Size for the VMware vCenter Server Appliance

Set the inventory size of the VMware vCenter Server Appliance based on the number of hosts and virtual
machines that you plan to have in the VMware vCenter Server Appliance inventory.

Prerequisites

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings
for the VMware vCenter Server Appliance,” on page 69 and the vSphere Installation and Setup documentation.

Procedure
1  Power off the VMware vCenter Server Appliance virtual machine where it is installed.
2 Right-click the VMware vCenter Server Appliance virtual machine in the inventory pane and select Edit
Settings.
3  On the Hardware tab, select Memory.
4  Set the memory size based on your planned inventory size.
Option Description
4 GB or higher Memory requirement for fewer than 10 hosts and 100 virtual machines in the
VMware vCenter Server Appliance inventory.
8 GB or higher Memory requirement for between 10 and 100 hosts or between 100 and 1000
virtual machines in the VMware vCenter Server Appliance inventory.
16 GB or higher Memory requirement for between 100 and 400 hosts or between 1000 and
4000 virtual machines in the VMware vCenter Server Appliance inventory.
24 GB or higher Memory requirement for over 400 hosts or 4000 virtual machines in the
VMware vCenter Server Appliance inventory.
5 Click OK.

Configure ESXi Dump Collector on the VMware vCenter Server Appliance

You can use ESXi Dump Collector to configure and dump a host's kernel core to a network server on the
datacenter when the system fails. ESXi Dump Collector is installed and enabled by default on the VMware
vCenter Server Appliance.

ESXi Dump Collector does not support vSphere distributed switches in ESXi 5.0.
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Prerequisites

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings
for the VMware vCenter Server Appliance,” on page 69 and the vSphere Installation and Setup documentation.

Procedure
1 Log in to the VMware vCenter Server Appliance.
2 On the vCenter Server tab, click Services.

3 Type the size in the ESXi Dump Collector repository max size text box to specify the maximum core
dump repository size in GB.

4 Click Test Settings to verify that your changes are valid.
5 Click Save Settings.

6  Restart ESXi services.

What to do next

Configure hosts to dump kernel memory to the network server. See the vSphere Installation and Setup
documentation.

Configure ESXi Auto Deploy Settings on the VMware vCenter Server Appliance

If you are using the VMware vCenter Server appliance for Auto Deploy, you can change the server port and
maximum repository size for Auto Deploy.

Prerequisites

Enable the Auto Deploy server on the VMware vCenter Server Appliance. See the vSphere Installation and
Setup documentation.

Procedure
1 Log in to the VMware vCenter Server Appliance web console.
2 On the vCenter Server tab, click Services.

3 Inthe vSphere Auto Deploy repository max size field, type the maximum Auto Deploy repository size
in GB.

4  (Optional) Click Test Settings to verify that the specified settings are valid.
5 Click Save Settings.

6  Restart ESXi services.

Configure NFS Storage on the VMware vCenter Server Appliance

Enable storing VMware vCenter Server Appliance log and core files on NFS to store VMware vCenter Server
Appliance files on an NFS datastore.

Prerequisites

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings
for the VMware vCenter Server Appliance,” on page 69 and the vSphere Installation and Setup documentation.

Disable root squashing on the NFS server. For example, use the command exportfs -vo
rw,no_root_squash,sync :/share.

Procedure

1 Login to the VMware vCenter Server Appliance Web console.
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(Optional) On the vCenter Server tab, click Summary.
Click Stop for vCenter Server.

This action minimizes logging to the old storage location.
On the vCenter Server tab, click Storage.

(Optional) Select Enable storing log files on NFS and type the NFS share on which to store VMware
vCenter Server Appliance log files.

(Optional) Select Enable storing core files on NFS and type the NFS share on which to store VMware
vCenter Server Appliance core files.

(Optional) Click Test Settings to verify that the VMware vCenter Server Appliance can successfully store
files to the specified NFS shares.

Click Save Settings.

Restart the VMware vCenter Server Appliance.

Configure Authentication Settings on the VMware vCenter Server Appliance

You can configure authentication settings on the VMware vCenter Server Appliance.

Prerequisites

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings

for the VMware vCenter Server Appliance,” on page 69 and the vSphere Installation and Setup documentation.

Procedure

1 Log in to the VMware vCenter Server Appliance Web console and on the vCenter Server tab, cick
Authentication.

2 (Optional) Select Active Directory Enabled to enable an Active Directory server for the VMware vCenter
Server Appliance.

3 (Optional) Type the domain, administrator user name, and administrator password for the Active
Directory server and click Save Settings.

4  Restart VMware vCenter Server Appliance.

Configuring Communication Among ESXi, vCenter Server, and the
vSphere Client

By default, the vSphere Client uses ports 80 and 443 to communicate with vCenter Server and ESXi hosts.

Configure your firewall to allow communication between the vSphere Client and vCenter Server by opening
ports 80 and 443.

vCenter Server acts as a web service. If your environment requires the use of a web proxy, vCenter Server can
be proxied like any other web service.
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Using vCenter Server in Linked Mode

You can join multiple vCenter Server systems using vCenter Linked Mode to allow them to share information.
When a server is connected to other vCenter Server systems using Linked Mode, you can connect to that
vCenter Server system and view and manage the inventories of the linked vCenter Server systems.

Linked Mode uses Microsoft Active Directory Application Mode (ADAM) to store and synchronize data across
multiple vCenter Server systems. ADAM is installed as part of vCenter Server installation. Each ADAM
instance stores data from the vCenter Server systems in the group, including information about roles and
licenses. This information is replicated across all of the ADAM instances in the connected group to keep them
in sync.

When vCenter Server systems are connected in Linked Mode, you can perform the following actions:

B Log in simultaneously to vCenter Server systems for which you have valid credentials.

B Search the inventories of the vCenter Server systems in the group.

B View the inventories of the vCenter Server systems in the group in a single inventory view.

You cannot migrate hosts or virtual machines between vCenter Server systems connected in Linked Mode.
For more information on troubleshooting Linked Mode groups, see the vSphere Troubleshooting documentation.
This chapter includes the following topics:

B “Linked Mode Prerequisites for vCenter Server,” on page 77

B “Linked Mode Considerations for vCenter Server,” on page 78

B “Join a Linked Mode Group After Installation,” on page 79

B “Reconciling Roles When Connecting vCenter Server to a Linked Mode Group,” on page 80

B “Isolate a vCenter Server Instance from a Linked Mode Group,” on page 80

B “Change the Domain of a vCenter Server System in a Linked Mode Group,” on page 81

B “Configure the URLs on a Linked Mode vCenter Server System,” on page 81

B “Monitor vCenter Server Services,” on page 82

Linked Mode Prerequisites for vCenter Server

Prepare the vCenter Server system for joining a Linked Mode group.

Before joining a vCenter Server to a Linked Mode group, review “Linked Mode Considerations for vCenter
Server,” on page 78.

All the requirements for standalone vCenter Server systems apply to Linked Mode systems.
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The following requirements apply to each vCenter Server system that is a member of a Linked Mode group:

vCenter Server does not support Linked Mode groups that contain both version 5.x and pre-5.0 versions
of vCenter Server. Similarly, vCenter Server does not support Linked Mode groups that contain both
version 5.1.x and 5.0.x versions of vCenter Server. vCenter Server 5.0.x can be joined in a Linked Mode
group only with other instances of vCenter Server 5.0.x. vCenter Server 5.1.x can be joined in a Linked
Mode group only with other instances of vCenter Server 5.1.x. After all vCenter Servers in the group are
upgraded to version 5.0.x or all vCenter Servers in the group are upgraded to version 5.1.x, you can rejoin
them.

Make sure that all vCenter Servers in a Linked Mode group are registered to the same vCenter Single Sign
On server.

To join a Linked Mode group the vCenter Server must be in evaluation mode or licensed as a Standard
edition. vCenter Server Foundation and vCenter Server Essentials editions do not support Linked Mode.

DNS must be operational for Linked Mode replication to work.

The vCenter Server instances in a Linked Mode group can be in different domains if the domains have a
two-way trust relationship. Each domain must trust the other domains on which vCenter Server instances
are installed.

When adding a vCenter Server instance to a Linked Mode group, the installer must be run by a domain
user who is an administrator on both the machine where vCenter Server is installed and the target machine
of the Linked Mode group.

All vCenter Server instances must have network time synchronization. The vCenter Server installer
validates that the machine clocks are not more than five minutes apart. See “Synchronizing Clocks on the
vSphere Network,” on page 47.
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Consider several issues before you configure a Linked Mode group.

Before you configure a Linked Mode group, consider the following issues.

If you are upgrading a version 5.0.x vCenter Server that is part of a Linked Mode group, it will not be
removed from the group. If you are upgrading a pre-5.0 vCenter Server that is part of a Linked Mode
group, it will be removed from the group. vCenter Server does not support Linked Mode groups that
contain both version 5.x and pre-5.0 versions of vCenter Server. Similarly, vCenter Server does not support
Linked Mode groups that contain both version 5.1.x and 5.0.x versions of vCenter Server. vCenter Server
5.0.x can be joined in a Linked Mode group only with other instances of vCenter Server 5.0.x. vCenter
Server 5.1.x can be joined in a Linked Mode group only with other instances of vCenter Server 5.1.x. After
all vCenter Servers in the group are upgraded to version 5.0.x or all vCenter Servers in the group are
upgraded to version 5.1.x, you can rejoin them.

Each vCenter Server user sees the vCenter Server instances on which they have valid permissions.

When you set up your vCenter Server Linked Mode group, you must install the first vCenter Server as a
standalone instance because you do not yet have a remote vCenter Server machine to join. Subsequent
vCenter Server instances can join the first vCenter Server or other vCenter Server instances that have joined
the Linked Mode group.

If you join a vCenter Server to a standalone instance that is not part of a domain, you must add the
standalone instance to a domain and add a domain user as an administrator.

The vCenter Server instances in a Linked Mode group do not need to have the same domain user login.
The instances can run under different domain accounts. By default, they run as the LocalSystem account
of the machine on which they are running, which means that they are different accounts.

During vCenter Server installation, if you enter an IP address for the remote instance of vCenter Server,
the installer converts it into a fully qualified domain name.
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CauTtioN If you need to uninstall and reinstall vCenter Server on more than one member of a Linked
Mode group, do so with a single vCenter Server at a time. Uninstalling and reinstalling multiple linked
vCenter Servers at the same time is not supported, and can cause errors that prevent vCenter Server from
connecting to vCenter Inventory Service. If it is necessary to uninstall and reinstall multiple linked vCenter
Servers at the same time, isolate them from the Linked Mode group first, and rejoin them to the Linked
Mode group after the reinstallation is complete.

Join a Linked Mode Group After Installation

After installing vCenter Server, you can join a vCenter Server to a Linked Mode group.

Prerequisites

See “Linked Mode Prerequisites for vCenter Server,” on page 77 .

Norte vCenter Server does not support Linked Mode groups that contain both version 5.x and pre-5.0 versions
of vCenter Server. Similarly, vCenter Server does not support Linked Mode groups that contain both version

5.1.x and 5.0.x versions of vCenter Server. vCenter Server 5.0.x can be joined in a Linked Mode group only

with other instances of vCenter Server 5.0.x. vCenter Server 5.1.x can be joined in a Linked Mode group only

with other instances of vCenter Server 5.1.x. After all vCenter Servers in the group are upgraded to version

5.0.x or all vCenter Servers in the group are upgraded to version 5.1.x, you can rejoin them.

Procedure
1  Select Start > All Programs > VMware > vCenter Server Linked Mode Configuration.
2 Click Next.
3 Select Modify linked mode configuration and click Next.
4  Click Join this vCenter Server instance to an existing linked mode group or another instance and click
Next.
5 Enter the server name and LDAP port number of a remote vCenter Server instance that is a member of
the group and click Next.
If you enter an IP address for the remote server, the installer converts it into a fully qualified domain name.
6  If the vCenter Server installer detects a role conflict, select how to resolve the conflict.
Option Action
Yes, let VMware vCenter Server Click Next.
resolve the conflicts for me The role on the joining system is renamed to vcenter_namerole_name, where
vcenter_name is the name of the vCenter Server system that is joining the
Linked Mode group, and role_name is the name of the original role.
No, I'll resolve the conflicts myself To resolve the conflicts manually:
a  Using the vSphere Client, log in to one of the vCenter Server systems
using an account with Administrator privileges.
b  Rename the conflicting role.
¢ Close the vSphere Client session and return to the vCenter Server
installer.
d Click Back and click Next.
The installation continues without conflicts.
A conflict results if the joining system and the Linked Mode group each contain a role with the same name
but with different privileges.
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7  Click Finish.

vCenter Server restarts. Depending on the size of your inventory, the change to Linked Mode might take
from a few seconds to a few minutes to complete.

The vCenter Server instance is now part of a Linked Mode group. After you form a Linked Mode group, you
can log in to any single instance of vCenter Server and view and manage the inventories of all the vCenter
Servers in the group. It might take several seconds for the global data (such as user roles) that are changed on
one machine to be visible on the other machines. The delay is usually 15 seconds or less. It might take a few
minutes for a new vCenter Server instance to be recognized and published by the existing instances, because
group members do not read the global data very often.

Reconciling Roles When Connecting vCenter Server to a Linked Mode
Group

When you join a vCenter Server system to a linked mode group, the roles defined on each vCenter Server
system in the group are replicated to the other systems in the group.

If the roles defined on each vCenter Server system are different, the roles lists of the systems are combined into
a single common list. For example, if vCenter Server 1 has a role named Role A and vCenter Server 2 has a role
named Role B, then both servers will have both Role A and Role B after they are joined in a linked mode group.

If two vCenter Server systems have roles with the same name, the roles are combined into a single role if they
contain the same privileges on each vCenter Server system. If two vCenter Server systems have roles with the
same name that contain different privileges, this conflict must be resolved by renaming at least one of the roles.
You can choose to resolve the conflicting roles either automatically or manually.

If you choose to reconcile the roles automatically, the role on the joining system is renamed to
vcenter_namerole_name where vcenter_name is the name of the vCenter Server system that is joining the Linked
Mode group and role_name is the name of the original role.

If you choose to reconcile the roles manually, connect to one of the vCenter Server systems with the vSphere
Client and rename one instance of the role before proceeding to join the vCenter Server system to the Linked
Mode group.

If you remove a vCenter Server system from a linked mode group, the vCenter Server system retains all the
roles it had as part of the group.

Isolate a vCenter Server Instance from a Linked Mode Group

You can isolate a vCenter Server instance from a Linked Mode group.

Procedure
1  Select Start > All Programs > VMware > vCenter Server Linked Mode Configuration.
Click Modify linked mode configuration and click Next.

Click Isolate this vCenter Server instance from linked mode group and click Next.
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Click Continue and click Finish.

vCenter Server restarts. Depending on the size of your inventory, the change to Linked Mode configuration
might take from a few seconds to a few minutes to complete.

The vCenter Server instance is no longer part of the Linked Mode group.
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Change the Domain of a vCenter Server System in a Linked Mode Group

To change the domain of a vCenter Server system in a Linked Mode group, isolate the vCenter Server system
from the Linked Mode group first.

vCenter Server systems in a Linked Mode group can be in different domains if the domains have a trust
relationship.

Procedure
1  Isolate the vCenter Server system from the Linked Mode group.
2 Change the domain of the vCenter Server system.

Refer to the documentation for the operating system on which vCenter Server is installed for more
information on changing the domain.

3 Rejoin the vCenter Server system to the Linked Mode group.

Configure the URLs on a Linked Mode vCenter Server System

If you connect a vCenter Server system to a Linked Mode group and the vCenter Server system has a machine
name that does not match the domain name, several connectivity problems arise. Correct this situation by
changing the URLs.

If you do not update the URLSs, remote instances of vCenter Server cannot reach the vCenter Server system,
because the default vCenter Server URL entries are no longer accurate. The vCenter Server installer configures
default URL entries as follows:

B For the Virtualcenter.VimApiUrl key, the default value is http(s)://Fully qualified domain name
(FQDN) of vCenter Server machine/sdkvCenter Server.

B For the Virtualcenter.VimWebServicesUrl key, the default value is https://FQDN of vCenter Server
machine: installed-webservices-port/vwsvCenter Server.

Procedure
1  Isolate the vCenter Server system from the Linked Mode group.

See “Isolate a vCenter Server Instance from a Linked Mode Group,” on page 80
2 Change the domain name or the machine name to make them match.

3 From the vSphere Client, connect directly to the vCenter Server instance on which you have changed the
domain or machine name.

4  Select Administration > vCenter Server Settings and click Advanced Settings.

5  For the Virtualcenter.VimApiUrl key, change the value to point to the location where the vSphere Client
and SDK clients can access the vCenter Server system.

For example: http(s)://machine-name/IP address: vc-port/sdk.

6  For the Virtualcenter.VimWebServicesUrl key, change the value to point to the location where vCenter
Server Webservices is installed.

For example: https://machine-name/ip: webservices—port/vws.

7 For the Virtualcenter.Instancename key, change the value so that the modified name appears in the
vCenter Server inventory view.

8  Rejoin the vCenter Server system to the Linked Mode group.

See “Join a Linked Mode Group After Installation,” on page 79.

VMware, Inc. 81



vCenter Server and Host Management

The URLs are now correctly configured.

Monitor vCenter Server Services

82

When you are logged in to a vCenter Server system that is part of a connected group, you can monitor the
health of services running on each server in the group.

Procedure

¢ From the vSphere Client Home page, click vCenter Service Status.

You can view the following information in the status window:

A list of vCenter Server systems and their services, and vCenter Server plug-ins.
Status of all listed items.
Date and time when the last change in status occurred.

Messages associated with the change in status.
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Plan how you will set up your virtual infrastructure. A large vSphere implementation might contain several
virtual datacenters with a complex arrangement of hosts, clusters, resource pools, and networks. It might
involve multiple vSphere Servers operating in Linked Mode. Smaller implementations might require a single
virtual datacenter with a much less complex topology. Regardless of the scale of your virtual infrastructure,
consider how the virtual machines it will support are going to be used and administered.

Here are questions you should answer as you create and organize an inventory of virtual objects:
B Will some virtual machines require dedicated resources?

B Will some virtual machines experience periodic spikes in workload?

®  Will some virtual machines need to be administered as a group?

® Do you want to use multiple Distributed Switches?

® Do you want to use vMotion and Distributed Resource Management with certain virtual machines but
not others?

B Will some virtual objects require one set of system permissions, while other objects will require a different
set of permissions?

The left pane of the vSphere Client displays your vSphere inventory. You can add and arrange objects in any
way with the following restrictions:

B The name of an inventory object must be unique with its parent.

B vApp names must be unique within the Virtual Machines and Templates view.
B System permissions are inherited and cascade.

Populating and organizing your inventory involves the following activities:
This chapter includes the following topics:

B “Create Datacenters,” on page 84

B “Add Hosts,” on page 84

B “Add a Host in the vSphere Web Client,” on page 85

B “Add a Host to a DRS Cluster in the vSphere Web Client,” on page 86
B “Create Clusters,” on page 87

B “Create Resource Pools,” on page 88

B “Create a Resource Pool in the vSphere Web Client,” on page 89

B “Create a Folder in the vSphere Web Client,” on page 89
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B “Create Datastores,” on page 90
B “Create Host-Wide Networks,” on page 91

B “Create Datacenter-Wide Networks,” on page 91

Create Datacenters

A virtual datacenter is a container for all the inventory objects required to complete a fully functional
environment for operating virtual machines. You can create multiple datacenters to organize sets of
environments. For example, you might create a datacenter for each organizational unit in your enterprise or
create some datacenters for high performance environments and others for less demanding virtual machines.

Prerequisites
B Open a vSphere Client session to a vCenter Server.

B Verify that you have sufficient permissions to create a datacenter object.

Note Inventory objects can interact within a datacenter, but interaction across datacenters is limited. For
example, you can hot migrate virtual machines from one host to another host in the same datacenter, but not
from a host in one datacenter to a host in a different datacenter.

Procedure

1  Go to Home > Inventory > Hosts and Clusters.
2 Select File > New > Datacenter.

3 Rename the datacenter.

What to do next

Add hosts, clusters, resource pools, vApps, networking, datastores, and virtual machines to the datacenter.

Add Hosts

84

You can add hosts under a datacenter object, folder object, or cluster object. If a host contains virtual machines,
those virtual machines are added to the inventory together with the host. Information about configuring hosts
is located in the vSphere Networking, vSphere Storage, vSphere Security, and vSphere Host Profiles documentation.

Prerequisites

B Open a vSphere Client session to a vCenter Server.

B Verify that you have sufficient permissions to create a host object.

B Verify that a Datacenter, folder, or cluster exists in the inventory.

B Obtain the user name and password for an account with administrative privileges on the host.

B Verify that hosts behind a firewall are able to communicate with the vCenter Server system and all other
hosts through port 902 or other custom-configured port.

B Verify that all NFS mounts on the host are active.
Procedure
1  Select Home > Inventory > Hosts and Clusters.

Select a datacenter, cluster, or folder within a datacenter.

Select File > New > Add Host.
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Enter host name or IP address and administrator credentials and click Next.
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5 (Optional) Select Enable Lockdown Mode to disable remote access for the administrator account after
vCenter Server takes control of this host.

Selecting this check box ensures that the host is managed only through vCenter Server. You can perform
certain management tasks while in lockdown mode by logging into the local console on the host.

6  Review host information and click Next.
7  (Optional) Assign a license key to the host if needed and click Next.

8 Do one of the following:

Option Description

If you are adding the host to a cluster  Select a resource pool option and click Next.

If you are not adding the host to a Select a location where you want to place virtual machines that already exist
cluster on the host and click Next.

9 Review the summary information and click Finish.

The host and its virtual machines are added to the inventory.

Add a Host in the vSphere Web Client

You can add hosts under a datacenter object, folder object, or cluster object. If a host contains virtual machines,
those virtual machines are added to the inventory together with the host.

Prerequisites
B Verify that a datacenter, folder, or cluster exists in the inventory.
B Obtain the user name and password of the root user account for the host.

B Verify that hosts behind a firewall are able to communicate with the vCenter Server system and all other
hosts through port 902 or other custom-configured port.

B Verify that all NFS mounts on the host are active.
Required privileges:

B Host.Inventory.Add host to cluster

B Resource.Assign virtual machine to resource pool

B System.View on the virtual machines folder where you want to place the virtual machines of the host.

Procedure

1  In the vSphere Web Client, navigate to a datacenter, cluster, or folder within a datacenter.
Right-click the datacenter, cluster, or folder and select Add Host.

Type the IP address or the name of the host and click Next.

Type administrator credentials and click Next.

Review the host summary and click Next.
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Assign a license key to the host.

B Assign an existing license key
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Choose from the license keys that are available in the inventory of the vCenter Server system where
you add the host. If the host is already licensed, you can choose its currently assigned license key. If
the host resides in the inventory of another vCenter Server system, its license will be copied to the
inventory of this vCenter Server system. After you add the host to this vCenter Server system, make
sure to remove its license key from the inventory of the host's previous vCenter Server system.

B Assign a new license key
Add a new license key and assign it to the host.

7  (Optional) Select Enable Lockdown Mode to disable remote access for the administrator account after
vCenter Server takes control of this host.

Selecting this check box ensures that the host is managed only through vCenter Server. You can perform
certain management tasks while in lockdown mode by logging into the local console on the host.

8 (Optional) If you add the host to a datacenter or a folder, select a location for the virtual machines that
reside on the host and click Next.

9  Review the summary and click Finish.

A new task for adding the host appears in the Recent Tasks pane. It might take a few minutes for the task to
complete.

Add a Host to a DRS Cluster in the vSphere Web Client

You can add a host under a DRS cluster object. If a host contains virtual machines, the virtual machines are
added to the inventory together with the host. For details about DRS clusters, see vSphere Resource
Management.

Prerequisites
B Obtain the user name and password of the root account on the host.

B Verify that hosts behind a firewall are able to communicate with the vCenter Server system and all other
hosts through port 902 or other custom-configured port.

B Verify that all NFS mounts on the host are active.
Required privileges:

B Host.Inventory.Add host to cluster

B Resource.Assign virtual machine to resource pool

B System.View on the virtual machines folder where you want to place the virtual machines of the host.

Procedure

1 Inthe vSphere Web Client, navigate to the DRS cluster where you want to add the host.
Type the IP address or the name of the host and click Next.

Type administrator credentials and click Next.

Review the host summary and click Next.
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Assign a license key to the host.

B Assign an existing license key
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Choose from the license keys that are available in the inventory of the vCenter Server system where
you add the host. If the host is already licensed, you can choose its currently assigned license key. If
the host resides in the inventory of another vCenter Server system, its license will be copied to the
inventory of this vCenter Server system. After you add the host to this vCenter Server system, make
sure to remove its license key from the inventory of the host's previous vCenter Server system.

B Assign a new license key
Add a new license key and assign it to the host.

6  (Optional) Select Enable Lockdown Mode to disable remote access for the administrator account after
vCenter Server takes control of this host.

Selecting this check box ensures that the host is managed only through vCenter Server. You can perform
certain management tasks while in lockdown mode by logging into the local console on the host.

7  Select a resource pool for the virtual machines of the host.
@ Put all of this host's virtual machines in the cluster's root resource pool

vCenter Server removes all existing resource pools of the host, and attaches all the virtual machines
in the host's hierarchy to the root. Because share allocations are relative to a resource pool, you might
have to change a virtual machine's shares manually after selecting this option, which destroys the
resource pool hierarchy.

€  Create a new resource pool for this host's virtual machines and resource pools

vCenter Server creates a top-level resource pool that becomes a direct child of the cluster, and adds
all children of the host to that new resource pool.

8 Review the summary and click Finish.

A new task for adding the host appears in the Recent Tasks pane. The task might take a few minutes to complete.

Create Clusters

A cluster is a group of hosts. When a host is added to a cluster, the host's resources become part of the cluster's
resources. The cluster manages the resources of all hosts within it. Clusters enable the vSphere High
Availability (HA) and vSphere Distributed Resource Scheduler (DRS) solutions.

Prerequisites

B Open vSphere Client session to a vCenter Server.

B Verify that you have sufficient permissions to create a cluster object.

B Verify that a Datacenter, or folder within a datacenter, exists in the inventory.
Procedure

1  Right-click a datacenter or folder in the vSphere Client and select New Cluster.

2 Enter a name for the cluster.

VMware, Inc. 87



vCenter Server and Host Management

3 Choose cluster features.

Option

Description

If you chose to use DRS with this
cluster

o

Click the vSphere DRS box.
b Select an automation level and a migration level and click Next.

(e}

Select a default power management setting and a DPM threshold, and
click Next.

If you chose to use HA with this
cluster

Click vSphere HA.

Select whether to enable host monitoring and admission control.
If admission control is enabled, specify a policy.

Click Next.

Specify cluster default behavior and click Next.
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Specify virtual machine monitoring settings and click Next.

4  Select an Enhanced vMotion Compatibility (EVC) setting and click Next.

EVC ensures that all hosts in a cluster present the same CPU feature set to virtual machines, even if the

actual CPUs on the hosts differ. This prevents migrations with vMotion from failing due to incompatible

CPUs.

5  Select a swap file policy and click Next.

6  Review the options you selected for the cluster and click Finish.

The cluster is added to the inventory.

What to do next

Add hosts and resource pools to the cluster.

Create Resource Pools

88

You can use resource pools to hierarchically partition available CPU and memory resources of a standalone
host or a cluster. Use resource pools to aggregate resources and set allocation policies for multiple virtual
machines, without the need to set resources on each virtual machine.

Prerequisites

B Verify that the vSphere Client is connected to a vCenter Server system. If the client is connected directly
to a host, you cannot create a resource pool.

B Make sure you have permissions sufficient to create a resource pool object.

B Verify that a cluster, vApp, or other resource pool object is parent to the resource pool.

Procedure

1  Select Home > Inventory > Hosts and Clusters.
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Click OK.

Select File > New > Resource Pool.

Select a cluster, vApp, or resource pool.

Enter a name and specify resource settings.

The resource pool is added to the inventory.

What to do next

Add virtual machines and vApps to your resource pool.
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Create a Resource Pool in the vSphere Web Client

You can use resource pools to hierarchically partition available CPU and memory resources of a standalone
host or a cluster. You can use resource pools to aggregate resources and set allocation policies for multiple
virtual machines, without setting resources on each virtual machine.

You can create a child resource pool of a standalone host, resource pool, vApp, or DRS cluster. You cannot
create resource pools in a cluster that is not enabled for DRS.

Prerequisites

Required privilege: Resource.Create resource pool on the parent object for the resource pool.

Procedure

1  In the Hosts and Clusters view of the vSphere Web Client inventory tree, select the parent object for the
resource pool.

2 o
L
Click the All Actions icon ( ) and select Inventory > New Resource Pool.
3  Type a name to identify the resource pool.

4  Specify how to allocate CPU and memory resources.

Option Description

Shares Specify shares for this resource pool with respect to the parent’s total
resources. Sibling resource pools share resources according to their relative
share values bounded by the reservation and limit.

B Select Low, Normal, or High to specify share values respectively in a
1:2:4 ratio.

B Select Custom to give each virtual machine a specific number of shares,
which expresses a proportional weight.

Reservation Specify a guaranteed CPU or memory allocation for this resource pool and
select the units for this reservation from the drop-down menu.
A nonzero reservation is subtracted from the unreserved resources of the
parent (host or resource pool). The resources are considered reserved,
regardless of whether virtual machines are associated with the resource pool.

Reservation Type When the Expandable check box is selected (default), expandable
reservations are considered during admission control.

If you power on a virtual machine in this resource pool, and the combined
reservations of the virtual machines are larger than the reservation of the
resource pool, the resource pool can use resources from its parent or
ancestors.

Limit Specify the upper limit for this resource pool's CPU or memory allocation by
typing a value or selecting a value from the drop-down menu.

5 Click OK.

Create a Folder in the vSphere Web Client

You can use folders to group objects of the same type for easier management. For example, permissions can
be applied to folders, allowing you to use folders to group objects that should have a common set of
permissions.

A folder can contain other folders, or a group of objects of the same type. For example, a single folder can
contain virtual machines and another folder containing virtual machines, but it cannot contain hosts and a
folder containing virtual machines.
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You can create these types of folders: Host and Cluster folders, Network folders, Storage folders, and VM and
Template folders.

Procedure
1  In the navigator, select either a datacenter or another folder as a parent object for the folder.

2 Right-click the parent object and select the menu option to create the folder.

Option Description

The parent object is a datacenter. If the parent object is a datacenter, you can select the type of folder to create:
B Select All vCenter Actions > New Host and Cluster Folder.
B Select All vCenter Actions > New Network Folder.
B Select All vCenter Actions > New Storage Folder.
B Select All vCenter Actions > New VM and Template Folder.

The parent object is a folder. If the parent object is a folder, the new folder is of the same type as the parent
folder.

Select All vCenter Actions > New Folder.

3 Type the name for the folder and click OK.

What to do next

Move objects into the folder by right-clicking the object and selecting Move To. Select the folder as the
destination.

Create Datastores

A datastore is a logical container that holds virtual machine files and other files necessary for virtual machine
operations. Datastores can exist on different types of physical storage, including local storage, iSCSI, Fibre
Channel SAN, or NFS. A datastore can be VMFS-based or NFS-based.

Prerequisites

B Open a vSphere Client session to a vCenter Server.

B Verify that you have sufficient permissions to create a datastore object.

B Verify that at least one host in the inventory has access to physical storage.
Procedure

1  Select Home > Inventory > Datastores.

2 Right-click on a datacenter and select Add Datastore.
3 Select a host and click Next.
4  Select a type of storage and click Next.
Option Description
Disk or LUN a  Select a disk or LUN and click Next.
b Review the disk layout information and click Next.
¢ Enter a name for the datastore and click Next.
d Specify maximum file and block sizes.
e Specify disk or LUN capacity and click Next.
Network File System a Enter server and folder information.
b  Select whether clients should mount the NFS as read-only.

¢ Enter a name and click Next.

90 VMware, Inc.



Chapter 6 Organizing Your Inventory

5 Review summary information and click Finish.

A datastore is added to the inventory.

Create Host-Wide Networks

In vSphere, you can create standard networks and distributed networks. Standard networks provide a method
of communication among the virtual machines on a standalone host and consist of standard switches and port
groups. Distributed networks aggregate the networking capabilities of multiple hosts and enable virtual
machines to keep consistent network configuration as they migrate across hosts. Distributed networks consist
of vSphere Distributed Switches, uplink port groups, and port groups.

Prerequisites
B Open a vSphere Client connection to a vCenter Server.
B Verify that you have sufficient permissions to create a standard switch.

B Verify that a host exists in the inventory.

Procedure

—_

Select a host from the inventory.

Click the Configuration tab.

Click Networking.

Click Virtual Switch.

Click Add Networking.

Select a connection type.

Select an existing virtual switch or create one.

Enter a display label for the port group on the switch.
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Select a VLAN ID.

—_
)

Review your settings and click Finish.

If you chose to use an existing standard switch, a new port group is added to it. If you chose to create a standard
switch, it is added with a port group.

Create Datacenter-Wide Networks

In vSphere, you can create standard networks and distributed networks. Standard networks provide a method
of communication among the virtual machines on a standalone host and consist of standard switches and port
groups. Distributed networks aggregate the networking capabilities of multiple hosts and enable virtual
machines to keep consistent network configuration as they migrate across hosts. Distributed networks consist
of vSphere Distributed Switches, uplink port groups, and port groups.

Prerequisites

B Open a vSphere Client connection to a vCenter Server.

B Verify that you have sufficient permissions to create a standard switch.
B Verify that a host exists in the inventory.

Procedure

1  Select Home > Inventory > Networking view, and select a datacenter.
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Click New vNetwork Distributed Switch in the toolbar.

Select a version and click Next.

Enter a display name for the switch.

Specify the maximum number of physical adapters per host (uplink ports) and click Next.

Add hosts and their physical network adapters to the switch and click Next.
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Choose whether you want vSphere to automatically create a port group and click Finish.

A vSphere Distributed Switch, with its associated uplink ports and port groups, is added to the inventory.
What to do next

B Add hosts to the switch.

B  Add port groups to the switch.

®  Edit switch properties.

Edit General vSphere Distributed Switch Settings

You can edit the general settings for a vSphere distributed switch, such as the distributed switch name and the
number of uplink ports on the distributed switch.

Procedure
1  Log in to the vSphere Client and select the Networking inventory view.
2 Right-click the vSphere distributed switch in the inventory pane, and select Edit Settings.

3 Select General to edit the vSphere distributed switch settings.

Option Description

Name Type the name for the distributed switch.

Number of Uplink Ports Select the number of uplink ports for the distributed switch.
Notes Type any notes for the distributed switch.

4  (Optional) Edit uplink port names.
a  Click Edit uplink names.
b Type new names for one or more uplink ports.
¢ Click OK.

5 Click OK.

Edit Advanced vSphere Distributed Switch Settings

You can change advanced vSphere distributed switch settings such as Cisco Discovery Protocol and the
maximum MTU for the vSphere distributed switch.

Procedure
1  Log in to the vSphere Client and select the Networking inventory view.

2 Right-click the vSphere distributed switch in the inventory pane, and select Edit Settings.
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Select Advanced to edit the following vSphere distributed switch settings.

Option Description
Maximum MTU Maximum MTU size for the vSphere distributed switch.
Discovery Protocol Status Choose the status for discovery protocol on the vSphere distributed switch.

B Enabled. Enabled discovery protocol for the vSphere distributed switch.

1 Select Cisco Discovery Protocol or Link Layer Discovery Protocol
from the Type drop-down menu.

2 Set Operation to Listen, Advertise, or Both.
B Disabled.

Admin Contact Info Enter the Name and Other Details for the vSphere distributed switch
administrator.

ClickOK.

Add Hosts to a vSphere Distributed Switch

You can add hosts and physical adapters to a vSphere distributed switch at the distributed switch level after
it is created.

Procedure

1
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Log in to the vSphere Client and select the Networking inventory view.

Right-click the vSphere distributed switch in the inventory pane, and select Add Host.
Select the hosts to add.

Under the selected hosts, select the physical adapters to add and click Next.

You can select physical adapters that are not being used and physical adapters that are being used.

Note Moving a physical adapter to a distributed switch without moving any associated virtual adapters
can cause those virtual adapters to lose network connectivity.

For each virtual adapter, select Destination port group and select a port group from the drop-down menu
to migrate the virtual adapter to the distributed switch or select Do not migrate.

(Optional) Set the maximum number of ports on a host.

a  Click View Details for the host.

b Select the maximum number of ports for the host from the drop-down menu.
¢ Click OK.

Click Next.

(Optional) Migrate virtual machine networking to the distributed switch.

a  Select Migrate virtual machine networking.

b For each virtual machine, select Destination port group and select a port group from the drop-down
menu or select Do not migrate.

Click Next.
(Optional) If you need to make any changes, click Back to the appropriate screen.

Review the settings for the distributed switch and click Finish.
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Add a Distributed Port Group

Add a distributed port group to a vSphere distributed switch to create a distributed switch network for your
virtual machines.

Procedure

1 Login to the vSphere Client and select the Networking inventory view.

2 Select Inventory > vSphere Distributed Switch > New Port Group.
3 Enter a Name and the Number of Ports for your new distributed port group.
4  Selecta VLAN Type.
Option Description
None Do not use VLAN.
VLAN In the VLAN ID field, enter a number between 1 and 4094.
VLAN Trunking Enter a VLAN trunk range.
Private VLAN Select a private VLAN entry. If you did not create any private VLANS, this

menu is empty.

5  Click Next.
6  Click Finish.

Edit General Distributed Port Group Settings

You can edit general distributed port group settings such as the distributed port group name and port group
type.

Procedure
1 Login to the vSphere Client and select the Networking inventory view.
2 Right-click the distributed port group in the inventory pane, and select Edit Settings.

3  Select General to edit the following distributed port group settings.

Option Action

Name Type the name for the distributed port group.

Description Type a brief description of the distributed port group.

Number of Ports Type the number of ports on the distributed port group.

Port binding Choose when ports are assigned to virtual machines connected to this
distributed port group.

B Select Static binding to assign a port to a virtual machine when the
virtual machine connects to the distributed port group. This option is not
available when the vSphere Client is connected directly to ESXi.

B Select Dynamic binding to assign a port to a virtual machine the first
time the virtual machine powers on after it is connected to the distributed
port group. Dynamic binding is deprecated in ESXi 5.x.

B Select Ephemeral for no port binding. This option is not available when
the vSphere Client is connected directly to ESXi.

4  Click OK.

94 VMware, Inc.



Chapter 6 Organizing Your Inventory

Edit Advanced Distributed Port Group Settings

You can edit advanced distributed port group settings, such as override settings and reset at disconnect.

Log in to the vSphere Client and select the Networking inventory view.

Right-click the distributed port group in the inventory pane, and select Edit Settings.

Select Advanced to edit the distributed port group properties.

Description

Select this option to allow distributed port group policies to be overridden
on a per-port level. Click Edit Override Settingsto select which policies can
be overridden at the port level.

Select which policies can be overridden at the port level.

When a distributed port is disconnected from a virtual machine, the
configuration of the distributed port is reset to the distributed port group
setting. Any per-port overrides are discarded.

Procedure

1

2

3
Option
Allow override of port policies
Edit Override Settings
Configure reset at disconnect

4 Click OK.

VMware, Inc.
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Tagging Objects in the
vSphere Web Client

Tags allow you to attach metadata to objects in the vSphere inventory to make these objects more sortable and
searchable.

A tag is a label that you can apply to objects in the vSphere inventory. When you create a tag, you assign that
tag to a category. Categories allow you to group related tags together. When you define a category, you can
also specify which object types its tags can be applied to and whether more than one tag in the category can
be applied to an object. For example, if you wanted to tag your virtual machines by guest operating system
type, you could create a category called 'operating system', and specify that it applies to virtual machines only
and that only a single tag can be applied to a virtual machine at any time. The tags in this category could be
"Windows", "Linux", and "Mac OS".

Tagging replaces the custom attributes functionality found in previous versions of vCenter Server. If you have
existing custom attributes, you can convert them into tags.

This chapter includes the following topics:

B “Migrate Custom Attributes to Tags,” on page 97
B “Create a Tag Category,” on page 98

B “Delete a Tag Category,” on page 99

®  “Edit a Tag Category,” on page 100

B “Create a Tag,” on page 100

B “Apply a Tag to an Object,” on page 101

B “Remove a Tag from an Object,” on page 101

B “Delete a Tag,” on page 102

®  “Edita Tag,” on page 102

Migrate Custom Attributes to Tags

Tags replace the custom attributes functionality found in previous versions of vSphere. If you have existing
custom attributes, you can migrate them to tags.

During the migration, the custom attribute names are converted to categories. Custom attribute values are
converted to tag names.

Procedure
1  Inthe vSphere Web Client object navigator, browse to any object that has custom attributes.
2 Click the object's Summarytab.

3 Inthe Custom Attributes panel, click Edit.
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Click Migrate.

The Migrate Custom Attributes to Tags wizard appears.

Read the instructions and click Next.

Select the custom attributes to migrate and click Next.

The Create Tag Categories page displays the name of each custom attribute as a new tag category.

(Optional) Select a category to edit its options.

Option

Description

Category Name

The category name must be unique to the currently-selected vCenter Server
system.

Description You can provide text in the description to describe the purpose or usage of
the category.
Cardinality B Select 1 tag per object to allow only one tag from this category to be

applied to an object at any one time.

Use this option for categories whose tags are mutually exclusive. For
example, a category called Priority with tags High, Medium, and Low
should allow one tag per object, because an object should have only one
priority.

B Select Many tags per object to allow multiple tags from the category to
be applied to an object at any one time.

Use this option for categories whose tags are not mutually exclusive.
After you have set the cardinality of a category, you can change the
cardinality from 1 tag per object to Many tags per object, but not from Many
tags per object to 1 tag per object.

Associable Object Types

Select whether tags in this category can be assigned to all objects or only to
a specific type of managed object, such as virtual machines or datastores.

After you have set the associable object types for a category, you can change
a category that is associable with a single object type to be associable with all
object types, but you cannot restrict a category that is associable to all object
types to being associable to a single object type.

(Optional) Select a tag to edit its attributes.

Option Description

Name The tag name must be unique across all linked vCenter Server systems.

Description You can provide text in the description to describe the purpose or usage of
the tag.

Click Finish.

Create a Tag Category
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Prerequisites

The selected custom attributes are converted to categories and tags.

You use categories to group tags together and define how tags can be applied to objects.

Every tag must belong to one and only one category. You must create at least one category before creating any
tags.

Required privilege: vCenter Inventory Service.vCenter Inventory Service Tagging.Create Inventory Service
Tag Category on the root vCenter Server.
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Procedure
1 From the vSphere Web Client Home, click Tags.
2 Click the Items tab and click Categories.
3 Click the New Category icon.
4  Edit the category options.
Option Description
Category Name The category name must be unique to the currently-selected vCenter Server
system.
Description You can provide text in the description to describe the purpose or usage of
the category.
Cardinality B Select 1 tag per object to allow only one tag from this category to be
applied to an object at any one time.
Use this option for categories whose tags are mutually exclusive. For
example, a category called Priority with tags High, Medium, and Low
should allow one tag per object, because an object should have only one
priority.
B Select Many tags per object to allow multiple tags from the category to
be applied to an object at any one time.
Use this option for categories whose tags are not mutually exclusive.
After you have set the cardinality of a category, you can change the
cardinality from 1 tag per object to Many tags per object, but not from Many
tags per object to 1 tag per object.
Associable Object Types Select whether tags in this category can be assigned to all objects or only to
a specific type of managed object, such as virtual machines or datastores.
After you have set the associable object types for a category, you can change
a category that is associable with a single object type to be associable with all
object types, but you cannot restrict a category that is associable to all object
types to being associable to a single object type.
5 Click OK.

Delete a Tag Category

You delete a category to remove it from your vSphere environment.

Deleting a category also deletes all tags associated with that category.

Prerequisites

Required privilege: vCenter Inventory Service.vCenter Inventory Service Tagging.Delete Inventory Service

Tag Category on the root vCenter Server.

Procedure

1
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From the vSphere Web Client Home, click Tags.

Click the Items tab and click Categories.

Select a category from the list and click the Delete Category icon ().

Click Yes to confirm deletion of the category.

The category and all its associated tags are deleted.
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Edit a Tag Category

You can edit a category to change its name, cardinality, or associable objects.

Prerequisites

Required privilege: vCenter Inventory Service.vCenter Inventory Service Tagging.Edit Inventory Service
Tag Category

on the root vCenter Server.

Procedure

1 From the vSphere Web Client Home, click Tags.
Click the Items tab and click Categories.

Select a category and click the Edit Category icon (#).
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Edit the category parameters.

Option Description

Category Name The category name must be unique to the currently-selected vCenter Server
system.

Description You can provide text in the description to describe the purpose or usage of
the category.

Cardinality B Select 1 tag per object to allow only one tag from this category to be
applied to an object at any one time.

Use this option for categories whose tags are mutually exclusive. For
example, a category called Priority with tags High, Medium, and Low
should allow one tag per object, because an object should have only one
priority.

B Select Many tags per object to allow multiple tags from the category to
be applied to an object at any one time.

Use this option for categories whose tags are not mutually exclusive.
After you have set the cardinality of a category, you can change the
cardinality from 1 tag per object to Many tags per object, but not from Many
tags per object to 1 tag per object.

Associable Object Types Select whether tags in this category can be assigned to all objects or only to
a specific type of managed object, such as virtual machines or datastores.
After you have set the associable object types for a category, you can change
a category that is associable with a single object type to be associable with all
object types, but you cannot restrict a category that is associable to all object
types to being associable to a single object type.

5 Click OK.

Create a Tag
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You use tags to add metadata to inventory objects. You can record information about your inventory objects
in tags and use the tags in searches.

Prerequisites

Required privilege: vCenter Inventory Service.vCenter Inventory Service Tagging.Create Inventory Service
Tag on root vCenter Server.

Procedure

1 From the vSphere Web Client Home, click Tags.

VMware, Inc.



Chapter 7 Tagging Objects in the vSphere Web Client

Click the Items tab and click Tags.
Click the New Tag icon.

In the vCenter Server drop-down menu, select the vCenter Server instance on which to create this tag.
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In the Name text box, enter a name for the tag.

Tag names must be unique within the category in which they are created.

6  (Optional) In the Description text box, enter a description for the tag.

7 Inthe Category drop-down menu, select an existing category or create a new category.

If you select [New Category], the dialogue box expands to show the options for creating a category. See
“Create a Tag Category,” on page 98.

8 Click OK.

Apply a Tag to an Object

After you have created tags, you can apply them as metadata to objects in the vSphere Web Client inventory.

Prerequisites

Required privilege: vCenter Inventory Service.vCenter Inventory Service Tagging.Create Inventory Service
Tag on the root vCenter Server instance.

Procedure

1 Browse to the object in the vSphere Web Client inventory.
Click the Manage tab and click Tags.

Click the Assign Tag icon (<).
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(Optional) From the Categories drop-down menu, select a category to limit the tags displayed to ones
from that category.

5  Select a tag from the list and click OK.

That tag is assigned to the object. The assigned tags for each object appear in the list on the Tags tab.

Remove a Tag from an Object

You can remove a tag that has been applied to an object.

Prerequisites

Required privilege: vCenter Inventory Service.vCenter Inventory Service Tagging.Create Inventory Service
Tag on the root vCenter Server instance.

Procedure
1  Browse to the object in the vSphere Web Client inventory.
Click the Manage tab and click Tags.

Select a tag to remove and click the Detach Tag icon (<).
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Click Yes to confirm the removal of the tag.
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Delete a Tag

You can delete a tag when it is no longer needed. Deleting a tag removes it from all the objects to which it is
applied.

Prerequisites

Required privilege: vCenter Inventory Service.vCenter Inventory Service Tagging.Delete Inventory Service
Tag on the root vCenter Server instance.

Procedure

1 From the vSphere Web Client Home, click Tags.
Click the Items tab and click Tags.

Select the tag to delete.

Click the Delete Tag icon (%).
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Click OK to confirm tag deletion.

Edit a Tag
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You can edit a tag to change its name or description.

After a tag has been created, you cannot change the tag's category.

Prerequisites

Required privilege: vCenter Inventory Service.vCenter Inventory Service Tagging.Edit Inventory Service
Tag on the root vCenter Server instance.

Procedure

1 From the vSphere Web Client Home, click Tags.
Click the Items tab and click Tags.

Select the tag to edit.

Click the Edit Tag icon (+).
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(Optional) In the Name text box, enter a new name for the tag.

Tag names must be unique within their category.

6  (Optional) In the Description text box, edit the description for the tag.
7 Click OK.
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License Management and Reporting

vCenter Server provides licensing infrastructure that you can use for management and reporting of licenses

that apply to ESXi hosts, vCenter Server, and certain solutions such as vCenter Site Recovery Manager, vCenter
CapacitylQ, vCenter Operations Manager, and so on.

Licensing in vCenter Server is implemented using license keys. You can assign one license key to multiple

licensable objects of the same type if the key has enough capacity. However, you cannot assign multiple license

keys to a single licensable object. For example, you can assign one license key to multiple vCenter Server

systems in a Linked Mode group, but you cannot assign multiple license keys to a single vCenter Server system.

ESXi hosts, vCenter Server, and solutions have different licensing models.

ESXi 5.x hosts are licensed with vSphere license keys that have per-processor capacity. You can assign a
vSphere license key to multiple ESXi hosts if the key has large enough processor capacity to cover all
physical processors in the hosts. When you assign a vSphere 5.x license key to an ESXi host, the amount
of processor capacity of the key that is consumed is equal to the number of physical processors in the host.
For details about how to apply the licensing model for ESXi hosts, see “Licensing for ESXi Hosts,” on
page 105.

vCenter Server systems are licensed with vCenter Server license keys that have per-instance capacity type.
A license key for vCenter Server determines the number of vCenter Server instances that you can license
with the key.

Solutions are licensed depending on the specific usage and licensing needs of each solution. For example,
vCenter Site Recovery Manager, vCenter Capacity IQ, and vCenter Operations Manager are licensed on
a per-virtual-machine basis.

The licensing infrastructure in vCenter Server provides functions that you can use to implement and monitor
the licensing models of ESXi hosts, vCenter Server, and solutions.

VMware, Inc.

Licensing Terminology and Definitions on page 105

The licensing infrastructure in vCenter Server uses specific terminology and definitions to refer to
different licensing-related objects.

Licensing for ESXi Hosts on page 105

ESXi hosts are licensed with vSphere licenses. Each vSphere license key has a certain processor capacity
that you can use to license multiple physical processors on ESXi hosts. When you assign a vSphere license
key to a host, the amount of processor capacity that is consumed is equal to the number of physical
processors in the host

Licensing for vCenter Server on page 106

vCenter Server systems are licensed with vCenter Server license keys that have per-instance capacity.

Solution Licensing on page 106

Solutions can have different licensing models depending on the specifics of every solution.
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Evaluation Mode Licenses on page 106

Evaluation mode licenses are available by default for every asset. While in evaluation mode, you can
explore all the features of the product that is associated with the asset.

Licensing for vCloud Suite on page 107

VMware vCloud Suite 5.1 combines multiple components into a single product to cover the complete set
of cloud infrastructure capabilities. When used together, the vCloud Suite components provide
virtualization, software-defined datacenter services, policy-based provisioning, disaster recovery,
application management, and operations management.

License and Evaluation Period Expiry on page 107

License and evaluation period expiry lead to consequences that prevent you from performing certain
operations in the vSphere environment.

Licensing ESXi Hosts and vCenter Server After Upgrade on page 107

Upgrading the ESXi or vCenter Server software may require changes in the licensing configuration of
ESXi hosts or vCenter Server.

vCenter Server License Inventory on page 108

All license keys of ESXi hosts, vCenter Server and solutions are kept in the vCenter Server license
inventory. vCenter Server systems in Linked Mode share a common license inventory.

License Management Permissions on page 109

You can control which users can view and manage license resources.

Managing Licenses on page 109

License management is centralized. You can use the vSphere Client to manage all licenses that are
available in the license inventory of a vCenter Server system or a Linked Mode group.

Managing Licenses in the vSphere Web Client on page 114

You can use the license management function in the vSphere Web Client to manage the licensing of the
assets in your vSphere environment from a central place. You can add license keys in the vCenter Server
inventory, assign license keys to multiple assets at a time, view information about the available products
and licenses, and export licensing information in a CSV file.

Viewing License Use on page 121

You can view the use and capacity of the license keys that are assigned to assets for a period that you
select.

Viewing License Use in the vSphere Web Client on page 125

You can view the use and capacity of the license keys that are assigned to assets for a period that you
select by using the vSphere Web Client.

Interpreting License Use Data on page 128

The license use data in an exported report and the data that you view in the license reporting function
areinterpreted differently. The license use data in an exported report contains the license usage snapshots
that vCenter Server has collected over a certain time period. The license use data that you view in the
license reporting function is aggregated from the license usage snapshots.
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Licensing Terminology and Definitions

The licensing infrastructure in vCenter Server uses specific terminology and definitions to refer to different

licensing-related objects.

License Key

Product

Product Edition

Feature

Solution

Asset

License Key Capacity

License Use

An alphanumeric sequence of 25 characters in groups of five that are separated
by dashes. The license key encodes details for the product it is associated with,
the license expiration date, the license capacity, and other information. The

license key is entered in the system to activate the product it is associated with.

A set of functionality that you can purchase together as a group. Examples of
products are vCenter Server, vSphere, and solutions.

A set of specific features that are associated with a unique license key. When
assigned, the license key unlocks the features in the product edition. Examples
of product editions are vSphere Enterprise, vSphere Standard, vCenter Server
Essentials, and so on.

Functionality that is enabled or disabled by a license that is associated with a
specific product edition. Examples of features are vSphere DRS, vSphere
vMotion, vSphere High Availability, and so on.

A product that is packed and distributed independently from vSphere. You
install a solution in vSphere to take advantage of certain functionality. Every
solution has a licensing model specific for the solution, but can use the licensing
infrastructure of vCenter Server for license management and reporting.
Examples of solutions are vCenter CapacitylQ, vCenter Site Recovery
Manager, vCenter Chargeback, and so on.

Any licensable object in vSphere. The license administrator in vSphere can
assign one license key to one or multiple assets of the same type if the key has
sufficient capacity. Assets are vCenter Server systems, ESXi hosts, and solution
instances.

Amount of units that you can assign to assets. The units of a license key capacity
can be of different types depending on the product that the license key is
associated with. For example, a license key for vCenter Server determines the
number of vCenter Server instances that you can license with the key.

The number of units that an asset uses from the capacity of a license key. For
example, if you assign a per-virtual-machine license key to vCenter Site
Recovery Manager, the license use for Site Recovery Manager is the number of
protected virtual machines.

Licensing for ESXi Hosts

ESXi hosts are licensed with vSphere licenses. Each vSphere license key has a certain processor capacity that
you can use to license multiple physical processors on ESXi hosts. When you assign a vSphere license key to
a host, the amount of processor capacity that is consumed is equal to the number of physical processors in the

host

To license an ESXi host, you need to assign it a vSphere license key with processor capacity that is sufficient
to license all physical processors on the host. For example, to license two ESXi hosts that have four processors
each, you need to assign a vSphere license key with a minimum capacity of 8 processors to the hosts.

VMware, Inc.
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If you try to assign a license key that has insufficient capacity to license all physical processors on the host, the
license assignment is unsuccessful. In such case, you need to assign a different license key with a larger
processor capacity. You need to use a different license key in your inventory or combine your license key with
another license key to create a new license key with a larger processor capacity.

You can assign and reassign the processor capacity of a vSphere license key to any combination of ESXi hosts.
For example, suppose that you purchase a vSphere license key for 10 processors. You can assign the license
key to any of the following combinations of hosts:

B Five 2-processor hosts.

B Three 2-processor hosts and one 4-processor host.
B Two 4-processor hosts and one 2-processor host.
B One 8-processor host and one 2-processor host.

Dual-core and quad-core processors, such as Intel processors that combine two or four independent processors
on a single chip, count as one processor.

Licensing for vCenter Server

vCenter Server systems are licensed with vCenter Server license keys that have per-instance capacity.

To license a single vCenter Server, you need a vCenter Server license key with a capacity for one instance. If
you have vCenter Server systems in a Linked Mode group, you can purchase a vCenter Server license key with
a larger capacity and assign the key to all vCenter Server systems in the group.

Norte If you license vCenter Server 5.x with vCenter Server Standard or Foundation licenses, vCenter Server
restricts managing hosts that are licensed with vSphere Essentials or Essentials Plus license keys.

Solution Licensing

Solutions can have different licensing models depending on the specifics of every solution.

Every solution that integrates its license management in vCenter Server is licensed on a different basis. Some
solutions can be licensed on per-instance basis, others can be licensed on per-virtual machine basis. For
example, vCenter Site Recovery Manager 5.0 is licensed on per-virtual machine basis. A license key for Site
Recovery Manager 5.0 defines the number of virtual machines that you can protect.

For information about the licensing model of a certain solution, see the documentation for that solution.

Evaluation Mode Licenses

106

Evaluation mode licenses are available by default for every asset. While in evaluation mode, you can explore
all the features of the product that is associated with the asset.

When you install an asset, its default license is evaluation mode. Evaluation mode licenses expire after 60 days.
If you assign a license key to the asset before its evaluation period expires, the time available in the evaluation
period is decreased by the time already used. To explore the entire set of features that are available for an asset,
you can set it back to evaluation mode, and use it for the remaining evaluation period.

For example, suppose that you use an ESXi host in evaluation mode for 20 days and then assign a vSphere
Standard license key to the host. If you set the host back in evaluation mode, you can explore the entire set of
features that are available for the host for the remaining evaluation period of 40 days.

You can track the number of remaining days available for the evaluation period of an asset from the vSphere
Client or the vSphere Web Client.
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Licensing for vCloud Suite

VMware vCloud Suite 5.1 combines multiple components into a single product to cover the complete set of
cloud infrastructure capabilities. When used together, the vCloud Suite components provide virtualization,
software-defined datacenter services, policy-based provisioning, disaster recovery, application management,
and operations management.

A vCloud Suite edition combines components such as vSphere Enterprise Plus, vCloud Director, vCloud
Networking and Security, and others, under a single license. vCloud Suite editions are licensed on per-
processor basis. Many of the vCloud Suite components are also available as standalone products licensed on
per-virtual machine basis. However, when these components are obtained through the vCloud Suite, they are
licensed on per-processor basis.

The components from a vCloud Suite edition are activated with a single license key. For example, if you have
a license key for vCloud Suite 5.1 Standard, you can use the same key to activate vSphere Enterprise Plus,
vCloud Director, vCloud Networking and Security, and so on.

All virtual machines running on a processor licensed with a vCloud Suite edition can use all components
included in that vCloud Suite edition. To run virtual machines on processors that are not licensed for vCloud
Suite, you need individual licenses for the products that you want to use.

For more information about the licensing model of vCloud Suite 5.1, see vCloud Suite 5.1 Licensing.

License and Evaluation Period Expiry

License and evaluation period expiry lead to consequences that prevent you from performing certain
operations in the vSphere environment.

For ESXi hosts, evaluation period expiry leads to disconnecting the hosts from vCenter Server. All powered-
on virtual machines continue to work, but you cannot power on any new virtual machines. You cannot change
the current configuration of the features that are already in use. You cannot use the features that remained
unused while the host was in evaluation mode.

When the evaluation period of a vCenter Server system expires, all hosts disconnect from that vCenter Server
system.

The specifics of every solution determine the consequences of the license or evaluation mode expiry. Refer to
the solution documentation for details

Licensing ESXi Hosts and vCenter Server After Upgrade

Upgrading the ESXi or vCenter Server software may require changes in the licensing configuration of ESXi
hosts or vCenter Server.

When you apply a minor upgrade or a patch to an ESXi host or vCenter Server, you do not need to replace the
existing license key with a new one. If you apply a major upgrade to an ESXi host or vCenter Server, you need
to apply a new license key. For example, if you upgrade an ESXi host from 4.x to 5., you need to license the
host with a vSphere 5.x license. Similarly, if you upgrade vCenter Server from 4.x to 5.x, you must assign a
vCenter Server 5.x license.

If you upgrade the edition of the license, for example, from vSphere Standard to vSphere Enterprise, you must
replace the existing license key on the assets with the upgraded license key.

ESX/ESXi 3.5 hosts require a license server to manage host-based license files. If you upgrade all your ESX/ESXi
3.5 hosts to 4.0 and later, you do not need a license server.
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vCenter Server License Inventory
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All license keys of ESXi hosts, vCenter Server and solutions are kept in the vCenter Server license inventory.
vCenter Server systems in Linked Mode share a common license inventory.

Thelicense inventories in the vCenter Server systems maintain work slightly differently, depending on whether
you have Linked Mode groups or standalone systems.

These examples are specific to ESXi hosts and might not apply to solutions.

Example: Uninstallation Scenarios

1
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You uninstall vCenter Server without first unlicensing and removing the hosts.
The hosts remain licensed.
You add the licensed hosts to another vCenter Server instance.

The license keys are transferred with the hosts.

slightly different scenario:

You uninstall vCenter Server keeping all hosts licensed.

You reinstall vCenter Server and make it part of a different Linked Mode group.

The host license keys from the previous group are not transferred to the new group.

You add hosts that were licensed by the previous vCenter Server group to the new group.
The host license keys are transferred to the new group.

The host license keys now belong to two Linked Mode groups. If the total assignment of the key exceeds
the key's capacity, this scenario is not supported and causes your license usage to be out of compliance.

Example: Standalone Scenario

Each vCenter Server instance maintains its own license inventory. If you add an ESXi host to vCenter Server
and add the same host to another vCenter Server instance, the host license key moves from the first inventory
to the second inventory.

1
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You have two vCenter Server instances that are standalone.
You assign a license to a host in one vCenter Server instance.
You add the host to another vCenter Server instance and retain the license when you add a host.

The host license key belongs to two separate license inventories. If the total assignment of the key exceeds
the key's capacity, this scenario is not supported and causes your license use to be out of compliance.

Example: Linked Mode Scenario

1
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You have two vCenter Server instances that belong to the same Linked Mode group.
You assign a license to a host in one vCenter Server instance.
The two vCenter Server instances share a single license inventory.

When you add a license key, the key becomes available to all the vCenter Server systems within the same
Linked Mode group. The license keys are shared, and each system in the group has the same inventory
view, although this might not always seem so because of replication delays.
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License Management Permissions

You can control which users can view and manage license resources.

The following permission types are supported.

Global.Licenses If you have global permission at the root folder, you can view and modify all

licenses in the vCenter Server inventory. This permission includes other
vCenter Server systems in a Linked Mode group.

Read-only If you have read-only permission on a host, the vCenter Server displays the

first and last five characters of the license key assigned to the host, the features
present in the license, and the expiration date for the license.

If you have neither of these permissions but you have the permission to add a host to vCenter Server, you can
add a license to the inventory and assign a license to the host when you perform the add host operation.

Managing Licenses

License management is centralized. You can use the vSphere Client to manage all licenses that are available in
the license inventory of a vCenter Server system or a Linked Mode group.

View License Information on page 109

You can view the license keys available in the vCenter Server license inventory from the Licensing page
in the vSphere Client.

Add License Keys to the License Inventory on page 110

After you obtain license keys, you can add them to the vCenter Server license inventory. You can add
multiple license keys at the same time.

Assign a License Key to Assets on page 111

You can assign license keys to single or multiple assets, individually, or in batches.

Add a License Key and Assign It to an Asset on page 111

After you obtain a license key, you can add it to the vCenter Server license inventory and assign the
license key to assets.

Export License Information on page 112

You can export license information in a file that you can later open with third-party applications.

Managing Licenses on ESXi Hosts on page 112

You can license an ESXi host that is connected to a vCenter Server system or to a Linked Mode group.
You can also query which features are licensed on a host or set a host to evaluation mode.

Managing Licenses on ESX/ESXi 3.5 Hosts on page 114

vCenter Server 5.x requires a license server to manage licenses on ESX/ESXi 3.5. For ESX/ESXi 4.x and
later hosts, vCenter Server 5.x does not require a license server.

View License Information

You can view the license keys available in the vCenter Server license inventory from the Licensing page in the
vSphere Client.

Prerequisites
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Procedure
1  Inthe vSphere Client, select Home > Licensing.

You can view and manage the license keys available in the vCenter Server inventory from the
Management tab.

2 (Optional) Click Refresh.

3 Inthe Management tab, select a sorting option for the license information.

Option Description

Product Displays the available license keys listed by product.

License key Displays the available license keys listed by license key.

Asset Displays the available license keys listed by the asset to which they are

assigned: host, vCenter Server, or solution.

The Management tab displays the available license keys listed by product, license key, or asset. You can right-
click any of the listed items to add, assign, and remove license keys and copy license information to your
clipboard.

What to do next

If you have a license key with zero assigned capacity, you can:
B Assign the license key to assets that require licensing.

B Remove the license key if the key is no longer required.

You should not keep unassigned license keys in the vCenter Server license inventory.

Add License Keys to the License Inventory

After you obtain license keys, you can add them to the vCenter Server license inventory. You can add multiple
license keys at the same time.

Prerequisites
B Verify that you have the Global.Licenses privilege.

B Ensure that the vSphere Client is connected to the vCenter Server system.

Procedure

1  In the vSphere Client, select Home > Administration > Licensing.

2 Click Manage vSphere Licenses.

3 Inthe Add License Keys text area, specify license keys one per line.
You can specify a list of keys in one operation.

4  (Optional) Type a brief description of the keys.

5 Click Add License Keys.

If you specify any invalid license keys, you receive an error message that lists only the invalid keys. You
can either delete the invalid keys, or add them after correcting them.

6 If you are not ready to assign the license keys to assets, click Next through the remaining wizard screens
and click Finish to save your changes.

The license keys are added to the vCenter Server license inventory. If vCenter Server is in a Linked Mode
group, the license keys are added to the shared inventory of the Linked Mode group.
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What to do next

Assign the license keys to assets that require licensing. You should not keep unassigned license keys in the
vCenter Server license inventory.

Assign a License Key to Assets

You can assign license keys to single or multiple assets, individually, or in batches.

Norte If an ESXi host disconnects from vCenter Server immediately after you assign a license key, the license
assignment operation does not complete but the host appears as licensed. The host is licensed after it reconnects
to vCenter Server.

Prerequisites
B Verify that you have the Global.Licenses privilege.

B Ensure that the vSphere Client is connected to the vCenter Server system.

Procedure

1  In the vSphere Client, select Home > Administration > Licensing.

Click Manage vSphere Licenses.

Click Next to go to the Assign Licenses page.

Click the ESX, vCenter Server, or Solutions tab to display the available assets.

Select the assets to show.
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In the Asset window, select one or more assets to license.
To select multiple assets, use Ctrl-click or Shift-click.
7 Inthe Product window, select an appropriate license key and click Next.

If the license key you assign has a strong limit, the license capacity must be greater than or equal to the
required license use for the asset. Otherwise, you cannot assign the license key. Check the EULA of the
license to determine whether it has a strong limit.

8  (Optional) If you are not ready to remove any license keys, click Next to skip the Remove License Keys
page and click Finish to save your changes.

Add a License Key and Assign It to an Asset

After you obtain a license key, you can add it to the vCenter Server license inventory and assign the license
key to assets.

Prerequisites
B Verify that you have the Global.Licenses privilege.

B Ensure that the vSphere Client is connected to the vCenter Server system.

Procedure

1  In the vSphere Client, select Home > Administration > Licensing.

In the Management tab, select Asset as a primary entity for sorting the license information.
Right-click an asset and select Change license key.

Select Assign a new license key and click Enter Key.
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Specify the license key, type an optional label for the key, and click OK.
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6 Click OK.

The license key is added to the vCenter Server license inventory and assigned to the corresponding asset. If
vCenter Server is part of a Linked Mode group, the license key is added to the shared inventory of the group.

What to do next

Assign the license key to other assets of the same type in case the license key has available capacity.

Export License Information

You can export license information in a file that you can later open with third-party applications.

Prerequisites
B Verify that you have the Global.Licenses privilege.

B Ensure that the vSphere Client is connected to the vCenter Server system.

Procedure
1  In the vSphere Client, select Home > Administration > Licensing.
2 In the Management tab, select the view that you want to export.
B Product
B License key
B Asset
3 On the report screen, click Export.

4  Inthe Save As dialog box, select a folder, a filename, and a format for the exported license data and click
Save.

Managing Licenses on ESXi Hosts

You can license an ESXi host that is connected to a vCenter Server system or to a Linked Mode group. You can
also query which features are licensed on a host or set a host to evaluation mode.

B Assign a License Key to an ESXi Host on page 112

You can assign a license key to an ESXi from the Licensing page in the vSphere Client.

B View Which Features Are Licensed on a Host on page 113

You can view which features a host is licensed to use.

B Setan ESXi Host to Evaluation Mode on page 113

If you have assigned a license key to an ESXi host, you can switch to evaluation mode to explore the full
set of features that are available for the host..

Assign a License Key to an ESXi Host

You can assign a license key to an ESXi from the Licensing page in the vSphere Client.

If the vSphere Client is connected directly to the host, on the host Configuration tab click Licensed Features
> Edit to change the license key.

Prerequisites
B Verify that you have the Global.Licenses privilege.

B Ensure that the vSphere Client is connected to the vCenter Server system.
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Procedure
1  In the vSphere Client, select Home > Administration > Licensing.
2 In the Management tab, right-click a host and select Change license key.
3 Assign alicense key.
B Select Assign an existing license key to this host and select a license key from the Product list.

B Select Assign anew license key to this host, click Enter Key, and specify a license key and an optional
label for the license key.

4  Click OK.

View Which Features Are Licensed on a Host
You can view which features a host is licensed to use.

If you try to configure features that are not included in the host license, the vSphere Client displays an error
message.

Procedure
1  From the vSphere Client, select the host in the inventory.
2 Click the Configuration tab.

3 Under Software, click Licensed Features.

The list appears of features that you can configure on the host.

Set an ESXi Host to Evaluation Mode

If you have assigned a license key to an ESXi host, you can switch to evaluation mode to explore the full set of
features that are available for the host..

Procedure

1 From the vSphere Client connected to a vCenter Server, select the host in the inventory.
Click the Configuration tab.

Under Software, click Licensed Features.

Click Edit next to ESX Server License Type.

Click Product Evaluation.
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Click OK to save your changes.

The host is in evaluation mode and you can explore the entire set of features for ESXi. If you have already used
the host in evaluation mode, the time that remains in the evaluation period is decreased by the time already
used. For example, suppose you have used the host in evaluation mode for 20 days and then assigned a vSphere
Standard license key to the host. If you set the host back in evaluation mode, you can explore the entire set of
features that are available for the host for the remaining evaluation period of 40 days. You can track the
remaining days from the evaluation period of a host in the host's page in the vSphere Client.

Note After the evaluation period of the host expires, you receive a warning message, and the host disconnects
from vCenter Server. All powered-on virtual machines continue to work, but you cannot power on any new
virtual machines. You cannot change the current configuration of the features that are already in use. You
cannot use the features that remained unused while the host was in evaluation mode.
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Managing Licenses on ESX/ESXi 3.5 Hosts

vCenter Server 5.x requires a license server to manage licenses on ESX/ESXi 3.5. For ESX/ESXi 4.x and later
hosts, vCenter Server 5.x does not require a license server.

If you do not have a license server installed and you need one, download the VMware License Server from the
VMware Web site.

The license server installation requires no downtime. No virtual machines, servers, hosts, or clients need to be
powered off for the installation of the license server.

Configure vCenter Server to Use a License Server

To manage licences on ESX/ESXi 3.5 hosts, you must configure vCenter Server 5.0 to use a license server.
Prerequisites

You must have a license server installed. You can download the VMware License Server from the VMware
Web site.

Procedure

1  Connect to vCenter Server by using the vSphere Client.

2 Select Administration > vCenter Server Settings.

3 Inthe License Server text box, type the port number and license server machine name, as in port@host.
For example: 27000@1icense-3. companyname.com

4  If you want the hosts and vCenter Server to use the same license server, select the Reconfigure ESX 3
hosts using license servers to use this server check box.

5 Click OK.

Managing Licenses in the vSphere Web Client

114

You can use the license management function in the vSphere Web Client to manage the licensing of the assets
in your vSphere environment from a central place. You can add license keys in the vCenter Server inventory,
assign license keys to multiple assets at a time, view information about the available products and licenses,
and export licensing information in a CSV file.

View License Information in the vSphere Web Client

You can view information about the license keys and products that are available in the inventory of a vCenter
Server instance or a Linked Mode group.

To view the privileges for the role of your user account, select Administration > Role Manager in the
vSphere Web Client.

Prerequisites

Required privilege: Global.Licenses

Procedure

1 Inthe vSphere Web Client, select Administration > Licensing > Licenses.

2 From the vCenter Server drop-down menu, select a vCenter Server instance.

If you select a vCenter Server instance that is part of a Linked Mode group, you view licensing information
for the entire group.
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Select a tab depending on the licensing information that you want to view.

Tab Description

Products Lists the products that have license keys available in the license inventory of
the selected vCenter Server instance. If the vCenter Server instance is part of
a Linked Mode group, you can view all products that are available for the
group.

License keys Lists all license keys that are available in the license inventory of the selected
vCenter Server instance. If the vCenter Server instance is part of a Linked
Mode group, the tab lists all license keys that are available in the shared
license inventory of the group.

vCenter Server Instances Displays licensing information about the selected vCenter Server instance. If
the vCenter Server instance is part of a Linked Mode group, the tab displays
licensing information about all vCenter Server instances in the group.

Hosts Lists all hosts that are connected to the selected vCenter Server instance. If
the vCenter Server instance is part of a Linked Mode group, the tab displays
all hosts that are available in the inventories of all vCenter Server instances
in the group.

Solutions Lists all solutions that are registered with the selected vCenter Server
instance. If the vCenter Server instance is part of a Linked Mode group, the
tab lists all solutions that are registered with the vCenter Server instances in
the group.

NoTe You might notice VRAM usage reported for vSphere 5.x licenses. vSphere 5.x is licensed per-
processor and you should ignore the reported vRAM usage for vSphere 5.x licenses.

What to do next

You should not keep unassigned license keys in the license inventory of vCenter Server.

If any unassigned license keys exist, assign these keys to vCenter Server instances, hosts or solutions that
need licensing.

Remove all license keys that are no longer required, such as expired license keys or keys that you do not
intend to assign.

Add License Keys to the Licensing Inventory in the vSphere Web Client

To assign license keys to assets, you should add the keys to the license inventory of the vCenter Server instances
or the Linked Mode group where the assets reside. You can add multiple license keys at the same time.

Prerequisites

Required privilege: Global.Licenses

Procedure

1 In the vSphere Web Client, select Administration > Licensing > Licenses.

2 From the vCenter Server drop-down menu, select the vCenter Server instance where you want to add the
license keys.
If you select a vCenter Server instance that is part of a Linked Mode group, the license keys are added to
the shared license inventory of the group.

3 Select the License Keys tab.

4  Click the Add License Keys (+) icon.

5 In the text area of theAdd License Keys dialog box, enter license keys one per line.
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6  (Optional) Label the license keys.
7 Click Next.

If you enter any invalid license keys, you receive an error message that lists only the invalid keys. You can
either delete the invalid keys, or correct them.

8 In the Ready to complete page, review the license keys to add and click Finish.

The license keys are added to the license inventory of the vCenter Server instance that you selected. If the
vCenter Server instance is in a Linked Mode group, the license keys are added to the shared inventory of the
Linked Mode group.

What to do next

Assign the license keys to hosts, vCenter Server instances or solutions that require licensing. You should not
keep unassigned license keys in license inventory of vCenter Server.

Confirm Adding License Keys in the vSphere Web Client

When you advance to the Ready to Complete page, the Add License Keys wizard shows information about
the license keys to add.

Procedure
1  (Optional) To change the configuration, click Back.
2 Toadd the license keys, click Finish.

Assign a License Key to Assets in the vSphere Web Client

After you add license keys to the license inventory of vCenter Server, you can assign the keys to unlicensed
assets, assets with expiring licenses, or assets with expiring evaluation period.

Norte If an ESXi host disconnects from vCenter Server immediately after you assign a license key, the license
assignment is not completed but the host appears as licensed. The host is licensed after it reconnects to vCenter
Server.

Prerequisites
B Required privilege: Global.Licenses

B Verify that the license keys that you want to assign are available in the inventory of the vCenter Server
system.

Procedure

1  Select a licensing option.

Licensing option Description

License an individual asset object a Navigate to the asset in the inventory.
b Click Manage, and click Settings
¢ Select Licensing.

License management function a Navigate to Administration > Licensing > Licenses.

b From the vCenter Server drop-down menu, select a vCenter Server
instance.

c Select the vCenter Server Instances, Hosts, or the Solutions tab.
d  Select the asset to license.
To select multiple assets, use Shift+click.

2 Click Assign License Key.
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3 Select the license key to assign and click OK.

Make sure that you select a license key that supports all the features that the asset runs.

The license key is assigned to the asset . Capacity from the license key is allocated according to the required

license usage for the asset.

NoTe You might notice VRAM usage reported for vSphere 5.x licenses. vSphere 5.x is licensed per-processor
and you should ignore the reported vVRAM usage for vSphere 5.x licenses.

Add a License Key and Assign it to Assets in the vSphere Web Client

After you obtain a license key, you can add it to the vCenter Server license inventory and assign it to assets.

Prerequisites
Required privilege: Global.Licenses
Procedure

1  Select a licensing option.

Licensing option

Description

License an individual asset object

Navigate to the asset in the inventory.
Click Manage, and click Settings
Select Licensing.

License management function

C

d

Navigate to Administration > Licensing > Licenses.

From the vCenter Server drop-down menu, select a vCenter Server
instance.

Select the vCenter Server Instances, Hosts, or the Solutions tab.
Select the asset to license.

To select multiple assets, use Shift+click.

Click Assign License Key.
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Click Decode.

From the licensing method drop-down menu, select Assign a new license key.

Type the license key, and type an optional label for the key.

Decode the license key to verify that it is in the correct format, and that it has enough capacity to satisfy

the required license usage for the asset. You can also decode the license key to verity that it belongs to the
correct product that is associated with the asset.

6 Click OK.

The license key is added to the inventory of vCenter Server and assigned to the asset . Capacity from the license

key is allocated according to the required license usage for the asset.

Note You might notice VRAM usage reported for vSphere 5.x licenses. vSphere 5.x is licensed per-processor
and you should ignore the reported vVRAM usage for vSphere 5.x licenses.

Export Licensing Information in the vSphere Web Client

You can export licensing information in a file that you can later open with third-party applications.

Prerequisites

Required privilege: Global.Licenses
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Procedure
1  In the vSphere Web Client, select Administration > Licensing > Licenses.
2 From the vCenter Server drop-down menu, select the vCenter Server instance for which you want to
export licensing information.
If the selected vCenter Server instance is part of a Linked Mode group, licensing information is exported
for the entire group.
3 Select the view that you want to export.
4  (Optional) Select a row from the table whose contents you want to export.
5 At the bottom right of the screen, click the Export list (%) action icon.
6  Select rows and columns to export.
Option Description
Rows If you have chosen a particular row from the table, leave the Selected rows
only option selected. To export all the contents of the view, select All rows.
Columns Specify columns to export from the table, by selecting the check box next
every column name.
7  Click Generate CSV Report.
8  When the report is generated, click Save.
9  Select a folder, a filename, and a format for the exported license data and click Save.

View Information About a Product in the vSphere Web Client

You can view information about a product, such as its associated license keys, and license capacity from the
Licensing option in the vSphere Web Client.

Prerequisites

Required privilege: Global.Licenses

Procedure

1 Inthe vSphere Web Client, select Administration > Licensing > Licenses.

2 From the vCenter Server drop-down menu, select the vCenter Server instance where the license keys that
are associated with the product reside.
If the vCenter Server instance is part of a Linked Mode group, the license keys for the product reside in
the shared license inventory of the group.

3 Select the Products tab.

4 In the table, select the row of the product for which you want to view information.

5  Click the product.

The vSphere Web Client displays information about the product. You can view the license keys that are
available for the product, the license capacity of the product, and the current license assignments.

Note You might notice vVRAM usage reported for vSphere 5.x products. vSphere 5.x is licensed per-processor
and you should ignore the reported vVRAM usage for vSphere 5.x products.
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View Information About a License Key in the vSphere Web Client

You can view information about a license key such as its associated product and capacity from the Licensing
option in the vSphere Web Client.

Prerequisites

Required privilege: Global.Licenses

Procedure
1 Inthe vSphere Web Client, select Administration > Licensing > Licenses.

2 From the vCenter Server drop-down menu, select the vCenter Server instance where the license key
resides.

If the vCenter Server instance is part of a Linked Mode group, the license key resides in the shared license
inventory of the group.

3 Select the License Keys tab.

4 In the table, select the row of the license key for which you want to view information.

5  Click the license key.

The vSphere Web Client displays information about the license key. You can view the product thatis associated

with the license key, the capacity of the key, the assets to which the license key is assigned, and other
information.

NoTe You might notice VRAM usage reported for vSphere 5.x licenses. vSphere 5.x is licensed per-processor
and you should ignore the reported vVRAM usage for vSphere 5.x licenses.

Managing Licenses on ESXi hosts in the vSphere Web Client

You can license an ESXi host that is connected to a vCenter Server system or to a Linked Mode group. You can
also view which features are licensed on a host or set a host to evaluation mode.

Assign a License Key to an ESXi Host in the vSphere Web Client

To be able to use certain features and functionality of an ESXi host, you must assign it a license key when the
evaluation period of the host expires.

Prerequisites

Required privilege: Global.Licenses

Procedure

1  In the vSphere Web Client, navigate to the host in the vSphere inventory.
Select the Manage tab.

Under System, select Licensing,.

=SS I ]

Click Assign License Key.
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5  From the drop-down menu, select an option to assign a license key to the host.

Option Description

Assign an existing license key Select from the license keys that already exist in the inventory of the vCenter
Server instance that manages the host. Make sure to select a license key that
supports all the features that the host runs.

Assign a new license key Enter a new license key and assign it to the host. You can click Decode to
verify that the license key is in the correct format, and that it has enough
capacity to satisfy the required license usage for the host. You can also decode
the license key to verity that it belongs to the correct product.

6 Click OK.

The license is assigned to the host. Capacity from the license key is allocated according to the required license
usage for the host.

Note If you assign a vSphere 5.x license to the host, you might notice that there is a VRAM usage reported
for the license. vSphere 5.x is licensed per-processor and you should ignore the reported vRAM usage for
vSphere 5.x licenses.

View the Licensed Features on a Host by Using the vSphere Web Client

Before you start to use a feature on a host, you can check whether the host is licensed to use this feature. If you
attempt to use features that are not included in the host license, the vSphere Web Client displays an error
message.

Procedure
1  In the vSphere Web Client, navigate to the host whose licensed features you want to view.
Click the Manage tab.

Select the Settings option.
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Under System, select Licensing.
The list of features that you can configure on the host appears on the right.

Set an ESXi Host to Evaluation Mode in the vSphere Web Client

To explore the complete set of features available for an ESXi host, you can set it to evaluation mode.

Procedure

1  In the vSphere Web Client, navigate to the host in the inventory.
On the Manage tab, select Settings.

Under System, click Licensing.

Click Assign License Key.

Select Evaluation mode.
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Click OK to save your changes.
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The host is in evaluation mode and you can explore the entire set of features that are relevant to a vSphere
Enterprise Plus license. If you have already used the host in evaluation mode, the time that remains in the
evaluation period is decreased by the time already used.

Note After the evaluation period of the host expires, you receive a warning message, and the host disconnects
from vCenter Server. All powered-on virtual machines continue to work, but you cannot power on any new
virtual machines. You cannot change the current configuration of the features that are already in use. You
cannot use the features that remained unused while the host was in evaluation mode.

Viewing License Use

You can view the use and capacity of the license keys that are assigned to assets for a period that you select.
You can use the license reporting function in vCenter Server to perform the following tasks:

B View statistics for the license use and capacity of products filtered by a vCenter Server system and time
period.

B Export license use reports in a CSV format for further analysis and processing.

B Set a threshold for the license use of products with use-based licensing models, such as per-virtual
machine. You can use license use thresholds to receive notifications if a certain use is exceeded.

The License Usage History service on vCenter Server takes snapshots of the license use every hour. The license
use snapshots are stored in the vCenter Server database. A license use snapshot contains data about the current
license assignment and use. The license use information that you can view in the license reporting interface
contains aggregated statistics from the snapshots that are collected in the period that you select.

The license use reports that you can export in CSV format contain the raw data from the license use snapshots
that are collected in the period that you select.

View the License Use for Multiple Products

You can view the license use for products from the Licensing page in the vSphere Client. You can filter the
license use data by vCenter Server system and time period.

Prerequisites

B Verify that you have the Global.Licenses privilege.

B Ensure that the vSphere Client is connected to the vCenter Server system.

B Ensure that you have the vSphere Web Client installed and the vCenter Server system is registered with
it.

Procedure

1  In the vSphere Client, select Home > Administration > Licensing.

2 Select the Reporting tab.

3 (Optional) If the vCenter Server instance that you are connected to is part of a Linked Mode group, leave
the default All vCenter Server instances value in the vCenter Server drop-down menu.

You should leave the default All vCenter Server instances value to view the license use for the entire
group. If you view the license use for a single vCenter Server instance and not the entire group, you do
not receive information about the total use of license keys assigned to more than one asset in the group.

4  From the Time period drop-down menu, select a preconfigured or a custom time period for which you
want to view the license use for products.

a  (Optional) If you select a custom time period, specify the start and end dates, and click Recalculate.
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The Products Chart shows the license use for each product as a percentage of the license capacity for the product
over the period that you select. If a threshold exists for the license use of a product, the percentage of the
threshold use appears in the chart.

Note You might notice VRAM usage reported for vSphere 5.x licenses. vSphere 5.x is licensed per-processor
and you should ignore the reported vVRAM usage for vSphere 5.x licenses.

View License Use Details for a Single Product

You can view details about the license use for a product from the Licensing page in the vSphere Client. You
can filter the license use data by a vCenter Server and period.

Prerequisites

B Verify that you have the Global.Licenses privilege.

B Ensure that the vSphere Client is connected to the vCenter Server system.

B Ensure that you have the vSphere Web Client installed and the vCenter Server system is registered with
it.

Procedure

1  In the vSphere Client, select Home > Administration > Licensing.

2 Select the Reporting tab.

3 If the vCenter Server instance that you are connected to is part of a Linked Mode group, leave the default
All vCenter Server instances value in the vCenter Server drop-down menu.

You should leave the default All vCenter Server instances value to view the license use for a product for
the entire group. If you view the license use for a single vCenter Server instance and not the entire group,
you do not receive information about the total use of license keys that are assigned to more than one asset
in the group.

4  Select a preconfigured or a custom period for the license use details from the Time period drop-down
menu.

a  (Optional) If you select a custom time period, specify the start and end dates, and click Recalculate.
5  Select a product from the Products Chart pane.
Details about the license use of the product that you select appear in the Product Details pane. The table in the

Product Details pane lists all the license keys for the product that are assigned to assets in the selected period.
The table can list license keys that are not used currently but were assigned to assets in the selected period.

Note You might notice VRAM usage reported for vSphere 5.x licenses. vSphere 5.x is licensed per-processor
and you should ignore the reported vVRAM usage for vSphere 5.x licenses.

What to do next

View details about each license key for the product.

View Details for a License Key

From the Licensing page of the vSphere Client, you can view details about the use and capacity of each license
key that is assigned to an asset.

Prerequisites
B Verify that you have the Global.Licenses privilege.

B Ensure that the vSphere Client is connected to the vCenter Server system.
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B Ensure that you have the vSphere Web Client installed and the vCenter Server system is registered with
it.

Procedure

1  In the vSphere Client, select Home > Administration > Licensing.

2 Select the Reporting tab.

3 If the vCenter Server instance that you are connected to is part of a Linked Mode group, leave the default
All vCenter Server instances value in the vCenter Server drop-down menu.

You should leave the default All vCenter Server instances value to view the use for a license key for the
entire group. If you select a single vCenter Server instance and the license key is assigned to more than
one asset in the group, you do not receive information about the total use of the license key.

4  From the Time period drop-down menu, select the time period for which you want to view details for a
license key.

a  (Optional) If you select a custom time period, specify the start and end dates, and click Recalculate.
5 To view the license keys that belong to a product, select the product from the Products Chart pane.

6 To view the details for a license key, select the key from the Product Details pane.

Export a License Use Report

From the Licensing page in the vSphere Client, you can export a report for the license use of products for a
certain time period. The report is exported in a CSV file that you can later open with third party applications.

Note A tamper-detection feature in vCenter Server protects the license use information. If the licensing data
in the vCenter Server database has been edited, you cannot export a license use report.

Prerequisites

B Verify that you have the Global.Licenses privilege.

B Ensure that the vSphere Client is connected to the vCenter Server system.

B Ensure that you have the vSphere Web Client installed and the vCenter Server system is registered with
it.

Procedure

1  In the vSphere Client, select Home > Administration > Licensing.

2 Select the Reporting tab.

3 Click export.
The Export License Data window appears.

4  (Optional) If the vCenter Server instance that you are connected to is part of a Linked Mode group, leave
the default All vCenter Server instances value in the vCenter Server drop-down menu.

You should leave the default All vCenter Server instances value to export the license use for the entire
group. By exporting the license use for a single vCenter Server instance and not the entire group, you do
not receive information about the total use of license keys that are assigned to more than one asset in the

group.

5  Selecta preconfigured or a custom time period for the license use report from the Time period drop-down
menu.

6  Click Export.

The export operation takes a few seconds.
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7 In the Save Export File window, click Yes.

8 Browse to the location where you want to save the file and click Save.

The license use for products over the selected time period is exported in an CSV file. The CSV file is contained
in a .zip file that you can find in the location you specified.

Note You might notice VRAM usage reported for vSphere 5.x licenses. vSphere 5.x is licensed per-processor
and you should ignore the reported vVRAM usage for vSphere 5.x licenses.

Set a Threshold for the License Use of a Product

You can set a threshold for the license use of products. A threshold helps you to track whether the current
license use for a product exceeds certain limits. If the license use for the product exceeds the threshold, an
alarm is triggered on the corresponding vCenter Server system.

You can apply thresholds only to products with use-based licensing models such as per-virtual machine. You
can set thresholds below or above the purchased license capacity. You can use thresholds as an additional
means to receive notifications if the license use for a product exceeds certain limits. Thresholds do not enforce
license use limits.

NoTe You can set thresholds for the license use of products only for individual vCenter Server systems. You
cannot set thresholds for all vCenter Server systems in a Linked Mode group.

Prerequisites

B Verify that you have the Global.Licenses privilege.

B Ensure that the vSphere Client is connected to the vCenter Server system.

B Ensure that you have the vSphere Web Client installed and the vCenter Server system is registered with
it.

Procedure

1  In the vSphere Client, select Home > Administration > Licensing.

2 Select the Reporting tab.

3 (Optional) If the vCenter Server that you are connected to is part of a Linked Mode group, from the vCenter
Server drop-down menu, select the vCenter Server system where you want to set a threshold for the license
use of a product.

Select the product from the Products Chart pane.
Click Edit Threshold in the Product Details pane.

Type the value for the threshold.

NN G

Click OK.

You receive a message that the threshold is successfully set for the relevant product. The view in the Products
Chart refreshes after a few seconds and a bar appears that indicates the threshold value as a percent of the
license capacity of the product.

If the license use for the product exceeds the threshold amount, an alarm is triggered on the corresponding
vCenter Server, and a notice appears on the Reporting tab of the Licensing page. However, further use of the
product is not restricted.

Note The notifications might take several minutes to appear after a threshold is exceeded.
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Viewing License Use in the vSphere Web Client

You can view the use and capacity of the license keys that are assigned to assets for a period that you select by
using the vSphere Web Client.

View the License Use for Multiple Products in the vSphere Web Client

You might want to track the license use for products that have license keys assigned to asset. Tracking the
license use for products helps you to estimate what are the overall license requirements for your environment
and to remain in compliance. You can filter the license use data by vCenter Server system and time period.

Prerequisites

Required privilege: Global.Licenses

Procedure
1  In the vSphere Web Client, select Administration > Licensing > License Reports.

2 From the vCenter Server drop-down menu, select the vCenter Server instance for which you want to
generate license use data.

When you select a vCenter Server instance that is part of a Linked Mode group, license use data is
aggregated for the entire Linked Mode group.

3 (Optional) To generate the license use report for a vCenter Server instance that is part of a Linked Mode
group, select Show data only for the selected vCenter Server.

4  From the Time period drop-down menu, select a preconfigured or a custom time period for which you
want to generate license use data.

5 If you select a custom time period, specify the start and end dates, and click Recalculate.
The Products Chart shows the license use for each product as a percentage of the license capacity for the product

over the selected period. If a threshold exists for the license use of a product, the percentage of the threshold
use appears in the chart.

Note You might notice VRAM usage reported for vSphere 5.x licenses. vSphere 5.x is licensed per-processor
and you should ignore the reported vVRAM usage for vSphere 5.x licenses.

View License Use Details for a Single Product in the vSphere Web Client

You can view details about the license use and capacity of a certain product. You can filter the license use data
by a vCenter Server system and time period.

Prerequisites

Required privilege: Global.Licenses

Procedure
1  In the vSphere Web Client, select Administration > Licensing > License Reports.

2 From the vCenter Server drop-down menu, select the vCenter Server instance for which you want to
generate license use data.

When you select a vCenter Server instance that is part of a Linked Mode group, license use data is
aggregated for the entire Linked Mode group.

3 (Optional) To generate the license use report for a vCenter Server instance that is part of a Linked Mode
group, select Show data only for the selected vCenter Server.
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4  From the Time period drop-down menu, select a preconfigured or a custom time period for which you
want to generate license use data.

5 If you select a custom time period, specify the start and end dates, and click Recalculate.

6  Select a product from the Products Chart pane.

NoTe You might notice VRAM usage reported for vSphere 5.x licenses. vSphere 5.x is licensed per-processor
and you should ignore the reported vVRAM usage for vSphere 5.x licenses.

Details about the license use for the selected product that appear in the Product Details pane. The table in the
Product Details pane lists all the license keys for the product that are assigned to assets in the selected period.
The table can list license keys that are not used currently but were assigned to assets in the selected period.

NoTe You might notice VRAM usage reported for vSphere 5.x licenses. vSphere 5.x is licensed per-processor
and you should ignore the reported vVRAM usage for vSphere 5.x licenses.

View Details for a License Key in the vSphere Web Client

You might want to view details about the use and capacity of each license key that is assigned to an asset.

Note You might notice VRAM usage reported for vSphere 5.x licenses. vSphere 5.x is licensed per-processor
and you should ignore the reported vVRAM usage for vSphere 5.x licenses.

Prerequisites

Required privilege: Global.Licenses

Procedure
1  In the vSphere Web Client, select Administration > Licensing > License Reports.

2 From the vCenter Server drop-down menu, select the vCenter Server instance for which you want to
generate license use data.

When you select a vCenter Server instance that is part of a Linked Mode group, license use data is
aggregated for the entire Linked Mode group.

3 (Optional) To generate the license use report for a vCenter Server instance that is part of a Linked Mode
group, select Show data only for the selected vCenter Server.

4  From the Time period drop-down menu, select the time period for which you want to view usage details
for a license key.

5 If you select a custom time period, specify the start and end dates, and click Recalculate.

6  To view the license keys that are associated with a product, select the product from the Products Chart
pane.

7  To view the details for a license key, select the key from the Product Details pane.

Export a License Use Report in the vSphere Web Client

You can export a report for the license use of products for a certain time period and vCenter Server instance.
The report is exported in a CSV file that you can later open with third-party applications.

Note A tamper-detection feature in vCenter Server protects the license use information. If the licensing data
in the vCenter Server database has been edited, you cannot export a license use report.
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Prerequisites

Required privilege: Global.Licenses

Procedure
1  In the vSphere Web Client, select Administration > Licensing > License Reports.
2 Click Export.

The Export License Data window appears.

3 From the vCenter Server drop-down menu, select the vCenter Server instance for which you want to
export license use data.

If you select a vCenter Server instance that is part of a Linked Mode group, the report contains license use
data for the entire group.

4  (Optional) To export data for a vCenter Server instance that is part of a Linked Mode group, select Export
license data only for the selected vCenter Server instance.

5  Selecta preconfigured or a custom time period for the license use report from the Time period drop-down
menu.

6  Click Export.
The export operation takes a few seconds.
7 In the Save Export File window, click Yes.
8  Browse to the location where you want to save the file and click Save.

The license use for products over the selected time period is exported in a CSV file. The CSV file is contained
in a .zip file saved to the specified location.

Note You might notice VRAM usage reported for vSphere 5.x licenses. vSphere 5.x is licensed per-processor
and you should ignore the reported vVRAM usage for vSphere 5.x licenses.

Set a Threshold for the License Use of a Product in the vSphere Web Client

You can set a threshold for the license use of products. A threshold helps you to track whether the current
license use for a product exceeds certain limits. If the license use for the product exceeds the threshold, an
alarm is triggered on the corresponding vCenter Server system.

You can apply thresholds only to products with use-based licensing models such as per-virtual machine. You
can set thresholds below or above the purchased license capacity. You can use thresholds as an additional
means to receive notifications if the license use for a product exceeds certain limits. Thresholds do not enforce
license use limits.

If the license use for the product exceeds the threshold amount, an alarm is triggered on the corresponding
vCenter Server system, and a notice appears on the License Reports view. However, further use of the product
is not restricted.

NoTE You can set thresholds for the license use of products only for individual vCenter Server systems. You
cannot set thresholds for all vCenter Server systems in a Linked Mode group.

Prerequisites

Required privilege: Global.Licenses

Procedure

1  In the vSphere Web Client, select Administration > Licensing > License Reports.
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2 From the vCenter Server drop-down menu, select the vCenter Server system where you want to set a
threshold for the license use of a product.

Select the product from the Products Chart pane.
Click Edit next to the Alert threshold in the Product Details pane.

Type a value for the threshold.

N G =W

Click OK.

You receive a message that the threshold is successfully set for the relevant product. The view in the Products
Chart refreshes after a few seconds and a bar appears that indicates the threshold value as a percent of the
license capacity of the product.

Note The notifications might take several minutes to appear after a threshold is exceeded.

Interpreting License Use Data
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The license use data in an exported report and the data that you view in the license reporting function are
interpreted differently. The license use data in an exported report contains the license usage snapshots that
vCenter Server has collected over a certain time period. The license use data that you view in the license
reporting function is aggregated from the license usage snapshots.

Interpreting License Use Data for Multiple Products

The license use data for products that is displayed in the Products Chart pane might be accompanied by an
asterisk (*) symbol that has a special meaning.

Certain products in the Products Chart might have one or two asterisk (*) symbols next to their names. The
asterisks have specific meanings.

Table 8-1. Interpreting Chart Results for Products Marked with Asterisks

vCenter Server Configuration Description

Single vCenter Server instance or all vCenter Serverinstances ~ An asterisk (*) next to a product in the Products Chart pane
in a Linked Mode group indicates that the licenses for the product have strong limits.
You cannot use more than 100 percent of the license capacity.

All vCenter Server instances in a Linked Mode group Two asterisks (**) next to a product in the Products Chart
indicate that the license use that is reported for the product
includes data from vCenter Server instances that no longer
participate in the Linked Mode group.

Single vCenter Server instance from a Linked Mode group ~ Two asterisks (**) next to a solution in the Products Chart
indicate that the license use that is reported for the solution
includes data for the entire Linked Mode group.

Licensing Details for a Selected Product

For each product, you can view details about the current and average license usage, and the current and average
license capacity that is available over a certain time period and vCenter Server system.

The table in the Product Details pane lists all license keys that belong to a product and that are assigned to
assets over the selected period. The table contains details for the use and capacity of every key.

The License Usage History service in every vCenter Server system collects license use snapshots every hour.
The license use on the Product Details pane is an aggregated value from the raw data in the license use
snapshots that are stored in vCenter Server.
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Table 8-2. Licensing Details for a Product

Licensing Detail for a
Product Description

Licenses used (selected period) Number of units from the available license capacity that assets have used over the selected

period.
Purchased capacity (selected Latest amount of license capacity that is purchased for the selected period.
period)
Licenses used % (selected Percentage of the purchased license capacity that assets use over the selected period.
period)
Licenses used (today) Number of units from the purchased license capacity that assets use on the current date.
Purchased capacity (today) Amount of license capacity that is available for the product on the current date.
Licenses used % (today) Percentage of the purchased license capacity that assets use on the current date.
Alert threshold Value of the threshold set for the license use of the product.

Details for a License Key

The details for a license key provide information about the license key assignment and use for a
vCenter Server system or a Linked Mode group during the selected time period.

Table 8-3. Details for a License Key

License Key Details Description

Asset Assets that are assigned with the license key over the selected period.

Licenses used (selected Number of units from the license key capacity that the asset has used over the selected period.
period) The value is aggregated from the data in the license usage snapshots that are available in the

vCenter Server database for the selected period. The License Usage History service in every
vCenter Server system collects license use snapshots every hour.

Licenses used (today) Amount of units from the license capacity that the asset uses on the current date.

License Use Data in an Exported Report

You can export the license use data for a certain period and for a vCenter Server system in a CSV file for later
analysis and reference.

The license use information that you view in the license reporting interface differs from the license use
information that you can export.

The license use information in the license reporting interface is aggregated from the license use snapshots
available in the vCenter Server database for the selected period.

The exported report is a CSV file that contains raw data about the license use of products for a single
vCenter Server system or a Linked Mode group. The exported report includes all the snapshots collected over
the selected period. The exported report can contain host, vCenter Server, or solution asset IDs, but does not
include user-defined names. The exported report is free of user and company-specific information.

Each row of the exported CSV file lists a single license use snapshot, which includes an asset, its assigned
license key, and the use at the given timestamp.

Table 8-4. Information in an Exported Report

Data Description
License Key Assigned license key.
Product Edition Edition of the product to which the license key belongs.
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Table 8-4. Information in an Exported Report (Continued)

Data

Description

Cost Unit

Capacity type of the license key (CPU, instance, virtual
machine, and so on).

License Key Expiration Date

Expiry date of the license key, if applicable.

Asset ID Automatically generated ID that vCenter Server uses to
identify the asset.

Usage Amount of units from the license capacity that the asset uses
at the time of the timestamp. The unit of this value is
indicated in the Cost Unit column.

Capacity Capacity of the license key. The unit of this value is indicated

in the Cost Unit column.

vCenter Servers

vCenter Server instances for which the usage is reported.
This column is useful when the report is generated for
multiple vCenter Server instances.

Timestamp

Timestamp of the license use snapshot.

The last section of raw data in the file contains a signature that is a checksum of the file content. You can ignore

this section of the report.

VMware, Inc.



Working with Tasks

vSphere tasks are activities and actions that occur on an object within the vSphere inventory.
This chapter includes the following topics:

B “Managing Tasks in the vSphere Web Client,” on page 131

B “Managing Tasks,” on page 132

B “Schedule Tasks,” on page 134

B “Report Errors to VMware,” on page 140

Managing Tasks in the vSphere Web Client

Tasks represent system activities that do not complete immediately, such as migrating a virtual machine. They
are initiated by high-level activities that you perform with the vSphere Web Client in real time and activities
that you schedule to occur at a later time or on a recurring basis.

For example, powering off a virtual machine is a task. You can perform this task manually every evening, or
you can set up a scheduled task to power off the virtual machine every evening for you.

Note The functionality available in the vSphere Web Clientdepends on whether the vSphere Web Client is
connected to a vCenter Server system or an ESXi host. Unless indicated, the process, task, or description applies
to both kinds of vSphere Web Client connections. When the vSphere Web Clientis connected to an ESXihost,
the Tasks option is not available; however, you can view recent tasks in the Status Bar at the bottom of the
vSphere Web Client.

View Tasks in the vSphere Web Client

You can view tasks that are associated with a single object or all objects in the vSphere Web Client.

By default, the tasks list for an object also includes tasks performed on its child objects. You can filter the list
by removing tasks performed on child objects and by using keywords to search for tasks.

If you are logged in to a vCenter Server system that is part of a Connected Group, a column in the task list
displays the name of the vCenter Server system on which the task was performed.

Prerequisites

Procedure

1 Navigate to an object in the inventory.
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2 Click the Monitor tab, then click Tasks.

The task list contains tasks performed on the object and detailed information, such as target, task status,
initiator, and start/completion time of the task.

3 (Optional) To view related events for a task, select the task in the list.

Managing Tasks

132

Tasks represent system activities that do not complete immediately, such as migrating a virtual machine. They
are initiated by high-level activities that you perform with the vSphere Client in real time and activities that
you schedule to occur at a later time or on a recurring basis.

For example, powering off a virtual machine is a task. You can perform this task manually every evening, or
you can set up a scheduled task to power off the virtual machine every evening for you.

Note The functionality available in the vSphere Client depends on whether the vSphere Client is connected
to a vCenter Server system or an ESXi host. Unless indicated, the process, task, or description applies to both
kinds of vSphere Client connections. When the vSphere Client is connected to an ESXihost, the Tasks option
is not available; however, you can view recent tasks in the Status Bar at the bottom of the vSphere Client.

Viewing Tasks

You can view tasks that are associated with a single object or all objects in the vSphere Client inventory. The
Tasks & Events tab lists completed tasks and tasks that are currently running.

By default, the tasks list for an object also includes tasks performed on its child objects. You can filter the list
by removing tasks performed on child objects and by using keywords to search for tasks.

If you are logged in to a vCenter Server system that is part of a Connected Group, a column in the task list
displays the name of the vCenter Server system on which the task was performed.

View All Tasks

You view completed tasks and running tasks on the vSphere Client Tasks & Events tab.

Procedure

1  Display the object in the inventory.

2 Display the tasks for a single object or the entire vCenter Server.

B To display the tasks for an object, select the object.
B To display the tasks in the vCenter Server, select the root folder.

3 Click the Tasks & Events tab.

The task list contains tasks performed on the object and its children.

4  (Optional) To view detailed information for a task, select the task in the list.
The Task Details pane displays details such as task status, any error messages in the error stack, and any
related events.

View Recent Tasks

You view recent tasks for vCenter Server or an ESXi host in the vSphere Client Recent Tasks pane.

Procedure
1  Display the Inventory panel.

2 Select the object.
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3 If necessary, select View > Status to display the status bar at the bottom of the vSphere Client.
4 In the status bar, Click Tasks.

The list of completed tasks appears in the Recent Tasks pane of the Status Bar.

View Scheduled Tasks

You view scheduled tasks in the vSphere Client Scheduled Tasks pane. The scheduled task list includes tasks
that are scheduled to run and those that have already run.

Procedure

¢ In the navigation bar, select Home > Management > Scheduled Tasks.

Filter Tasks for a Host or Datacenter

Filtering the task list removes tasks performed on child objects.

Procedure
1 Select the host or datacenter in the inventory and click the Tasks & Events tab.
2 In View, click Tasks to display the tasks list.

3 If the Show all entries list and the search field are not displayed under the Tasks and Events buttons,
select View > Filtering,.

4  Click Show all entries and select Show host entries or Show datacenter entries, depending on the object
selected.
Use Keywords to Filter the Tasks List

You can filter the tasks list based on any task attribute, including task name, target, status, initiator, change
history, and time. Filtering is inclusive, not exclusive. If the keyword is found in any of the selected columns,
the task is included in the filtered list.

Procedure

1  Display the object in the inventory.

Select the object and click the Tasks & Events tab.

If the Name, Target or Status contains search field is not displayed, select View > Filtering.

Click the search field arrow and select the attributes to include in the search.

62 B O N S

Type a keyword into the box and press Enter.

Cancel a Task

Canceling a task stops a running task from occurring. Canceling a scheduled task does not cancel subsequent
runs. To cancel a scheduled task that has not run, reschedule it.

NoTe You can only cancel a subset of tasks by using the vSphere Client.

Required privileges:
B Manual tasks: Tasks.Update Task
B Scheduled tasks:Scheduled Task.Remove Task

B Appropriate permissions on the host where the task is running
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Prerequisites

To cancel a task, the vSphere Client must be connected to a vCenter Server system.

Procedure
1  Locate the task in the Recent Tasks pane of the Status Bar.

By default, the Status Baris displayed at the bottom of the vSphere Client. If it is not visible, select View
> Status Bar.

2 Right-click the appropriate task and select Cancel.
If the cancel option is unavailable, the selected task cannot be canceled.

The vCenter Server system or ESXi host stops the progress of the task and returns the object to its previous
state. The vSphere Client displays the task with a Canceled status.

Policy Rules for Task Operations

The vCenter Server and ESXi hosts adhere to certain rules when managing tasks in the system.
vCenter Server and ESXi hosts use the following rules to process tasks:

B The user performing the task in the vSphere Client must have the correct permissions on the relevant
objects. After a scheduled task is created, it will be performed even if the user no longer has permission
to perform the task.

B When the operations required by manual tasks and scheduled tasks conflict, the activity due first is started
first.

B When a virtual machine or host is in an incorrect state to perform any activity, manual or scheduled,
vCenter Server or the ESXi host does not perform the task. A message is recorded in the log.

B When an object is removed from the vCenter Server or the ESXi host, all associated tasks are also removed.

B The vSphere Client and vCenter Server system use UTC time to determine the start time of a scheduled
task. This ensures vSphere Client users in different time zones see the task scheduled to run at their local
time.

Events are logged in the event log at start and completion of a task. Any errors that occur during a task are
also recorded in the event log.

A

CautioN Do not schedule multiple tasks to be performed at the same time on the same object. The results are
unpredictable.

Schedule Tasks
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You can schedule tasks to run once in the future or multiple times, at a recurring interval.

To schedule tasks in the vSphere Client, it must be connected to a vCenter Server system to create and manage
scheduled tasks.

The tasks you can schedule are listed in the following table.

Table 9-1. Scheduled Tasks

Scheduled Task Description

Add a host Adds the host to the specified datacenter or cluster.

Change the power state of a virtual machine Powers on, powers off, suspends, or resets the state of the virtual machine.

Change cluster power settings Enable or disable DPM for hosts in a cluster.
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Table 9-1. Scheduled Tasks (Continued)

Scheduled Task Description

Change resource settings of a resource pool ~ Changes the following resource settings:
or virtual machine B CPU - Shares, Reservation, Limit.

B Memory — Shares, Reservation, Limit.

Check compliance of a profile Checks that a host's configuration matches the configuration specified in a
host profile.

Clone a virtual machine Makes a clone of the virtual machine and places it on the specified host or
cluster.

Create a virtual machine Creates a new virtual machine on the specified host.

Deploy a virtual machine Creates a new virtual machine from a template on the specified host or
cluster.

Migrate a virtual machine Migrate a virtual machine to the specified host or datastore by using

migration or migration with vMotion.

Make a snapshot of a virtual machine Captures the entire state of the virtual machine at the time the snapshot is
taken.
Scan for Updates Scans templates, virtual machines, and hosts for available updates.

This task is available only when vSphere Update Manager is installed.

Remediate Downloads any new patches discovered during the scan operation and
applies the newly configured settings.

This task is available only when vSphere Update Manager is installed.

You create scheduled tasks by using the Scheduled Task wizard. For some scheduled tasks, this wizard opens
the wizard used specifically for that task. For example, if you create a scheduled task that migrates a virtual
machine, the Scheduled Task wizard opens the Migrate Virtual Machine wizard, which you use to set up the
migration details.

Scheduling one task to run on multiple objects is not possible. For example, you cannot create one scheduled
task on a host that powers on all virtual machines on that host. You must create a separate scheduled task for
each virtual machine.

After a scheduled task runs, you can reschedule it to run again at another time.

Create a Scheduled Task
To schedule a task, use the Scheduled Task wizard.
Required privilege: Schedule Task.Create Tasks

You can schedule a limited number of tasks by using the vSphere Client. If the task to schedule is not available,
use the vSphere APL. See the vSphere SDK Programming Guide.

Q CautioN Do not schedule multiple tasks to be performed at the same time on the same object. The results are
unpredictable.

Prerequisites
The vSphere Client must be connected to a vCenter Server system to schedule tasks.
Procedure
1 Inthe navigation bar, click Home > Management > Scheduled Tasks.
The current list of scheduled tasks appears.

2 In the toolbar, click New.
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In the Select a Task to Schedule dialog box, select a task and click OK to open the wizard for that task.

Note For some scheduled tasks, the wizard opens the wizard used specifically for that task. For example,
to migrate a virtual machine, the Scheduled Task wizard opens the Migrate Virtual Machine Wizard,
which you use to set up the migration details.

Complete the wizard that opens for the task.

Click OK to open the Scheduled Task wizard.

Enter a task name and task description and click Next.
Select a Frequency and specify a Start Time.

You can schedule a task to run only once during a day. To set up a task to run multiple times in one day,
set up additional scheduled tasks.

Table 9-2. Scheduled Task Frequency Options

Frequency Action

Once B To run the scheduled task immediately, select Now and click Next.

To run the scheduled task at a later time and date, select Later and enter a Time. Click the
Date arrow to display the calendar and click a date.

After Startup ®  In Delay, enter the number of minutes to delay the task.

Hourly 1 In Start Time, enter the number of minutes after the hour to run the task.
2 In Interval, enter the number of hours after which to run the task.
For example, to start a task at the half-hour mark of every 5th hour, enter 30 and 5.

Daily ®  Enter the Start Time and Interval.
For example, to run the task at 2:30 pm every four days, enter 2:30 and 4.

Weekly 1  Enter the Interval and Start Time.
2 Select each day on which to run the task.
For example, to run the task at 6 am every Tuesday and Thursday, enter 1 and 6 am, and select
Tuesday and Thursday.

Monthly 1 Enter the Start Time.
2 Specify the days by using one of the following methods.
W Enter a specific date of the month.
W Select first, second, third, fourth, or last, and select the day of the week.

last runs the task on the last week in the month that the day occurs. For example, if
you select the last Monday of the month and the month ends on a Sunday, the task
runs six days before the end of the month.

3 InInterval, enter the number of months between each task run.

Click Next.

Set up email notifications and click Next.

10 Click Finish.

The vCenter Server system adds the task to the list in the Scheduled Tasks window.
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Create a Scheduled Task in the vSphere Web Client

You can create scheduled tasks for operations that you want to automatically run once or at a recurring interval.

You can create a scheduled task for a limited number of operations by using the vSphere Web Client. If the
task to schedule is not available, use the vSphere API. See the vSphere SDK Programming Guide.

Q CautioN Do not schedule multiple tasks simultaneously on the same object. The results are unpredictable.

Prerequisites

Required privilege: Schedule Task.Create tasks

Procedure

1  In the vSphere Web Client, navigate to the object for which you want to schedule a task.
2 Select Manage, and select Scheduled Tasks.

3 From the Schedule New Task drop-down list, select the task to schedule.

A wizard opens for the task with (scheduled) appended next to itsname. The wizard contains a Scheduling
options page, where you configure the scheduling options for the task. For example, to schedule taking
a virtual machine snapshot, the Take a VM Snapshot wizard (scheduled) opens. In Edit settings, you enter
the properties for the snapshot, and in Scheduling options,you configure the scheduling options for the
task.
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4  Inthe Scheduling options page, configure the required settings for the task.

a Type aname and a description for the task.

b  To configure the scheduling settings for the task, click Change next to Configured Scheduler.

Table 9-3. Scheduler options

Option

Description

Run this action now

Runs the scheduled task immediately.

Run this action after startup

Runs the task after a certain number of minutes.

Schedule this action to run later

Runs the scheduled task at a date and time that you specify.

Setup a recurring schedule for this action

Runs the scheduled task on a recurring pattern.

Hourly 1 Type the number of hours after which to run the task.
2 Type the number of minutes after the hour to run the task.
For example, to start a task at the half-hour mark of every fifth hour,
type 5 hours and 30 minutes.
Daily 1 Type the number of days on which to run the task.
2 Type the start time for the task.
For example, to run the task at 2:30 pm every four days, type 4 and
2:30.
Weekly 1 Type the number of weeks on which the task must run.
2 Select the day of the week you want the task to run.
3 Type the start time for the task.
For example, to run the task at 6 am every Tuesday and Thursday,
type 1 week, 6 am, and select Tuesday and Thursday.
Monthly 1 Type the start time for the task.

2 Select the days by using one of the following methods.
B Type a specific day of the month and the number of months
to run the task on. For example, the tenth day every five
months.

W Select first, second, third, fourth, or last, and select the day
of the week and the number of months to run the task on.

last runs the task on the last week in the month that the day
occurs. For example, if you select the last Monday of the
month and the month ends on a Sunday, the task runs six
days before the end of the month.

¢ Setup email notifications and click OK.

Canceling Scheduled Tasks

Canceling a task stops a running task from occurring, regardless of whether the task was a real-time task or a
scheduled task. The operation cancels only the running task. If the task being canceled is a scheduled task,

subsequent runs are not canceled.

Tasks that aren’t running can be cleared when they are in a queued or scheduled state. In such cases, because

the cancel operation is not available, either remove the task or reschedule it to run at a different time. Removing

a scheduled task requires that you recreate it to run it in the future, rescheduling does not.

You can cancel the following tasks:
B Connecting to a host
B Cloning a virtual machine

B  Deploying a virtual machine
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B Migrating a powered off virtual machine. This task is cancelable only when the source disks have not been
deleted.

If your vSphere environment uses virtual services, you can also cancel the following scheduled tasks:
B Change the power state of a virtual machine

B Make a snapshot of a virtual machine

Change or Reschedule a Task

After a scheduled task is created, you can change the timing, frequency, and specifics of the task. You can edit
and reschedule tasks before or after they run.

Required privilege:Schedule Task.Modify Task

Procedure

1 In the vSphere Client navigation bar, click Home > Management > Scheduled Tasks.
Select the task.

In the toolbar, click Properties.

Change task attributes as necessary.

Click Next to advance through the wizard.

N G k= W DN

Click Finish.

Change or Reschedule a Task in the vSphere Web Client

After a scheduled task is created, you can change the schedule, frequency, and other attributes of the task. You
can edit and reschedule tasks before or after they run.

Prerequisites

Required privilege:Schedule Task.Modify

Procedure

1  In the vSphere Web Client, navigate to the object for which you want to edit a scheduled task.

To view all scheduled tasks for a vCenter Server instance, navigate to that vCenter Server instance.
Select Manage > Scheduled Tasks.

Right-click the task and select Edit.

Change the task attributes as necessary.

(62 B O N S

Click OK.

Remove a Scheduled Task

Removing a scheduled task removes all future occurrences of the task. The history associated with all
completed occurrences of the task remains in the vCenter Server database.

Prerequisites

To remove scheduled tasks, the vSphere Client must be connected to the vCenter Server system.
Required privilege:Scheduled Task.Remove Task

Procedure

1 Inthe vSphere Client navigation bar, click Home > Management > Scheduled Tasks.
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Select the task.
Select Inventory > Scheduled Task > Remove.

Click OK.

The task is removed from the list of scheduled tasks.

Remove a Scheduled Task in the vSphere Web Client

Removing a scheduled task removes all future occurrences of the task. The history associated with all

completed occurrences of the task remains in the vCenter Server database.

Prerequisites

Required privilege:Scheduled task.Remove

Procedure

1

In the vSphere Web Client, navigate to the object for which you want to remove a scheduled task.
To view all scheduled tasks for a vCenter Server instance, navigate to that vCenter Server instance.
Select Manage > Scheduled Tasks.

Right-click the task to remove and select Remove.

Report Errors to VMware

Some errors that appear for tasks, events, and in error dialogs can be submitted to VMware for further

investigation. In some cases, more information or links to knowledge base articles are provided.

Perform this task in the vSphere Client, within an error dialog, Task Details, or Event Details

Procedure

1

140

Click Submit error report to send the error report.

The Submit Error Report window displays details about the specific error.
(Optional) Click the printer icon to print the error log report.

(Optional) Click the disk icon to save the error log report.

The error log report can be saved as an HTML file. If you are working offlline, this allows you to use the
HTML file to submit the error report to VMware at a later time.

Click Submit.

The data is sent to VMware for analysis. Additionally, the data is compared to entries in the VMware
Knowledge Base and, if matches are found, the relevant articles are displayed.
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Starting and Stopping the vSphere
Components

You can start and stop each one of the major vSphere components, ESXi, and vCenter Server. You might want
to stop a component to perform maintenance or upgrade operations.

This chapter includes the following topics:

B “Start an ESXi Host,” on page 141

B “Reboot or Shut Down an ESXi Host,” on page 141

B “Reboot or Shut Down an ESXi Host in the vSphere Web Client,” on page 142

B “Starting vCenter Server,” on page 142

Start an ESXi Host

When you install ESXi, it starts itself through the installation reboot process. If your ESXi host is shut down,
you must manually restart it.

Procedure

€ On the physical box where ESXi is installed, press the power button until the power on sequence begins.

The ESXi host starts, locates its virtual machines, and proceeds with its normal ESXi functions.

Reboot or Shut Down an ESXi Host

You can power off or restart (reboot) any ESXi host using the vSphere Client. Powering off a managed host
disconnects it from vCenter Server, but does not remove it from the inventory.

Procedure
1 Shut down all virtual machines running on the ESXi host.
2 Select the ESXi host you want to shut down.
3 From the main or right-click menu, select Reboot or Shut Down.
B [f you select Reboot, the ESXi host shuts down and reboots.
B [f you select Shut Down, the ESXi host shuts down. You must manually power the system back on.
4  Provide a reason for the shut down.

This information is added to the log.
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Reboot or Shut Down an ESXi Host in the vSphere Web Client

You can power off or restart any ESXi host by using the vSphere Web Client. Powering off a managed host
disconnects it from vCenter Server, but does not remove it from the inventory.

Prerequisites
Required privileges:
B Host.Configuration.Maintenance

B Global.Log event

Procedure
1 Inthe vSphere Web Client, navigate to the host that you want to shut down.
2 Power of all virtual machines on the host.
3 Right-click the host and select Reboot or Shutdown.
B [f you select Reboot, the ESXi host shuts down and starts.
B [f you select Shut Down, the ESXi host shuts down. You must manually power the system back on.
4  Provide a reason for the shut down.

This information is added to the log.

Starting vCenter Server

142

vCenter Server runs as a Windows service. vCenter Server starts when you start the Windows machine on
which it is installed. It also restarts when that machine is rebooted.

Verify That vCenter Server Is Running

You can verify that the vCenter Server service is running.

Procedure
1  Go to the Services console for your version of Windows.

For example, select Control Panel > Administrative Tools > Services and click VMware VirtualCenter
Server.

The Status column indicates whether the service started.
2 Right-click the vCenter Server service and select Properties.

3 Inthe VMware vCenter Server Services Properties dialog box, click the General tab and view the service
status.

Restart the vCenter Server System

The vCenter Server service starts when the machine on which it is installed is booted. You can manually restart
the vCenter Server system.

Procedure
1 Go to the Services console for your version of Windows.

For example, select Control Panel > Administrative Tools > Services and click VMware vCenter
Server.
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2 Right-click VMware vCenter Server, select Start, and wait for startup to complete.

3  Close the Properties dialog box.

Stop the vCenter Server System
vCenter Server is a Windows service. You can use the Windows interface to select the service and stop it.

You should not have to stop the vCenter Server service. The vCenter Server should operate without
interruption. Continuous operation ensures that all monitoring and task activities are performed as expected.

Procedure
1  Go to the Services console for your version of Windows.
For example, select Start > Control Panel > AdministrativeTools > Services.
2 Click VMware vCenter Server Service.
3 Right-click VMware vCenter Server, select Stop, and wait for it to stop.

4  Close the Properties dialog box.
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Managing Hosts in vCenter Server

To access the full capabilities of your hosts and to simplify the management of multiple hosts, you should
connect your hosts to a vCenter Server system.

For information about configuration management of ESXihosts, see the vSphere Networking documentation, the
vSphere Storage documentation, or the vSphere Security documentation.

The views and capabilities displayed vary depending on whether the vSphere Client is connected to a
vCenter Server system or an ESXi host. Unless indicated, the process, task, or description applies to all kinds
of vSphere Client connections.

See “Add Hosts,” on page 84, “Add a Host in the vSphere Web Client,” on page 85, and “Add a Host to a DRS
Cluster in the vSphere Web Client,” on page 86 for information and instructions about adding hosts to
vCenter Server.

This chapter includes the following topics:

B “Disconnecting and Reconnecting a Host,” on page 145

B “Remove a Host from a Cluster,” on page 147

B “Remove a Host from a Cluster in the vSphere Web Client,” on page 148
B “Understanding Managed Host Removal,” on page 148

B “Remove a Managed Host from vCenter Server,” on page 149

B “Remove a Managed Host from vCenter Server in the vSphere Web Client,” on page 150

Disconnecting and Reconnecting a Host

You can disconnect and reconnect a host that a vCenter Server system manages. Disconnecting a managed
host does not remove it from vCenter Server; it temporarily suspends all monitoring activities that
vCenter Server performs.

The managed host and its associated virtual machines remain in the vCenter Server inventory. By contrast,
removing a managed host from vCenter Server removes the managed host and all its associated virtual
machines from the vCenter Server inventory.

Disconnect a Managed Host

Use the vSphere Client to disconnect a managed host from vCenter Server.

Procedure

1  From the vSphere Client connected to a vCenter Server system, display the inventory and click the
managed host to disconnect.
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2 Right-click the host and select Disconnect from the pop-up menu.
3 In the confirmation dialog box that appears, click Yes.

If the managed host is disconnected, the word “disconnected” is appended to the object name in
parentheses, and the object is dimmed. All associated virtual machines are similarly dimmed and labeled.

Disconnect a Managed Host in the vSphere Web Client

Disconnect a managed host to temporarily suspend all vCenter Server monitoring and management activities.

Disconnecting a managed host does not remove it from the vCenter Server inventory. The managed host and
its associated virtual machines remain in the vCenter Server inventory. Removing a managed host removes
the managed host and all its associated virtual machines from the vCenter Server inventory.

Prerequisites

Required privilege: Host.Configuration.Connection

Procedure

1  In the vSphere Web Client, navigate to the host in the vSphere inventory.
2 Right-click the host and select Disconnect.

3 In the confirmation dialog box that appears, click Yes.

If the managed host disconnects successfully, the disconnected designation is appended to the object name in
parentheses, and the object is dimmed. All associated virtual machines are similarly dimmed and labeled.

Reconnect a Managed Host

Use the vSphere Client to reconnect a managed host to a vCenter Server system.

Procedure

1  From the vSphere Client connected to a vCenter Server system, display the inventory and click the
managed host to reconnect.

2 Right-click the host and select Connect from the pop-up menu.

When the managed host’s connection status to vCenter Server is changed, the statuses of the virtual
machines on that managed host are updated to reflect the change.

Reconnect a Managed Host in the vSphere Web Client

A host that a vCenter Server system manages might disconnect from vCenter Server because of network
problems or other reasons. If this happens, you can reconnect the host.

Prerequisites
Required privilege: Host.Configuration.Connection
Procedure

1  In the vSphere Web Client, navigate to the disconnected host.
2 Right-click the host and select Connect.

When the host reconnects to vCenter Server, the statuses of the virtual machines on that host are updated to
reflect the change.

When the managed host is connected, the disconnected designation is removed and the object name is
displayed in bold. All associated virtual machines are similarly labeled.
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Reconnecting Hosts After Changes to the vCenter Server SSL Certificate

vCenter Server uses an SSL certificate to encrypt and decrypt host passwords stored in the vCenter Server
database. If the certificate is replaced or changed, vCenter Server cannot decrypt host passwords, and therefore
cannot connect to managed hosts.

If vCenter Server fails to decrypt a host password, the host is disconnected from vCenter Server. You must
reconnect the host and supply the login credentials, which will be encrypted and stored in the database using
the new certificate.

Remove a Host from a Cluster

When a host is removed from a cluster, the resources it provides are deducted from the total cluster resources.
The virtual machines deployed on the host are either migrated to other hosts within the cluster, or remain with
the host and are removed from the cluster, depending on the state of the virtual machines when the host is
removed from the cluster.

You can remove hosts from a cluster by selecting them in the inventory and dragging them to a new location
within the inventory. The new location can be a folder as a standalone host or another cluster.

Prerequisites

Before you can remove a host from a cluster, you must power off all virtual machines that are running on the
host, or migrate the virtual machines to a new host using vMotion.

Procedure
1 From the vSphere Client connected to a vCenter Server system, display the inventory.

2 Right-click the appropriate managed host icon in the inventory panel, and select Enter Maintenance
Mode from the pop-up menu.

If all virtual machines on the host are not powered off, the host will not enter maintenance mode.

If the host is inside a DRS-enabled cluster, entering maintenance mode causes DRS to attempt to
automatically evacuate powered-on virtual machines from the host using vMotion.

3 In the confirmation dialog that appears, clickYes.

The confirmation dialog also asks if you want to automatically evacuate virtual machines that are not
powered on from the host. This is useful if you want those virtual machines to remain registered to a host
within the cluster.

The host icon changes and the term “maintenance mode” is added to the name in parentheses.
4  Select the host icon in the inventory panel, and drag it to the new location.

The host can be moved to another cluster or another datacenter. When the new location is selected, a blue
box surrounds the cluster or datacenter name.

vCenter Server moves the host to the new location.
5 Right-click the host, and select Exit Maintenance Mode from the pop-up menu.

6  (Optional) Restart any virtual machines, as needed.
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Remove a Host from a Cluster in the vSphere Web Client

When you remove a host from a cluster, its resources are deducted from the total resources of the cluster. The
state of the virtual machines deployed on the host determines whether they are migrated to other hosts within
the cluster, or remain on the host and are removed from the cluster.

Prerequisites

Verify that all virtual machines on the host are powered off, or migrate the running virtual machines to a new
host by using vMotion.

Required privileges:
B Host.Inventory.Remove host
B Host.Inventory.Move host

B Host.Inventory.Maintain

Procedure
1  In the vSphere Web Client, navigate to the host that you want to remove from a cluster.
2 Right-click the host and select Enter Maintenance Mode.
All virtual machines on the host must be powered off so that the host can enter maintenance mode.

If the host is inside a DRS-enabled cluster, DRS attempts to automatically migrate powered-on virtual
machines from the host by using vMotion.

3 In the confirmation dialog box that appears, click Yes.
When the task for entering maintenance mode completes, the icon beside the host name changes.
4  Right-click the host and select Move To.
5  Select a datacenter, folder, or another cluster to move the host to.
vCenter Server moves the host to the new location.
6  Right-click the host and select Exit Maintenance Mode.

7  (Optional) Power on virtual machines on the host.

Understanding Managed Host Removal

148

Removing a managed host from vCenter Server breaks the connection and stops all monitoring and managing
functions of that managed host and of all the virtual machines on that managed host. The managed host and
its associated virtual machines are removed from the inventory.

Historical data for removed hosts remains in the vCenter Server database.

Removing a managed host differs from disconnecting the managed host from vCenter Server. Disconnecting
amanaged host does not remove it from vCenter Server; it temporarily suspends all vCenter Server monitoring
activities. The managed host and its associated virtual machines remain in the vCenter Server inventory.

Removing a managed host from vCenter Server does not remove the virtual machines from the managed host
or datastore. It removes only vCenter Server’s access to the managed host and virtual machines on that
managed host.

Figure 11-1 illustrates the process for removing a managed host from vCenter Server. In the example here,
notice the lost link between vCenter Server and the removed managed host, while the managed host files
remain on the datastore.
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Remove a managed host from vCenter Server to stop all vCenter Server monitoring and management of that

host.

If possible, remove managed hosts while they are connected. Removing a disconnected managed host does

not remove the vCenter Server agent from the managed host.

Prerequisites

Make sure NFS mounts are active. If NFS mounts are unresponsive, the operation fails.

Procedure

1 From the vSphere Client connected to a vCenter Server system, display the inventory.

2 (Optional) If the host is part of a cluster, you must put it in maintenance mode.

a  Right-click the managed host in the inventory and select Enter Maintenance Mode from the pop-up

menu.

b On the confirmation dialog, click Yes.

The host icon changes and the term “maintenance mode” is added to the name in parentheses.

3 Right-click the appropriate host in the inventory panel, and select Remove from the pop-up menu.

4 In the confirmation dialog that appears, click Yes to remove the managed host.

vCenter Server removes the managed host and associated virtual machines from the vCenter Server
environment. vCenter Server then returns the status of all associated processor and migration licenses to

available.
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You can remove a managed host from vCenter Server to stop vCenter Server from monitoring and managing
that host.

If possible, remove managed hosts while they are connected. Removing a disconnected managed host does
not remove the vCenter Server agent from the managed host.

Prerequisites
Verify that NFS mounts are active. If NFS mounts are unresponsive, the operation fails.

Required privilege: Host.Configuration.Maintenance

Procedure
1  In the vSphere Web Client client, navigate to the host in the vSphere inventory.
2 (Optional) If the host is part of a cluster, you must put it in maintenance mode.
a  Right-click the managed host and select Enter Maintenance Mode.
All virtual machines on the host must be powered off so that the host can enter maintenance mode.

If the host is inside a DRS-enabled cluster, DRS attempts to automatically evacuate powered-on virtual
machines from the host by using vMotion.

b  Inthe confirmation dialog box, click Yes.
The host icon changes and a maintenance mode designation is appended to the name in parentheses.
3 Right-click the host and select All vCenter Actions > Remove from Inventory.
4 In the confirmation dialog box that appears, click Yes to remove the managed host.

vCenter Server removes the managed host and its virtual machines from the inventory. vCenter Server then
frees the amount of license capacity that was allocated for the host. The host retains its assigned license key.
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Migrating Virtual Machines in the
vSphere Web Client

You can move virtual machines from one host or storage location to another location using hot or cold
migration. For example, with vMotion you can move turned on virtual machines away from a host to perform
maintenance, to balance loads, to collocate virtual machines that communicate with each other, to move virtual
machines apart to minimize fault domain, to migrate to new server hardware, and so on.

You can use cold or hot migration to move virtual machines to different hosts or datastores.

Cold Migration You can move a turned-off or suspended virtual machine to a new host.
Optionally, you can relocate configuration and disk files for turned off or
suspended virtual machines to new storage locations. You can also use cold
migration to move virtual machines from one datacenter to another. To
perform a cold migration, you can move virtual machines manually or set up
a scheduled task.

Hot Migration Depending on the type of migration you are using, vMotion, Storage vMotion,
or cross-host Storage vMotion, you can move a turned on virtual machine to a
different host, or move its disks or folder to a different datastore without any
interruption in the availability of the virtual machine. vMotion is also referred
to as "live migration" or "hot migration."

You cannot move a turned on virtual machine from one datacenter to another.

Note Copying a virtual machine creates a new virtual machine. It is not a form of migration. Cloning a virtual
machine or copying its disks and configuration file creates a new virtual machine. Cloning is not a form of
migration.

In vCenter Server, you have the following migration options:

Change Host Moving a virtual machine, but not its storage to another host. You can move
the virtual machine using cold migration or hot migration. You use vMotion
to move a turned-on virtual machine to another host.

Change Datastore Moving a virtual machine and its storage, including virtual disks and
configuration files or a combination of these, to a new datastore on the same
host. You can change the datastore using cold or hot migration. You use Storage
Migration to move a turned-on virtual machine and its storage to a new

datastore.
Change Host and Moving a virtual machine to another host and moving its disk or virtual
Datastore machine folder to another datastore. You can change the host and datastore

using cold or hot migration. Hot migration is a combination of Storage vMotion
and vMotion called cross-host Storage vMotion.

VMware, Inc. 151



vCenter Server and Host Management

Cold

This chapter includes the following topics:

B “Cold Migration in the vSphere Web Client,” on page 152

B “Migration with vMotion,” on page 152

B “Migration with Storage vMotion,” on page 155

B “Migration with Cross-Host Storage vMotion,” on page 156

B “CPU Compatibility and EVC,” on page 157

B “Migrate a Powered-Off or Suspended Virtual Machine in the vSphere Web Client,” on page 165
B “Migrate a Powered-On Virtual Machine with vMotion in the vSphere Web Client,” on page 166
B “Migrate a Virtual Machine with Storage vMotion in the vSphere Web Client,” on page 167

B “Migrate a Virtual Machine with Cross-Host Storage vMotion in the vSphere Web Client,” on
page 168

B “Limits on Simultaneous Migrations in the vSphere Web Client,” on page 170

Migration in the vSphere Web Client

Cold migration is the migration of turned-off or suspended virtual machines. With cold migration, you can
move the associated disks from one datastore to another. The virtual machines are not required to be on shared
storage. You can also use cold migration to move virtual machines from one datacenter to another.

You must turn off or suspend the virtual machines to migrate before you begin the cold migration process.
Migrating a suspended virtual machine is considered a cold migration because although the virtual machine
is turned on, it is not running.

If the virtual machine is turned off and configured with a 64-bit guest operating system, vCenter Server
generates a warning if you try to migrate it to a host that does not support 64-bit operating systems. Otherwise,
CPU compatibility checks do not apply when you migrate turned off virtual machines with cold migration.

When you migrate a suspended virtual machine, the new host for the virtual machine must meet CPU
compatibility requirements, because the virtual machine must be able to resume executing instructions on the
new host.

A cold migration consists of the following tasks:

1  Ifyou select the option to move to a different datastore, the configuration files, including the NVRAM file
(BIOS settings), log files, and the suspend file, are moved from the source host to the destination host’s
associated storage area. You can chose to move the virtual machine's disks, as well.

2 The virtual machine is registered with the new host.

3 After the migration is completed, the old version of the virtual machine is deleted from the source host if
you selected the option to move to a different datastore.

Migration with vMotion

152

If you need to take a host offline for maintenance, you can move the virtual machine to another host. Migration
with vMotion™ allows virtual machine working processes to continue throughout a migration.

The entire state of the virtual machine is moved to the new host, while the associated virtual disk remains in
the same location on storage that is shared between the two hosts. After the virtual machine state is migrated
to the alternate host, the virtual machine runs on the new host. Migrations with vMotion are completely
transparent to the running virtual machine.
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The state information includes the current memory content and all the information that defines and identifies
the virtual machine. The memory content includes transaction data and whatever bits of the operating system
and applications are in the memory. The defining and identification information stored in the state includes
all the data that maps to the virtual machine hardware elements, such as BIOS, devices, CPU, MAC addresses
for the Ethernet cards, chip set states, registers, and so forth.

When you migrate a virtual machine with vMotion, the new host for the virtual machine must meet
compatibility requirements in order for the migration to proceed.

Migration with vMotion occurs in three stages:

1  When the migration with vMotion is requested, vCenter Server verifies that the existing virtual machine
is in a stable state with its current host.

2 The virtual machine state information (memory, registers, and network connections) is copied to the target
host.

3 The virtual machine resumes its activities on the new host.

If errors occurs during migration, the virtual machines revert to their original states and locations.

Host Configuration for vMotion
In order to successfully use vMotion, you must first configure your hosts correctly.
Ensure that you have correctly configured your hosts in each of the following areas:
B Each host must be correctly licensed for vMotion.
B Each host must meet shared storage requirements for vMotion.

B Each host must meet the networking requirements for vMotion.

ImporTANT The ESXi firewall in ESXi 5.0 and later does not allow per-network filtering of vMotion traffic.
Therefore, you must install rules on your external firewall to ensure that no incoming connections can be
made to the vMotion socket.

vMotion Shared Storage Requirements

Configure hosts for vMotion with shared storage to ensure that virtual machines are accessible to both source
and target hosts.

During a migration with vMotion, the migrating virtual machine must be on storage accessible to both the
source and target hosts. Ensure that the hosts configured for vMotion use shared storage. Shared storage can
be on a Fibre Channel storage area network (SAN), or can be implemented using iSCSI and NAS.

If you use vMotion to migrate virtual machines with raw device mapping (RDM) files, make sure to maintain
consistent LUN IDs for RDMs across all participating hosts.

See the vSphere Storage documentation for information on SANs and RDMs.

vSphere vMotion Networking Requirements
Migration with vMotion requires correctly configured network interfaces on source and target hosts.

Configure each host with at least one vMotion network interface. To ensure secure data transfer, the vMotion
network must be a secure network, accessible only to trusted parties. Because vMotion performance improves
significantly with additional bandwidth, dedicate at minimum a physical 1 Gigabit Ethernet (GigE) NIC to
vMotion. As a best practice, provision at least one additional physical NIC as a failover NIC.

To determine the maximum number of concurrent vMotions possible, see the Concurrent migration limits at
“Limits on Simultaneous Migrations in the vSphere Web Client,” on page 170. These limits vary with a host's
link speed to the vMotion network.
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Some configurations include Metro vMotion, which is a feature that enables reliable migrations between hosts
that are separated by high network round-trip latency times. Metro vMotion is enabled when the appropriate
license is installed. No user configuration is necessary.

You can configure multiple NICs for vMotion by adding two or more NICs to the required standard switch.
For details, see the VMware knowledge base article at http://kb.vmware.com/kb/2007467.

Recommended networking best practices are as follows:
B Use one dedicated GigE adapter for vMotion.
B [f only two Ethernet adapters are available:

B For best security, dedicate the GigE adapter to vMotion, and use VLANSs to divide the virtual machine
and management traffic on the other adapter.

B For best availability, combine both adapters into a bond, and use VLANSs to divide traffic into
networks: one or more for virtual machine traffic and one for vMotion.

Configure the virtual networks on vMotion enabled hosts as follows:
B On each host, configure a VMkernel port group for vMotion.
B Ensure that virtual machines have access to the same subnets on source and destination hosts.

B [fyou are using standard switches for networking, ensure that the network labels used for virtual machine
port groups are consistent across hosts. During a migration with vMotion, vCenter Server assigns virtual
machines to port groups based on matching network labels.

Note You cannot migrate virtual machines that are attached to a virtual intranet with vMotion, even if
the destination host has a virtual intranet configured with the same network label.

B  [f you are using vSphere Distributed Switches for networking, ensure that source and destination hosts
are members of all vSphere Distributed Switches that virtual machines use for networking.

B Use of Jumbo Frames is recommended for best vMotion performance.

Virtual Machine Conditions and Limitations for vMotion in the vSphere Web Client

To successfully migrate virtual machines with vMotion, the virtual machine must meet certain network, disk,
CPU, USB, and other device requirements.

The following virtual machine conditions and limitations apply:

B The source and destination management network IP address families must match. You cannot migrate a
virtual machine from a host that is registered to vCenter Server with an IPv4 address to a host that is
registered with an IPv6 address.

B You cannot use migration with vMotion to migrate virtual machines that use raw disks for clustering.

B [fvirtual CPU performance counters are enabled, you can migrate virtual machines only to hosts that have
compatible CPU performance counters.

B You can migrate virtual machines with USB devices that are connected to a physical USB device on the
host. You must enable the devices for vMotion.

B You cannot use migration with vMotion to migrate a virtual machine that uses a virtual device backed by
a device that is not accessible on the destination host. For example, you cannot migrate a virtual machine
with a CD drive backed by the physical CD drive on the source host. Disconnect these devices before you
migrate the virtual machine.

B You cannot use migration with vMotion to migrate a virtual machine that uses a virtual device backed by
a device on the client computer. Disconnect these devices before you migrate the virtual machine.
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Swap File Location Compatibility

Virtual machine swap file location affects vMotion compatibility in different ways depending on the version
of ESXi running on the virtual machine's host.

You can configure ESX 3.5 or ESXi 3.5 or later hosts to store virtual machine swap files with the virtual machine
configuration file, or on a local swap file datastore specified for that host.

The location of the virtual machine swap file affects vMotion compatibility as follows:

B For migrations between hosts running ESX/ESXi version 3.5 and later, vMotion and migrations of
suspended and powered-off virtual machines are allowed.

B During a migration with vMotion, if the swapfile location specified on the destination host differs from
the swapfile location specified on the source host, the swap file is copied to the new location. This activity
can result in slower migrations with vMotion. If the destination host cannot access the specified swap file
location, it stores the swap file with the virtual machine configuration file.

See the vSphere Resource Management documentation for information about configuring swap file policies.

Migration with Storage vMotion

With Storage vMotion, you can migrate a virtual machine and its disk files from one datastore to another while
the virtual machine is running. With Storage vMotion, you can move virtual machines off of arrays for
maintenance or to upgrade. You also have the flexibility to optimize disks for performance, or to transform
disk types, which you can use to reclaim space.

You can choose to place the virtual machine and all its disks in a single location, or select separate locations
for the virtual machine configuration file and each virtual disk. The virtual machine does not change execution
host during a migration with Storage vMotion.

During a migration with Storage vMotion, you can transform virtual disks from Thick-Provisioned Lazy
Zeroed or Thick-Provisioned Eager Zeroed to Thin-Provisioned or the reverse.

Storage vMotion has several uses in administering virtual infrastructure, including the following examples of
use.

B Storage maintenance and reconfiguration. You can use Storage vMotion to move virtual machines off of
a storage device to allow maintenance or reconfiguration of the storage device without virtual machine
downtime.

B Redistributing storage load. You can use Storage vMotion to manually redistribute virtual machines or
virtual disks to different storage volumes to balance capacity or improve performance.

B You can use Storage vMotion to migrate virtual machines when you upgrade datastores from VMFS2 to
VMEFS5. For information about the two-step upgrade process, see the vSphere Storage documentation.

Storage vMotion Requirements and Limitations

A virtual machine and its host must meet resource and configuration requirements for the virtual machine
disks to be migrated with Storage vMotion.

Storage vMotion is subject to the following requirements and limitations:

B Virtual machine disks must be in persistent mode or be raw device mappings (RDMs). For virtual
compatibility mode RDMs, you can migrate the mapping file or convert to thick-provisioned or thin-
provisioned disks during migration as long as the destination is not an NFS datastore. If you convert the
mapping file, a new virtual disk is created and the contents of the mapped LUN are copied to this disk.
For physical compatibility mode RDMs, you can migrate the mapping file only.

B Migration of virtual machines during VMware Tools installation is not supported.
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B The host on which the virtual machine is running must have a license that includes Storage vMotion.

B ESX/ESXi 3.5 hosts must be licensed and configured for vMotion. ESX/ESXi 4.0 and later hosts do not
require vMotion configuration in order to perform migration with Storage vMotion.

B Thehost on which the virtual machine is running must have access to both the source and target datastores.

B For limits on the number of simultaneous migrations with vMotion and Storage vMotion, see “Limits on
Simultaneous Migrations,” on page 189.

Migration with Cross-Host Storage vMotion
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You can use cross-host storage vMotion to migrate virtual machines to a different host and datastore
simultaneously. In addition, unlike Storage vMotion, which requires a single host to have access to both the
source and destination datastore, you can migrate virtual machines across storage accessibility boundaries.

Cross-host Storage vMotion does not require environments with shared storage. This is useful for performing
cross-cluster migrations, when the target cluster machines might not have access to the source cluster's storage.
Virtual machine working processes continue to run during the migration with cross-host storage vMotion.

You can place the virtual machine and all of its disks in a single location or select separate locations for the
virtual machine configuration file and each virtual disk. In addition, you can change virtual disks from thick-
provisioned to thin-provisioned or from thin-provisioned to thick-provisioned. For virtual compatibility mode
RDMs, you can migrate the mapping file or convert from RDM to VMDK.

Cross-host storage vMotion is useful for virtual infrastructure administration tasks similar to vMotion or
Storage vMotion tasks, such as the following;:

B Host maintenance. You can move virtual machines off of a host to allow maintenance of the host.

B Storage maintenance and reconfiguration. You can move virtual machines off of a storage device to allow
maintenance or reconfiguration of the storage device without virtual machine downtime.

B Redistributing storage load. You can use manually redistribute virtual machines or virtual disks to
different storage volumes to balance capacity or improve performance.

Cross-Host Storage vMotion Requirements and Limitations

A virtual machine and its host must meet resource and configuration requirements for the virtual machine
files and disks to be migrated with cross-host storage vMotion.

Cross-host storage vMotion is subject to the following requirements and limitations:
B The hosts must be licensed for vMotion.
B The hosts must be running ESXi 5.1.

B The hosts must meet the networking requirement for vMotion. See “vSphere vMotion Networking
Requirements,” on page 153.

B The virtual machines must be properly configured for vMotion. See “Virtual Machine Conditions and
Limitations for vMotion in the vSphere Web Client,” on page 154

B Virtual machine disks must be in persistent mode or be raw device mappings (RDMs). See “Storage
vMotion Requirements and Limitations,” on page 155.

B The destination host must have access to the destination storage.

B When you move a virtual machine with RDMs and do not convert those RDMs to VMDKs, the destination
host must have access to the RDM LUN .

B Consider the limits for simultaneous migrations when you perform a cross-host storage vMotion. This
type of vMotion counts against the limits for both vMotion and Storage vMotion, so it consumes both a
network resource and 16 datastore resources. See “Limits on Simultaneous Migrations,” on page 189.
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CPU Compatibility and EVC

vCenter Server performs compatibility checks before it allows migration of running or suspended virtual
machines to ensure that the virtual machine is compatible with the target host.

vMotion transfers the running state of a virtual machine between underlying ESXi systems. Live migration
requires that the processors of the target host provide the same instructions to the virtual machine after
migration that the processors of the source host provided before migration. Clock speed, cache size, and
number of cores can differ between source and target processors. However, the processors must come from
the same vendor class (AMD or Intel) to be vMotion compatible.

Note Donotadd virtual ESXihosts to an EVC cluster. ESXi virtual machines are not supported in EVC clusters.

Migrations of suspended virtual machines also require that the virtual machine be able to resume execution
on the target host using equivalent instructions.

When you initiate a migration with vMotion or a migration of a suspended virtual machine, the Migrate Virtual
Machine wizard checks the destination host for compatibility and produces an error message if compatibility
problems will prevent migration.

The CPU instruction set available to the operating system and to applications running in a virtual machine is
determined at the time that a virtual machine is powered on. This CPU feature set is based on the following
items:

®  Host CPU family and model

B Settings in the BIOS that might disable CPU features
B ESX/ESXi version running on the host

B The virtual machine's compatibility setting

B The virtual machine's guest operating system

To improve CPU compatibility between hosts of varying CPU feature sets, some host CPU features can be
hidden from the virtual machine by placing the host in an Enhanced vMotion Compatibility (EVC) cluster.

Note You can hide Host CPU features from a virtual machine by applying a custom CPU compatibility mask
to the virtual machine, but this is not recommended. VMware, in partnership with CPU and hardware vendors,
is working to maintain vMotion compatibility across the widest range of processors. For additional
information, search the VMware Knowledge Base for the vMotion and CPU Compatibility FAQ.

CPU Compatibility Scenarios

vCenter Server's CPU compeatibility checks compare the CPU features available on the source host, the subset
of features that the virtual machine can access, and the features available on the target host. Without the use
of EVC, any mismatch between two hosts' user-level features will block migration, whether or not the virtual
machine itself has access to those features. A mismatch between two hosts' kernel-level features, however,
blocks migration only when the virtual machine has access to a feature that the target host does not provide.

User-level features are non-privileged instructions that might be used by virtual machine applications. These
include SSE3, SSSE3, SSE4.1, SSE4.2, and AES. Because they are user-level instructions that bypass the
virtualization layer, these instructions could cause application instability if mismatched after a migration with
vMotion.

Kernel-level features are privileged instructions that might be used by the virtual machine operating system.
These include the AMD No eXecute (NX) and the Intel eXecute Disable (XD) security features.
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When you attempt to migrate a virtual machine with vMotion, one of the following scenarios applies:

B The destination host feature set matches the virtual machine’s CPU feature set. CPU compatibility
requirements are met, and migration with vMotion proceeds.

B The virtual machine’s CPU feature set contains features not supported by the destination host. CPU
compatibility requirements are not met, and migration with vMotion cannot proceed.

Note EVC overcomes such incompatibility by providing a "baseline" feature set for all virtual machines
running in a cluster and that hides the differences among the clustered hosts' CPUs from the virtual
machines.

B The destination host supports the virtual machine’s feature set, plus additional user-level features (such
as SSE4.1) not found in the virtual machine’s feature set. CPU compatibility requirements are not met, and
migration with vMotion cannot proceed.

Note This type of incompatibility is ignored for migrations among hosts in EVC clusters.

B The destination host supports the virtual machine’s feature set, plus additional kernel-level features (such
as NX or XD) not found in the virtual machine’s feature set. CPU compatibility requirements are met, and
migration with vMotion proceeds. The virtual machine retains its CPU feature set as long as it remains
powered on, allowing it to migrate freely back to the original host. However, if the virtual machine is
rebooted, it acquires a new feature set from the new host, which might cause vMotion incompatibility if
you attempt to migrate the virtual machine back to the original host.

CPU Families and Feature Sets

Processors are grouped into families. Processors within a given family generally have similar feature sets.

Processor families are defined by the processor vendors. You can distinguish different processor versions
within the same family by comparing the processors’ model, stepping level, and extended features. In some
cases, processor vendors have introduced significant architectural changes within the same processor family,
such as the SSSE3 and SSE4.1 instructions, and NX/XD CPU security features.

By default, vCenter Server identifies mismatches on features accessible to applications as incompatible to
guarantee the stability of virtual machines after migrations with vMotion.

Server hardware’s CPU specifications will usually indicate whether or not the CPUs contain the features that
affect vMotion compatibility.

For more information on identifying Intel processors and their features, see Application Note 485: I ntel® Processor
Identification and the CPUID Instruction, available from Intel. For more information on identifying AMD
processors and their features, see CPUID Specification, available from AMD.

About Enhanced vMotion Compatibility

You can use the Enhanced vMotion Compatibility (EVC) feature to help ensure vMotion compatibility for the
hosts in a cluster. EVC ensures that all hosts in a cluster present the same CPU feature set to virtual machines,
even if the actual CPUs on the hosts differ. Using EVC prevents migrations with vMotion from failing because
of incompatible CPUs.

Configure EVC from the cluster settings dialog box. When you configure EVC, you configure all host processors
in the cluster to present the feature set of a baseline processor. This baseline feature set is called the EVC mode.
EVC leverages AMD-V Extended Migration technology (for AMD hosts) and Intel FlexMigration technology
(for Intel hosts) to mask processor features so that hosts can present the feature set of an earlier generation of
processors. The EVC mode must be equivalent to, or a subset of, the feature set of the host with the smallest
feature set in the cluster.
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EVC masks only those processor features that affect vMotion compatibility. Enabling EVC does not prevent a
virtual machine from taking advantage of faster processor speeds, increased numbers of CPU cores, or
hardware virtualization support that might be available on newer hosts.

EVC cannot prevent virtual machines from accessing hidden CPU features in all circumstances. Applications
that do not follow CPU vendor recommended methods of feature detection might behave unexpectedly in an
EVC environment. VMware EVC cannot be supported with ill-behaved applications that do not follow the
CPU vendor recommendations. For more information about creating well-behaved applications, search the
VMware Knowledge Base for the article Detecting and Using New Features in CPUs.

EVC Requirements for Hosts

To improve CPU compatibility between hosts that have varying CPU feature sets, you can hide some host CPU
features from the virtual machine by placing the host in an Enhanced vMotion Compatibility (EVC) cluster.
Hosts in an EVC cluster and hosts that you add to an existing EVC cluster must meet EVC requirements.

B Power off all virtual machines in the cluster that are running on hosts with a feature set greater than the
EVC mode that you intend to enable, or migrate out of the cluster.

B All hosts in the cluster must meeting the following requirements.

Requirements Description

Supported ESX/ESXi ~ ESX/ESXi 3.5 Update 2 or later.

version

vCenter Server The host must be connected to a vCenter Server system.
CPUs A single vendor, either AMD or Intel.

Advanced CPU Enable these CPU features in the BIOS if they are available:
features enabled ®  Hardware virtualization support (AMD-V or Intel VT)

B MD No eXecute(NX)

B  [Intel eXecute Disable (XD)

Note Hardware vendors sometimes disable particular CPU features in the BIOS by default. This
can cause problems in enabling EVC, because the EVC compatibility checks detect the absence of

features that are expected to be present for a particular CPU. If you cannot enable EVC on a system
with a compatible processor, ensure that all features are enabled in the BIOS.

Supported CPUs for ~ To check EVC support for a specific processor or server model, see the VMware Compatibility Guide
the EVC mode that at http://www.vmware.com/resources/compatibility/search.php.
you want to enable

Create an EVC Cluster in the vSphere Web Client

Create an EVC cluster to help ensure vMotion compatibility between the hosts in the cluster.

To create an EVC cluster with minimal disruption to your existing infrastructure, create an empty EVC cluster
and move hosts into the cluster. To enable EVC on an existing cluster, see “Enable EVC on an Existing Cluster
in the vSphere Web Client,” on page 160.

Other cluster features such as vSphere DRS and vSphere HA are fully compatible with EVC. You can enable
these features when you create the cluster.

Prerequisites

Before you create an EVC cluster, verify that the hosts you intend to add to the cluster meet the requirements
listed in “EVC Requirements for Hosts,” on page 159.

Procedure
1  Right-click a datacenter in the inventory and select New Cluster.

2 Type a name for the cluster.
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Expand EVC and select a baseline CPU feature set from the EVC mode drop-down menu.

Select a CPU vendor and EVC mode appropriate for the hosts that you intend to add to the cluster.
(Optional) Enable DRS.

(Optional) Enable vSphere HA.

Click OK.

Select a host to move into the cluster.

If the host feature set is greater than the EVC mode that you enabled for the EVC cluster, power off all the
virtual machines on the host, or use vMotion to migrate them to another host.

Move the host into the cluster.

You can power on the virtual machines that are on the host, or migrate virtual machines into the cluster
with vMotion. The virtual machines must meet CPU compatibility requirements for the cluster’s EVC
mode. Power off virtual machines running on hosts with more features than the EVC mode before
migration into the cluster.

Repeat Step 3 and Step 4 for each additional host that you want to move into the cluster.

You can now use vMotion to migrate virtual machines between different hosts in the cluster without
encountering CPU incompatibility issues.

Enable EVC on an Existing Cluster in the vSphere Web Client

Enable EVC on an existing cluster to help ensure vMotion compatibility between the hosts in the cluster.

Prerequisites

Before you enable EVC on an existing cluster, ensure that the hosts in the cluster meet the requirements listed
in “EVC Requirements for Hosts,” on page 159.

Procedure

1
2

A O s W

160

Select the cluster in the inventory.

Ensure that the cluster has no powered-on virtual machines.

B Power off all the virtual machines on the hosts with feature sets greater than the EVC mode
B Migrate the cluster’s virtual machines to another host using vMotion.

Because these virtual machines are running with more features than the EVC mode you intend to set,
power off the virtual machines to migrate them back into the cluster after enabling EVC.

Ensure that the cluster contains hosts with CPUs from only one vendor, either Intel or AMD.
Click the Manage tab, select VMware EVC and click Edit.
Enable EVC for the CPU vendor and feature set appropriate for the hosts in the cluster, and click OK.

If you powered off or migrated virtual machines out of the cluster, power on the virtual machines in the
cluster, or migrate virtual machines into the cluster.

Power off virtual machines running with a larger feature set than the EVC mode that you enabled for the
cluster before you move them back into the cluster.
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Change the EVC Mode for a Cluster in the vSphere Web Client

Configure EVC to ensure that virtual machine migrations between hosts in the cluster do not fail because of
CPU feature incompatibilities.

Several EVC approaches are available to ensure CPU compatibility:

If all the hosts in a cluster are compatible with a newer EVC mode, you can change the EVC mode of an
existing EVC cluster.

You can enable EVC for a cluster that does not have EVC enabled.
You can raise the EVC mode to expose more CPU features.

You can lower the EVC mode to hide CPU features and increase compatibility.

Prerequisites

B Verify that all hosts in the cluster have supported CPUs for the EVC mode you want to enable. See
http://kb.vmware.com/kb/1003212 for a list of supported CPUs.

B Verify that all hosts in the cluster are connected and registered on vCenter Server. The cluster cannot
contain a disconnected host.

B Virtual machines must be in the following power states, depending on whether you raise or lower the
EVC mode.
EVC Mode Virtual Machine Power Action
Raise the EVC mode toa CPU ~ Running virtual machines can remain powered on. New EVC mode features are not
baseline with more features. available to the virtual machines until they are powered off and powered back on

again. A full power cycling is required. Rebooting the guest operating system or
suspending and resuming the virtual machine is not sufficient.

Lower the EVC mode to a CPU  Power off virtual machines if they are powered on and running at a higher EVC
baseline with fewer features. Mode than the one you intend to enable.
To verify the EVC mode for virtual machines, see “Determine EVC Modes for Virtual Machines,” on
page 183.

Procedure

1  Select a cluster in the inventory.

2 Click the Manage tab and click Settings.

3 Select VMware EVC and click Edit.

4  Select whether to enable or disable EVC.
Option Description
Disable EVC The EVC feature is disabled. CPU compatibility is not enforced for the hosts

in this cluster.

Enable EVC for AMD Hosts The EVC feature is enabled for AMD hosts.
Enable EVC for Intel Hosts The EVC feature is enabled for Intel hosts.

5 From the VMware EVC Mode drop-down menu, select the baseline CPU feature set that you want to
enable for the cluster.
If you cannot select the EVC Mode, the Compatibility pane displays the reason, and the relevant hosts for
each reason.

6 Click OK.
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Determine EVC Modes for Virtual Machines in the vSphere Web Client

The EVC mode of a virtual machine defines the CPU features that the virtual machine can access. The virtual
machine's EVC mode is determined when it is powered on in an EVC-enabled cluster.

When a virtual machine is powered on, it determines the EVC mode of the cluster in which it is running. If the
EVC mode of the cluster is subsequently raised, the virtual machine does not change its EVC mode until it is
powered off and powered on again. This means that the virtual machine does not use of any CPU features

exposed by the cluster's new EVC mode until the virtual machine has been powered off and powered on again.

For example, consider a cluster containing hosts with Intel Xeon 45nm Core 2 processors that have been set to
the Intel Merom Generation (Xeon Core 2) EVC mode. A virtual machine powered on in this cluster runs in
the Intel Merom Generation (Xeon Core 2) EVC mode. If the cluster's EVC mode is raised to Intel Penryn
Generation (Xeon 45nm Core 2), the virtual machine remains at the lower Intel Merom Generation (Xeon Core
2) EVC mode. To use any of the features exposed by the higher cluster EVC mode, such as SSE4.1, you must
power off the virtual machine and power it on again.

Procedure
1  Select the cluster or host in the inventory.
2 Click the Related Objects tab and click Virtual Machines.

3 If the EVC Mode column does not appear, right-click any column title, select Show/Hide Columns and
select EVC Mode.

The EVC modes of all running or suspended virtual machines appear in the EVC Mode column. Powered
off virtual machines and virtual machines that are not in EVC clusters show N/A as the EVC mode.

Determine the EVC Mode that a Host Supports in the vSphere Web Client

By determining the EVC modes that the host can support, you can determine whether the host is compatible
with other hosts in an EVC cluster. For hosts to be included in the same EVC cluster, all the hosts must support
at least one common mode.

Procedure

1  Select a host in the inventory.

2 Click the Summary tab.

3 In the Configuration panel, expand EVC Mode.

The supported EVC modes are listed in order from the fewest to the greatest number of supported features.

Prepare Clusters for AMD Processors Without 3DNow!

Newer generations of AMD processors do not include 3DNow! processor instructions. If hosts in a cluster have
different generations of AMD processors, some with 3DNow! instruction sets and some without, you cannot
successfully migrate virtual machines between the hosts. You must use an EVC mode or CPU compatibility
mask to hide the instructions.

The vCenter Server AMD Opteron Gen. 3 (no 3DNow!) EVC mode masks the 3DNow! instructions from
virtual machines. You can apply this EVC mode to EVC clusters containing only AMD Opteron Generation 3
hosts to allow the clusters to maintain vMotion compatibility with AMD Opteron hosts that do not have
3DNow! instructions. Clusters containing AMD Opteron Generation 1 or AMD Opteron Generation 2 hosts
cannot be made vMotion-compatible with hosts that do not have 3DNow! instructions.

Prerequisites

Ensure that the cluster contains only hosts with AMD Opteron Generation 3 or newer processors.
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Procedure
4 Enable the AMD Opteron Gen. 3 (no 3DNow!) EVC mode for your EVC cluster.

The steps to enable the EVC mode differ depending on whether you are creating a cluster or enabling the
mode on an existing cluster, and on whether the existing cluster contains powered-on virtual machines.

Option Description

Creating a new cluster In the New Cluster wizard, enable EVC for AMD hosts and select the AMD
Opteron Gen. 3 (no 3DNow!) EVC mode.

Editing a cluster without powered-on  In the Cluster Settings dialog box, edit the VMware EVC settings and select
virtual machines the AMD Opteron Gen. 3 (no 3DNow!) EVC mode.

Editing a cluster with powered-on The AMD Opteron Gen. 3 (no 3DNow!) EVC mode cannot be enabled while
virtual machines there are powered-on virtual machines in the cluster.
a Power-off any running virtual machines in the cluster, or migrate them
out of the cluster using vMotion.

Migrating the virtual machines out of the cluster with vMotion allows
you to delay powering off the virtual machines until a more convenient
time.

b In the Cluster Settings dialog box, edit the VMware EVC settings and
select the AMD Opteron Gen. 3 (no 3DNow!) EVC mode.

¢ If you migrated virtual machines out of the cluster, power them off and
cold migrate them back into the cluster.

d Power on the virtual machines.

You cannow add hosts with AMD processors without 3DNow! instructions to the cluster and preserve vMotion
compatibility between the new hosts and the existing hosts in the cluster.

CPU Compatibility Masks

CPU compatibility masks allow per-virtual machine customization of the CPU features visible to a virtual
machine.

vCenter Server compares the CPU features available to a virtual machine with the CPU features of the
destination host to determine whether to allow or disallow migrations with vMotion.

Default values for the CPU compatibility masks are set by VMware to guarantee the stability of virtual
machines after a migration with vMotion.

In some cases, where a choice between CPU compeatibility or guest operating system features (such as NX/XD)
exists, VMware provides check-box options to configure individual virtual machines through the virtual
machine’s Advanced Settings option. For more control over the visibility of CPU features, you can edit the
virtual machine’s CPU compatibility mask at the bit level.

e CautioN Changing the CPU compatibility masks can result in an unsupported configuration. Do not manually
change the CPU compatibility masks unless instructed to do so by VMware Support or a VMware Knowledge
base article.

CPU compatibility masks cannot prevent virtual machines from accessing masked CPU features in all
circumstances. In some circumstances, applications can detect and use masked features even though they are
hidden from the guest operating system. In addition, on any host, applications that use unsupported methods
of detecting CPU features rather than using the CPUID instruction can access masked features. Virtual
machines running applications that use unsupported CPU detection methods might experience stability
problems after migration.
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View CPUID Details for an EVC Cluster in the vSphere Web Client

The feature set that is exposed by an EVC cluster corresponds to the feature set of a particular type of processor.
Processor feature sets are described by a set of feature flags that you examine using the CPUID instruction.

You can view the CPUID feature flags currently exposed by the hosts in an EVC cluster.
Procedure

1  Select a cluster in the inventory.

2 Click the Manage tab and click Settings.

3 Under Configuration, click VMware EVC and expand Current CPUID Details.

This VMware EVC panel displays the CPUID feature flags that EVC enforces for the hosts in this cluster. For
information about CPUID feature flags, see the Intel and AMD Web sites.

About Migration Compatibility Checks

During migration, the Migrate Virtual Machine wizard checks the destination host for compatibility with the
migrating virtual machine using a number of criteria.

When you select a host, the Compatibility panel at the bottom of the Migrate Virtual Machine wizard displays
information about the compatibility of the selected host or cluster with the virtual machine’s configuration.

If the virtual machine is compatible, the panel displays the message, Validation succeeded. If the virtual
machine is not compatible with either the host’s or cluster’s configured networks or datastores, the
compatibility window can display both warnings and errors:

B Warning messages do not disable migration. Often the migration is justified and you can continue with
the migration despite the warnings.

B Errors can disable migration if there are no error-free destination hosts among the selected destination
hosts. In this case, the Next button is disabled.

For clusters, the network and datastore configurations are taken into account when checking compatibility
issues. For hosts, the individual host’s configuration is used. A possible problem might be that vMotion is not
enabled on one or both hosts.

A specific host CPU feature’s effects on compatibility are dependent on whether ESXi exposes or hides them
from virtual machines.

B Features that are exposed to virtual machines are not compatible when they are mismatched.
B Features that are not exposed to virtual machines are compatible regardless of mismatches.

Specific items of virtual machine hardware can also cause compatibility issues. For example, a virtual machine
using an enhanced vmxnet virtual NIC cannot be migrated to a host running a version of ESXi that does not
support enhanced vmxnet.
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Migrate a Powered-Off or Suspended Virtual Machine in the
vSphere Web Client

You can use cold migration, to move a virtual machine and its associated disks from one datastore to another.

The virtual machines are not required to be on shared storage. You can also use cold migration to move virtual
machines from one datacenter to another.

Prerequisites

B Make sure that you are familiar with the requirements for cold migration. See “Cold Migration in the

vSphere Web Client,” on page 152.

B Required privilege: Resource.ColdMigrate

Procedure

1  Right-click the virtual machine and select Migrate.
a  Tolocate a virtual machine, select a datacenter, folder, cluster, resource pool, host, or vApp.
b  Click the Related Objects tab and click Virtual Machines.

2 Select the migration type and click Next.

Option Description

Change host Move the virtual machine to another host.

Change datastore Move the virtual machine’s configuration file and virtual disks.

Change both host and datastore Move the virtual machine to another host and move its configuration file and
virtual disks.

3 Select the destination host or cluster for this virtual machine migration and click Next.

Any compatibility problem appears in the Compatibility panel. Fix the problem, or select another host or

cluster.

Possible targets include hosts and DRS clusters with any level of automation. If a cluster has no DRS

enabled, select a specific host in the cluster rather than selecting the cluster.

4  Select the format for the virtual machine's disks.

Option Action

Same format as source Use the same format as the source virtual machine.

Thick Provision Lazy Zeroed Create a virtual disk in a default thick format. Space required for the virtual
disk is allocated during creation. Any data remaining on the physical device
is not erased during creation, but is zeroed out on demand at a later time on
first write from the virtual machine.

Thick Provision Eager Zeroed Create a thick disk that supports clustering features such as Fault Tolerance.
Space required for the virtual disk is allocated at creation time. In contrast to
the thick provision lazy zeroed format, the data remaining on the physical
device is zeroed out during creation. It might take longer to create disks in
this format than to create other types of disks.

Thin Provision Use the thin provisioned format. At first, a thin provisioned disk uses only
as much datastore space as the disk initially needs. If the thin disk needs more
space later, it can grow to the maximum capacity allocated to it.

5  Assign astorage profile from the VM Storage Profile drop-down menu. Storage profiles define the storage
capabilities that are required by the applications running on the virtual machine.
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6  Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the  Select a datastore and click Next.
same location on a datastore.

Store all virtual machine files inthe a Select a Storage DRS cluster.

same Storage DRS cluster. b  (Optional) To not use Storage DRS with this virtual machine, select
Disable Storage DRS for this virtual machine and select a datastore
within the Storage DRS cluster.

¢ Click Next.

Store virtual machine configuration a Click Advanced.
files and disks in separate locations. |,  For the virtual machine configuration file and for each virtual disk, select
Browse, and select a datastore or Storage DRS cluster.
¢ (Optional) If you selected a Storage DRS cluster and do not want to use
Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the Storage DRS
cluster.
d Click Next.

7 Review the information on the Review Selections page and click Finish.

8  Review the information on the Review Selections page and click Finish.

Depending on the migration type you selected, vCenter Server moves the virtual machine to the new host or
storage location. Event messages appear in the Events tab. The data displayed on the Summary tab shows the
status and state throughout the migration. If errors occur during migration, the virtual machines revert to their
original states and locations.

Migrate a Powered-On Virtual Machine with vMotion in the
vSphere Web Client

166

You can use the Migration wizard to migrate a powered-on virtual machine from one host to another using
vMotion technology. To relocate the disks of a powered-on virtual machine, migrate the virtual machine using
Storage vMotion.

Prerequisites

Before migrating a virtual machine with vMotion, make sure that your hosts and virtual machines meet the
requirements for migration with vMotion.

B Make sure that your hosts and virtual machines meet the requirements for migration with vMotion. See
“Host Configuration for vMotion,” on page 153 and “Virtual Machine Conditions and Limitations for
vMotion in the vSphere Web Client,” on page 154.

B Required privilege: Resource.HotMigrate

Procedure

1  Right-click the virtual machine and select Migrate.
a  Tolocate a virtual machine, select a datacenter, folder, cluster, resource pool, host, or vApp.
b Click the Related Objects tab and click Virtual Machines.

2 Select Change host and click Next.

3 Select the destination resource for the virtual machine migration.
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4 Select a destination host or cluster for the virtual machine.

Any compatibility problem appears in the Compatibility panel. Fix the problem, or select another host or
cluster.

Possible targets include hosts and fully automated DRS clusters. You can select a nonautomated cluster
as a target. You are prompted to select a host within the non-automated cluster.

5  Select the migration priority level and click Next.

Option Description
Reserve CPU for optimal VMotion vCenter Server attempts to reserve resources on both the source and
performance destination hosts to be shared among all concurrent migrations with

vMotion. vCenter Server grants a larger share of host CPU resources. if
sufficient CPU resources are not immediately available, vMotion is not

initiated.
Perform with available CPU vCenter Server reserves resources on both the source and destination hosts
resources to be shared among all concurrent migration with vMotion. vCenter Server

grants a smaller share of host CPU resources. If there is a lack of CPU
resources, the duration of vMotion can be extended.

6  Review the information on the Review Selections page and click Finish.
7  Review the page and click Finish.
vCenter Server moves the virtual machine to the new host. Event messages appear in the Events tab. The data

displayed on the Summary tab shows the status and state throughout the migration. If errors occur during
migration, the virtual machines revert to their original states and locations.

Migrate a Virtual Machine with Storage vMotion in the
vSphere Web Client

Use migration with Storage vMotion to relocate a virtual machine’s configuration file and virtual disks while
the virtual machine is powered on.

You can change the virtual machine’s execution host during a migration with Storage vMotion.

Prerequisites

B Ensure that you are familiar with the requirements for Storage vMotion. See “Storage vMotion
Requirements and Limitations,” on page 155.

B Required privilege: Resource.HotMigrate

Procedure

1 Right-click the virtual machine and select Migrate.
a  Tolocate a virtual machine, select a datacenter, folder, cluster, resource pool, host, or vApp.
b  Click the Related Objects tab and click Virtual Machines.

2 Select Change datastore and click Next.

3 Select the format for the virtual machine's disks.

Option Action
Same format as source Use the same format as the source virtual machine.
Thick Provision Lazy Zeroed Create a virtual disk in a default thick format. Space required for the virtual

disk is allocated during creation. Any data remaining on the physical device
is not erased during creation, but is zeroed out on demand at a later time on
first write from the virtual machine.
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Option Action

Thick Provision Eager Zeroed Create a thick disk that supports clustering features such as Fault Tolerance.
Space required for the virtual disk is allocated at creation time. In contrast to
the thick provision lazy zeroed format, the data remaining on the physical
device is zeroed out during creation. It might take longer to create disks in
this format than to create other types of disks.

Thin Provision Use the thin provisioned format. At first, a thin provisioned disk uses only
as much datastore space as the disk initially needs. If the thin disk needs more
space later, it can grow to the maximum capacity allocated to it.

4  Assign astorage profile from the VM Storage Profile drop-down menu. Storage profiles define the storage
capabilities that are required by the applications running on the virtual machine.

5  Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the  Select a datastore and click Next.
same location on a datastore.

Store all virtual machine filesinthe a  Select a Storage DRS cluster.

same Storage DRS cluster. b  (Optional) To not use Storage DRS with this virtual machine, select
Disable Storage DRS for this virtual machine and select a datastore
within the Storage DRS cluster.

¢ Click Next.

Store virtual machine configuration a Click Advanced.

files and disks in separate locations. |,  For the virtual machine configuration file and for each virtual disk, select
Browse, and select a datastore or Storage DRS cluster.

¢ (Optional) If you selected a Storage DRS cluster and do not want to use
Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the Storage DRS
cluster.

d Click Next.

6  Review the information on the Review Selections page and click Finish.

vCenter Server moves the virtual machine to the new storage location. Event messages appear in the Events
tab. The data displayed on the Summary tab shows the status and state throughout the migration. If errors
occur during migration, the virtual machines revert to their original states and locations.

Migrate a Virtual Machine with Cross-Host Storage vMotion in the
vSphere Web Client

168

You can move a virtual machine to another host and move its disks or virtual machine folder to another
datastore. With cross-host Storage vMotion, you can migrate a virtual machine and its disks and files while
the virtual machine is on.

When you perform cross-host Storage vMotion, shared storage is not required. Virtual machine disks or
contents of the virtual machine folder are transferred over the vMotion network to reach the destination host
and datastores. Cross-host Storage vMotion shares the configuration and licensing requirements of vMotion,
but not of Storage vMotion.

To make disk format changes and preserve them, you must select a different datastore for the virtual machine
files and disks. You cannot preserve disk format changes if you select the same datastore on which the virtual
machine currently resides.

Prerequisites

B Ensure that your hosts and virtual machines meet the necessary requirements. See “Cross-Host Storage
vMotion Requirements and Limitations,” on page 156.
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B Required privilege: Resource.HotMigrate

Procedure

1 Right-click the virtual machine and select Migrate.
a  Tolocate a virtual machine, select a datacenter, folder, cluster, resource pool, host, or vApp.
b  Click the Related Objects tab and click Virtual Machines.

2 Select Change both host and datastore and click Next.

3 Select the destination resource for the virtual machine and click Next.

4 Select the format for the virtual machine's disks.

Option Action
Same format as source Use the same format as the source virtual machine.
Thick Provision Lazy Zeroed Create a virtual disk in a default thick format. Space required for the virtual

disk is allocated during creation. Any data remaining on the physical device
is not erased during creation, but is zeroed out on demand at a later time on
first write from the virtual machine.

Thick Provision Eager Zeroed Create a thick disk that supports clustering features such as Fault Tolerance.
Space required for the virtual disk is allocated at creation time. In contrast to
the thick provision lazy zeroed format, the data remaining on the physical
device is zeroed out during creation. It might take longer to create disks in
this format than to create other types of disks.

Thin Provision Use the thin provisioned format. At first, a thin provisioned disk uses only
as much datastore space as the disk initially needs. If the thin disk needs more
space later, it can grow to the maximum capacity allocated to it.

5  Assign a storage profile from the VM Storage Profiledrop-down menu.

Storage profiles define the storage capabilities that are required by the applications running on the virtual
machine.

6  Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the  Select a datastore and click Next.
same location on a datastore.

Store all virtual machine filesinthe a Select a Storage DRS cluster.

same Storage DRS cluster. b (Optional) To not use Storage DRS with this virtual machine, select
Disable Storage DRS for this virtual machine and select a datastore
within the Storage DRS cluster.

¢ Click Next.

Store virtual machine configuration a Click Advanced.

files and disks in separate locations. 1,  For the virtual machine configuration file and for each virtual disk, select
Browse, and select a datastore or Storage DRS cluster.

¢ (Optional) If you selected a Storage DRS cluster and do not want to use
Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the Storage DRS
cluster.

d Click Next.

7 Review the information on the Review Selections page and click Finish.
vCenter Server moves the virtual machine to the new host and storage location. Event messages appear in the

Events tab. The data that appears in the Summary tab shows the status and state throughout the migration. If
errors occur during migration, the virtual machines revert to their original states and locations.
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Limits on Simultaneous Migrations in the vSphere Web Client

170

vCenter Server places limits on the number of simultaneous virtual machine migration and provisioning
operations that can occur on each host, network, and datastore.

Each operation, such as a migration with vMotion or cloning a virtual machine, is assigned a resource cost.
Each type of resource, such as host, datastore, or network, has a maximum cost that it can support at any one
time. Any new migration or provisioning operation that would cause a resource to exceed its maximum cost
does not proceed immediately, but is queued until other operations complete and release resources. Each of
the network, datastore, and host limits must be satisfied for the operation to proceed.

Cross-host Storage vMotion is a combination of vMotion and Storage vMotion and inherits the network, host,
and datastore costs associated with those operations. When you consider per-operation costs, a cross-host
Storage vMotion becomes equivalent to a Storage vMotion with a network cost of 1.

Network Limits

Network limits apply to migrations with vMotion and cross-host Storage vMotion. Network limits depend on
both the version of ESXi and the network type.

Table 13-1 lists network limits for migration with vMotion.

Table 12-1. Network Limits for Migration with vMotion and cross-host Storage vMotion

Operation ESX/ESXi Version Network Type Maximum Cost
vMotion 3.x 1GigE and 10GigE 2
vMotion 4.0 1GigE and 10GigE 2
vMotion 41,5.0,5.1 1GigE 4
vMotion 41,50,51 10GigE 8

All migrations with vMotion have a network resource cost of 1.

Datastore Limits

Datastore limits apply to migrations with vMotion and with Storage vMotion. A migration with vMotion
involves one access to the datastore. A migration with Storage vMotion involves one access to the source
datastore and one access to the destination datastore.

Table 13-2 lists datastore limits for migration with vMotion and Storage vMotion. Table 13-3 lists the datastore
resource costs for migration with vMotion and Storage vMotion.

Table 12-2. Datastore Limits for Migration with vMotion and Storage vMotion

Operation ESX/ESXi Version Maximum Cost
vMotion/Storag ~ 3.x 8

e vMotion

vMotion/Storag 4.0 8

e vMotion

vMotion/Storag 4.1, 5.0, 5.1 128

e vMotion

Table 12-3. Datastore Resource Costs for vMotion and Storage vMotion

Operation ESX/ESXi Version Datastore Resource Cost
vMotion 3.x,4.0,4.1,5.0,5.1 1
Storage vMotion 3.x 1
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Table 12-3. Datastore Resource Costs for vMotion and Storage vMotion (Continued)

Operation ESX/ESXi Version Datastore Resource Cost
Storage vMotion 4.0 1
Storage vMotion 4.1,5.0,5.1 16

Host Limits

Host limits apply to migrations with vMotion, Storage vMotion, and other provisioning operations such as
cloning, deployment, and cold migration.

Table 13-4 lists the host limits for migrations with vMotion, migrations with Storage vMotion, and provisioning
operations. Table 13-5 lists the host resource cost for these operations.

Table 12-4. Host Limits for vMotion, Storage vMotion, and Provisioning Operations

Operation ESX/ESXi Version Maximum Cost
vMotion 3.x, 4.0 2
vMotion 41,5.0,5.1 8
Storage vMotion 3.x,4.0,4.1,5.0,5.1 2
other provisioning operations 3.x,4.0,4.1,5.0,5.1 8

Table 12-5. Host Resource Costs for vMotion, Storage vMotion, and Provisioning Operations

Operation ESX/ESXi Version Host Resource Cost
vMotion 3.x, 4.0 4
vMotion 41,5.0,5.1 1
Storage vMotion 3.x,4.0,4.1,5.0,5.1 4
other provisioning operations 3.x,4.0,4.1,5.0,5.1 1
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Migrating Virtual Machines in the
vSphere Client

Migration is the process of moving a virtual machine from one host or storage location to another. Copying a
virtual machine creates a new virtual machine. It is not a form of migration.

In vCenter Server, you have the following migration options:

Cold Migration Moving a powered-off virtual machine to a new host. Optionally, you can
relocate configuration and disk files to new storage locations. You can use cold
migration to move virtual machines from one datacenter to another.

Migrating a Suspended Moving a suspended virtual machine to a new host. Optionally, you can
Virtual Machine relocate configuration and disk files to new storage location. You can migrate
suspended virtual machines from one datacenter to another.

Migration with vMotion Moving a powered-on virtual machine to a new host. Migration with vMotion
allows you to move a virtual machine to a new host without any interruption
in the availability of the virtual machine. You cannot use vMotion to move
virtual machines from one datacenter to another. Some configurations include
Metro vMotion, a feature that enables reliable migrations between hosts
separated by high network round-trip latency times. Metro vMotion is
automatically enabled when the appropriate license is installed. No user
configuration is necessary.

Migration with Storage Moving the virtual disks or configuration file of a powered-on virtual machine

vMotion to a new datastore. Migration with Storage vMotion allows you to move a
virtual machine’s storage without any interruption in the availability of the
virtual machine.

Both migration of a suspended virtual machine and migration with vMotion are sometimes referred to as “hot
migration”, because they allow migration of a virtual machine without powering it off. Migration with vMotion
is sometimes referred to as "live migration".

You can move virtual machines manually or set up a scheduled task to perform the cold migration.

Cloning a virtual machine or copying its disks and configuration file creates a new virtual machine. Cloning
is not a form of migration.

This chapter includes the following topics:

B “Cold Migration,” on page 174

B “Migrating a Suspended Virtual Machine,” on page 174
B “Migration with vMotion,” on page 174

B “Migration with Storage vMotion,” on page 177

B “CPU Compatibility and EVC,” on page 178
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Cold

B “Migrate a Powered-Off or Suspended Virtual Machine in the vSphere Client,” on page 186
B “Migrate a Powered-On Virtual Machine with vMotion in the vSphere Client,” on page 187
B “Migrate a Virtual Machine with Storage vMotion in the vSphere Client,” on page 188

B “Limits on Simultaneous Migrations,” on page 189

Migration

Cold migration is the migration of a powered-off virtual machine. With cold migration, you have the option
of moving the associated disks from one datastore to another. The virtual machines are not required to be on
shared storage.

The virtual machine you want to migrate must be powered off prior to beginning the cold migration process.

If a virtual machine is configured to have a 64-bit guest operating system, vCenter Server generates a warning
if you try to migrate it to a host that does not support 64-bit operating systems. Otherwise, CPU compatibility
checks do not apply when you migrate a virtual machine with cold migration.

A cold migration consists of the following tasks:

1  If the option to move to a different datastore was chosen, the configuration files, including the NVRAM
file (BIOS settings), and log files are moved from the source host to the destination host’s associated storage
area. If you chose to move the virtual machine's disks, these are also moved.

2 The virtual machine is registered with the new host.

3 After the migration is completed, the old version of the virtual machine is deleted from the source host if
the option to move to a different datastore was chosen.

Migrating a Suspended Virtual Machine

When migrating a suspended virtual machine, you also have the option of moving the associated disks from
one datastore to another. The virtual machines are not required to be on shared storage.

When you migrate a suspended virtual machine, the new host for the virtual machine must meet CPU
compatibility requirements, because the virtual machine must be able to resume executing instructions on the
new host.

Migration of a suspended virtual machine consists of the following steps:

1  The configuration files, including the NVRAM file (BIOS settings), log files, and the suspend file as well
as the disks of the virtual machine are moved from the source host to the destination host’s associated
storage area.

2 The virtual machine is registered with the new host.

3 After the migration is completed, the old version of the virtual machine is deleted from the source host.

Migration with vMotion

174

If you need to take a host offline for maintenance, you can move the virtual machine to another host. Migration
with vMotion™ allows virtual machine working processes to continue throughout a migration.

The entire state of the virtual machine is moved to the new host, while the associated virtual disk remains in
the same location on storage that is shared between the two hosts. After the virtual machine state is migrated
to the alternate host, the virtual machine runs on the new host. Migrations with vMotion are completely
transparent to the running virtual machine.
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The state information includes the current memory content and all the information that defines and identifies
the virtual machine. The memory content includes transaction data and whatever bits of the operating system
and applications are in the memory. The defining and identification information stored in the state includes
all the data that maps to the virtual machine hardware elements, such as BIOS, devices, CPU, MAC addresses
for the Ethernet cards, chip set states, registers, and so forth.

When you migrate a virtual machine with vMotion, the new host for the virtual machine must meet
compatibility requirements in order for the migration to proceed.

Migration with vMotion occurs in three stages:

1  When the migration with vMotion is requested, vCenter Server verifies that the existing virtual machine
is in a stable state with its current host.

2 The virtual machine state information (memory, registers, and network connections) is copied to the target
host.

3 The virtual machine resumes its activities on the new host.

If errors occurs during migration, the virtual machines revert to their original states and locations.

Host Configuration for vMotion
In order to successfully use vMotion, you must first configure your hosts correctly.
Ensure that you have correctly configured your hosts in each of the following areas:
B Each host must be correctly licensed for vMotion.
B Each host must meet shared storage requirements for vMotion.

B Each host must meet the networking requirements for vMotion.

ImporTANT The ESXi firewall in ESXi 5.0 and later does not allow per-network filtering of vMotion traffic.
Therefore, you must install rules on your external firewall to ensure that no incoming connections can be
made to the vMotion socket.

vMotion Shared Storage Requirements

Configure hosts for vMotion with shared storage to ensure that virtual machines are accessible to both source
and target hosts.

During a migration with vMotion, the migrating virtual machine must be on storage accessible to both the
source and target hosts. Ensure that the hosts configured for vMotion use shared storage. Shared storage can
be on a Fibre Channel storage area network (SAN), or can be implemented using iSCSI and NAS.

If you use vMotion to migrate virtual machines with raw device mapping (RDM) files, make sure to maintain
consistent LUN IDs for RDMs across all participating hosts.

See the vSphere Storage documentation for information on SANs and RDMs.

vSphere vMotion Networking Requirements
Migration with vMotion requires correctly configured network interfaces on source and target hosts.

Configure each host with at least one vMotion network interface. To ensure secure data transfer, the vMotion
network must be a secure network, accessible only to trusted parties. Because vMotion performance improves
significantly with additional bandwidth, dedicate at minimum a physical 1 Gigabit Ethernet (GigE) NIC to
vMotion. As a best practice, provision at least one additional physical NIC as a failover NIC.

To determine the maximum number of concurrent vMotions possible, see the Concurrent migration limits at
“Limits on Simultaneous Migrations in the vSphere Web Client,” on page 170. These limits vary with a host's
link speed to the vMotion network.
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Some configurations include Metro vMotion, which is a feature that enables reliable migrations between hosts
that are separated by high network round-trip latency times. Metro vMotion is enabled when the appropriate
license is installed. No user configuration is necessary.

You can configure multiple NICs for vMotion by adding two or more NICs to the required standard switch.
For details, see the VMware knowledge base article at http://kb.vmware.com/kb/2007467.

Recommended networking best practices are as follows:
B Use one dedicated GigE adapter for vMotion.
B [f only two Ethernet adapters are available:

B For best security, dedicate the GigE adapter to vMotion, and use VLANSs to divide the virtual machine
and management traffic on the other adapter.

B For best availability, combine both adapters into a bond, and use VLANSs to divide traffic into
networks: one or more for virtual machine traffic and one for vMotion.

Configure the virtual networks on vMotion enabled hosts as follows:
B On each host, configure a VMkernel port group for vMotion.
B Ensure that virtual machines have access to the same subnets on source and destination hosts.

B [fyou are using standard switches for networking, ensure that the network labels used for virtual machine
port groups are consistent across hosts. During a migration with vMotion, vCenter Server assigns virtual
machines to port groups based on matching network labels.

Note You cannot migrate virtual machines that are attached to a virtual intranet with vMotion, even if
the destination host has a virtual intranet configured with the same network label.

B  [f you are using vSphere Distributed Switches for networking, ensure that source and destination hosts
are members of all vSphere Distributed Switches that virtual machines use for networking.

B Use of Jumbo Frames is recommended for best vMotion performance.

Virtual Machine Configuration Requirements for vMotion in the vSphere Client
A number of specific virtual machine configurations can prevent migration of a virtual machine with vMotion.
The following virtual machine configurations can prevent migration with vMotion:
B You cannot use migration with vMotion to migrate virtual machines that use raw disks for clustering.

B [fvirtual CPU performance counters are enabled, you can migrate virtual machines only to hosts that have
compatible CPU performance counters.

B You cannot use migration with vMotion to migrate a virtual machine that uses a virtual device backed by
a device that is not accessible on the destination host. (For example, you cannot migrate a virtual machine
with a CD drive backed by the physical CD drive on the source host.) Disconnect these devices before
migrating the virtual machine.

Virtual machines with USB passthrough devices can be migrated with vMotion as long as the devices are
enabled for vMotion.

B You cannot use migration with vMotion to migrate a virtual machine that uses a virtual device backed by
a device on the client computer. Disconnect these devices before migrating the virtual machine.
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Swap File Location Compatibility

Virtual machine swap file location affects vMotion compatibility in different ways depending on the version
of ESXi running on the virtual machine's host.

You can configure ESX 3.5 or ESXi 3.5 or later hosts to store virtual machine swap files with the virtual machine
configuration file, or on a local swap file datastore specified for that host.

The location of the virtual machine swap file affects vMotion compatibility as follows:

B For migrations between hosts running ESX/ESXi version 3.5 and later, vMotion and migrations of
suspended and powered-off virtual machines are allowed.

B During a migration with vMotion, if the swapfile location specified on the destination host differs from
the swapfile location specified on the source host, the swap file is copied to the new location. This activity
can result in slower migrations with vMotion. If the destination host cannot access the specified swap file
location, it stores the swap file with the virtual machine configuration file.

See the vSphere Resource Management documentation for information about configuring swap file policies.

Migrating Virtual Machines with Snapshots

Migration of virtual machines with snapshots is possible if the virtual machine resides on shared storage
accessible to source and destination hosts.

Migrating a virtual machine with snapshots is permitted, regardless of the virtual machine power state, as long
as the virtual machine is being migrated to a new host without moving its configuration file or disks. (The
virtual machine must reside on shared storage accessible to both hosts.)

If the migration involves moving the configuration file or virtual disks, the following additional restrictions
apply:
B The starting and destination hosts must be running ESX 3.5 or ESXi 3.5 or later.

B All of the virtual machine files and disks must reside in a single directory, and the migrate operation must
move all the virtual machine files and disks to a single destination directory.

Reverting to a snapshot after migration with vMotion might cause the virtual machine to fail, because the
migration wizard cannot verify the compatibility of the virtual machine state in the snapshot with the
destination host. Failure occurs only if the configuration in the snapshot uses devices or virtual disks that are
not accessible on the current host, or if the snapshot contains an active virtual machine state that was running
on hardware that is incompatible with the current host CPU.

Migration with Storage vMotion

With Storage vMotion, you can migrate a virtual machine and its disk files from one datastore to another while
the virtual machine is running. With Storage vMotion, you can move virtual machines off of arrays for
maintenance or to upgrade. You also have the flexibility to optimize disks for performance, or to transform
disk types, which you can use to reclaim space.

You can choose to place the virtual machine and all its disks in a single location, or select separate locations
for the virtual machine configuration file and each virtual disk. The virtual machine does not change execution
host during a migration with Storage vMotion.

During a migration with Storage vMotion, you can transform virtual disks from Thick-Provisioned Lazy
Zeroed or Thick-Provisioned Eager Zeroed to Thin-Provisioned or the reverse.
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Storage vMotion has several uses in administering virtual infrastructure, including the following examples of
use.

B Storage maintenance and reconfiguration. You can use Storage vMotion to move virtual machines off of
a storage device to allow maintenance or reconfiguration of the storage device without virtual machine
downtime.

B Redistributing storage load. You can use Storage vMotion to manually redistribute virtual machines or
virtual disks to different storage volumes to balance capacity or improve performance.

B You can use Storage vMotion to migrate virtual machines when you upgrade datastores from VMFS2 to
VMEFS5. For information about the two-step upgrade process, see the vSphere Storage documentation.

Storage vMotion Requirements and Limitations

A virtual machine and its host must meet resource and configuration requirements for the virtual machine
disks to be migrated with Storage vMotion.

Storage vMotion is subject to the following requirements and limitations:

B Virtual machine disks must be in persistent mode or be raw device mappings (RDMs). For virtual
compatibility mode RDMs, you can migrate the mapping file or convert to thick-provisioned or thin-
provisioned disks during migration as long as the destination is not an NFS datastore. If you convert the
mapping file, a new virtual disk is created and the contents of the mapped LUN are copied to this disk.
For physical compatibility mode RDMs, you can migrate the mapping file only.

B Migration of virtual machines during VMware Tools installation is not supported.
B The host on which the virtual machine is running must have a license that includes Storage vMotion.

B ESX/ESXi 3.5 hosts must be licensed and configured for vMotion. ESX/ESXi 4.0 and later hosts do not
require vMotion configuration in order to perform migration with Storage vMotion.

B Thehost on which the virtual machine is running must have access to both the source and target datastores.

B For limits on the number of simultaneous migrations with vMotion and Storage vMotion, see “Limits on
Simultaneous Migrations,” on page 189.

CPU Compatibility and EVC

vCenter Server performs compatibility checks before it allows migration of running or suspended virtual
machines to ensure that the virtual machine is compatible with the target host.

vMotion transfers the running state of a virtual machine between underlying ESXi systems. Live migration
requires that the processors of the target host provide the same instructions to the virtual machine after
migration that the processors of the source host provided before migration. Clock speed, cache size, and
number of cores can differ between source and target processors. However, the processors must come from
the same vendor class (AMD or Intel) to be vMotion compatible.

Note Donotadd virtual ESXihosts to an EVC cluster. ESXi virtual machines are not supported in EVC clusters.

Migrations of suspended virtual machines also require that the virtual machine be able to resume execution
on the target host using equivalent instructions.

When you initiate a migration with vMotion or a migration of a suspended virtual machine, the Migrate Virtual
Machine wizard checks the destination host for compatibility and produces an error message if compatibility
problems will prevent migration.
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The CPU instruction set available to the operating system and to applications running in a virtual machine is
determined at the time that a virtual machine is powered on. This CPU feature set is based on the following
items:

®  Host CPU family and model

B Settings in the BIOS that might disable CPU features
B ESX/ESXi version running on the host

B The virtual machine's compatibility setting

B The virtual machine's guest operating system

To improve CPU compatibility between hosts of varying CPU feature sets, some host CPU features can be
hidden from the virtual machine by placing the host in an Enhanced vMotion Compatibility (EVC) cluster.

Note You can hide Host CPU features from a virtual machine by applying a custom CPU compatibility mask
to the virtual machine, but this is not recommended. VMware, in partnership with CPU and hardware vendors,
is working to maintain vMotion compatibility across the widest range of processors. For additional
information, search the VMware Knowledge Base for the vMotion and CPU Compatibility FAQ.

CPU Compatibility Scenarios

vCenter Server's CPU compatibility checks compare the CPU features available on the source host, the subset
of features that the virtual machine can access, and the features available on the target host. Without the use
of EVC, any mismatch between two hosts' user-level features will block migration, whether or not the virtual
machine itself has access to those features. A mismatch between two hosts' kernel-level features, however,
blocks migration only when the virtual machine has access to a feature that the target host does not provide.

User-level features are non-privileged instructions that might be used by virtual machine applications. These
include SSE3, SSSE3, SSE4.1, SSE4.2, and AES. Because they are user-level instructions that bypass the
virtualization layer, these instructions could cause application instability if mismatched after a migration with
vMotion.

Kernel-level features are privileged instructions that might be used by the virtual machine operating system.
These include the AMD No eXecute (NX) and the Intel eXecute Disable (XD) security features.

When you attempt to migrate a virtual machine with vMotion, one of the following scenarios applies:

B The destination host feature set matches the virtual machine’s CPU feature set. CPU compatibility
requirements are met, and migration with vMotion proceeds.

B The virtual machine’s CPU feature set contains features not supported by the destination host. CPU
compatibility requirements are not met, and migration with vMotion cannot proceed.

Note EVC overcomes such incompatibility by providing a "baseline" feature set for all virtual machines
running in a cluster and that hides the differences among the clustered hosts' CPUs from the virtual
machines.

B The destination host supports the virtual machine’s feature set, plus additional user-level features (such
as SSE4.1) not found in the virtual machine’s feature set. CPU compatibility requirements are not met, and
migration with vMotion cannot proceed.

Note This type of incompatibility is ignored for migrations among hosts in EVC clusters.
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B The destination host supports the virtual machine’s feature set, plus additional kernel-level features (such
as NX or XD) not found in the virtual machine’s feature set. CPU compatibility requirements are met, and
migration with vMotion proceeds. The virtual machine retains its CPU feature set as long as it remains
powered on, allowing it to migrate freely back to the original host. However, if the virtual machine is
rebooted, it acquires a new feature set from the new host, which might cause vMotion incompatibility if
you attempt to migrate the virtual machine back to the original host.

CPU Families and Feature Sets

Processors are grouped into families. Processors within a given family generally have similar feature sets.

Processor families are defined by the processor vendors. You can distinguish different processor versions
within the same family by comparing the processors” model, stepping level, and extended features. In some
cases, processor vendors have introduced significant architectural changes within the same processor family,
such as the SSSE3 and SSE4.1 instructions, and NX/XD CPU security features.

By default, vCenter Server identifies mismatches on features accessible to applications as incompatible to
guarantee the stability of virtual machines after migrations with vMotion.

Server hardware’s CPU specifications will usually indicate whether or not the CPUs contain the features that
affect vMotion compatibility.

For more information on identifying Intel processors and their features, see Application Note 485: I ntel® Processor
Identification and the CPUID Instruction, available from Intel. For more information on identifying AMD
processors and their features, see CPUID Specification, available from AMD.

About Enhanced vMotion Compatibility

You can use the Enhanced vMotion Compatibility (EVC) feature to help ensure vMotion compatibility for the
hosts in a cluster. EVC ensures that all hosts in a cluster present the same CPU feature set to virtual machines,
even if the actual CPUs on the hosts differ. Using EVC prevents migrations with vMotion from failing because
of incompatible CPUs.

Configure EVC from the cluster settings dialog box. When you configure EVC, you configure all host processors
in the cluster to present the feature set of a baseline processor. This baseline feature set is called the EVC mode.
EVC leverages AMD-V Extended Migration technology (for AMD hosts) and Intel FlexMigration technology
(for Intel hosts) to mask processor features so that hosts can present the feature set of an earlier generation of
processors. The EVC mode must be equivalent to, or a subset of, the feature set of the host with the smallest
feature set in the cluster.

EVC masks only those processor features that affect vMotion compatibility. Enabling EVC does not prevent a
virtual machine from taking advantage of faster processor speeds, increased numbers of CPU cores, or
hardware virtualization support that might be available on newer hosts.

EVC cannot prevent virtual machines from accessing hidden CPU features in all circumstances. Applications
that do not follow CPU vendor recommended methods of feature detection might behave unexpectedly in an
EVC environment. VMware EVC cannot be supported with ill-behaved applications that do not follow the
CPU vendor recommendations. For more information about creating well-behaved applications, search the
VMware Knowledge Base for the article Detecting and Using New Features in CPUs.

EVC Requirements for Hosts

To improve CPU compatibility between hosts that have varying CPU feature sets, you can hide some host CPU
features from the virtual machine by placing the host in an Enhanced vMotion Compatibility (EVC) cluster.
Hosts in an EVC cluster and hosts that you add to an existing EVC cluster must meet EVC requirements.

B Power off all virtual machines in the cluster that are running on hosts with a feature set greater than the
EVC mode that you intend to enable, or migrate out of the cluster.

B All hosts in the cluster must meeting the following requirements.
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Requirements Description

Supported ESX/ESXi ~ ESX/ESXi 3.5 Update 2 or later.

version

vCenter Server The host must be connected to a vCenter Server system.
CPUs A single vendor, either AMD or Intel.

Advanced CPU Enable these CPU features in the BIOS if they are available:
features enabled ®  Hardware virtualization support (AMD-V or Intel VT)

B MD No eXecute(NX)

B Intel eXecute Disable (XD)

Note Hardware vendors sometimes disable particular CPU features in the BIOS by default. This
can cause problems in enabling EVC, because the EVC compatibility checks detect the absence of

features that are expected to be present for a particular CPU. If you cannot enable EVC on a system
with a compatible processor, ensure that all features are enabled in the BIOS.

Supported CPUs for ~ To check EVC support for a specific processor or server model, see the VMware Compatibility Guide
the EVC mode that at http://www.vmware.com/resources/compatibility/search.php.
you want to enable

Create an EVC Cluster

Create an EVC cluster to help ensure vMotion compatibility between the hosts in the cluster.
When you create an EVC cluster, use one of the following methods:

B Create an empty cluster, enable EVC, and move hosts into the cluster.

B Enable EVC on an existing cluster.

VMware recommends creating an empty EVC cluster as the simplest way of creating an EVC cluster with
minimal disruption to your existing infrastructure.

Prerequisites

Before you create an EVC cluster, ensure that the hosts you intend to add to the cluster meet the requirements
listed in “EVC Requirements for Hosts,” on page 159.

Procedure
1  Create an empty cluster, and enable EVC.

Select the CPU vendor and EVC mode appropriate for the hosts you intend to add to the cluster. For
information on configuring EVC, see the vSphere Client online Help.

Other cluster features such as vSphere DRS and vSphere HA are fully compatible with EVC. You can
enable these features when you create the cluster. For information on specific cluster options, see the
vSphere Client online Help.

2 Select a host to move into the cluster.

3 If the host feature set is greater than the EVC mode that you have enabled for the EVC cluster, ensure that
the cluster has no powered-on virtual machines.

B Power off all the virtual machines on the host.
B Migrate the host’s virtual machines to another host using vMotion.
4  Move the host into the cluster.

You can power on the virtual machines on the host, or migrate virtual machines into the cluster with
vMotion, if the virtual machines meet CPU compatibility requirements for the cluster’'s EVC mode. Virtual
machines running on hosts with more features than the EVC mode must be powered off before migration
into the cluster.
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5 Repeat Step 3 and Step 4 for each additional host that you want to move into the cluster.

Enable EVC on an Existing Cluster

Enable EVC on an existing cluster to help ensure vMotion compatibility between the hosts in the cluster.

Prerequisites

Before you enable EVC on an existing cluster, ensure that the hosts in the cluster meet the requirements listed
in “EVC Requirements for Hosts,” on page 159.

Procedure
1  Select the cluster for which you want to enable EVC.

2 If virtual machines are running on hosts that have feature sets greater than the EVC mode you intend to
enable, ensure that the cluster has no powered-on virtual machines.

B Power off all the virtual machines on the hosts with feature sets greater than the EVC mode
B Migrate the cluster’s virtual machines to another host using vMotion.

Because these virtual machines are running with more features than the EVC mode you intend to set,
power off the virtual machines to migrate them back into the cluster after enabling EVC.

3 Ensure that the cluster contains hosts with CPUs from only one vendor, either Intel or AMD.
4  Edit the cluster settings and enable EVC.
Select the CPU vendor and feature set appropriate for the hosts in the cluster.

5 If you powered off or migrated virtual machines out of the cluster, power on the virtual machines in the
cluster, or migrate virtual machines into the cluster.

Any virtual machines running with a larger feature set than the EVC mode you enabled for the cluster
must be powered off before they can be moved back into the cluster.

Change the EVC Mode for a Cluster

If all the hosts in a cluster are compatible with the new mode, you can change the EVC mode of an existing
EVC cluster. You can raise the EVC mode to expose more CPU features, or lower the EVC mode to hide CPU
features and increase compatibility.

To raise the EVC mode from a CPU baseline with fewer features to one with more features, you do not need
to turn off any running virtual machines in the cluster. Virtual machines that are running do not have access
to the new features available in the new EVC mode until they are powered off and powered back on. A full
power cycling is required. Rebooting the guest operating system or suspending and resuming the virtual
machine is not sufficient.

To lower the EVC mode from a CPU baseline with more features to one with fewer features, you must first
power off any virtual machines in the cluster that are running at a higher EVC mode than the one you intend
to enable, and power them back on after the new mode has been enabled.

Prerequisites

If you intend to lower the EVC mode, power off any currently running virtual machines with a higher EVC
mode than the one you intend to enable. See “Determine EVC Modes for Virtual Machines,” on page 183.

The cluster cannot contain a disconnected host. All hosts in the cluster must be connected and registered on
the vCenter Server.

Procedure

1  Display the cluster in the inventory.
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2 Right-click the cluster and select Edit Settings.
3 In the left panel, select VMware EVC.

The dialog box displays the current EVC settings.
4  To edit the EVC settings, click Change.

5 From the VMware EVC Mode drop-down menu, select the baseline CPU feature set you want to enable
for the cluster.

If the selected EVC Mode cannot be selected, the Compatibility pane displays the reason or reasons why,
along with the relevant hosts for each reason.

6  Click OK to close the EVC Mode dialog box, and click OK to close the cluster settings dialog box.

Determine EVC Modes for Virtual Machines

The EVC mode of a virtual machine defines the CPU features that the virtual machine can access. The virtual
machine's EVC mode is determined when it is powered on in an EVC-enabled cluster.

When a virtual machine is powered on, it determines the EVC mode of the cluster in which it is running. If the
EVC mode of the cluster is subsequently raised, the virtual machine does not change its EVC mode until it is
powered off and powered on again. This means that the virtual machines does not make use of any additional
CPU features exposed by the new EVC mode of the cluster until the virtual machine has been powered off and
powered on again.

For example, consider a cluster containing hosts with Intel Xeon 45nm Core™ 2 processors that has been set
to the Intel® "Merom" Generation (Xeon® Core™ 2) EVC mode. A virtual machine powered on in this cluster
runs in the Intel "Merom" Generation (Xeon Core 2) EVC mode. If the cluster EVC mode is raised to Intel
"Penryn" Generation (Xeon 45nm Core 2), the virtual machine remains at the lower Intel "Merom" Generation
(Xeon Core 2) EVC mode. To use any of the features exposed by the higher cluster EVC mode, such as SSE4.1,
you must power off the virtual machine and power it on again.

You can use the Virtual Machines tab for a cluster or a host to determine the EVC modes of the running virtual
machines.

Procedure

1  Select the cluster or host in the inventory.

2 Click the Virtual Machines tab.

3 If the EVC Mode column is not displayed, right-click on the column titles and select EVC Mode.

The EVC modes of all running or suspended virtual machines are displayed in the EVC Mode column.
Powered off virtual machines and virtual machines that are not in EVC clusters show N/A as the EVC
mode.

Prepare Clusters for AMD Processors Without 3DNow!

Newer generations of AMD processors do not include 3DNow! processor instructions. If hosts in a cluster have
different generations of AMD processors, some with 3DNow! instruction sets and some without, you cannot
successfully migrate virtual machines between the hosts. You must use an EVC mode or CPU compatibility
mask to hide the instructions.

The vCenter Server AMD Opteron Gen. 3 (no 3DNow!) EVC mode masks the 3DNow! instructions from
virtual machines. You can apply this EVC mode to EVC clusters containing only AMD Opteron Generation 3
hosts to allow the clusters to maintain vMotion compatibility with AMD Opteron hosts that do not have
3DNow! instructions. Clusters containing AMD Opteron Generation 1 or AMD Opteron Generation 2 hosts
cannot be made vMotion-compatible with hosts that do not have 3DNow! instructions.
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Prerequisites

Ensure that the cluster contains only hosts with AMD Opteron Generation 3 or newer processors.
Procedure

¢ Enable the AMD Opteron Gen. 3 (no 3DNow!) EVC mode for your EVC cluster.

The steps to enable the EVC mode differ depending on whether you are creating a cluster or enabling the
mode on an existing cluster, and on whether the existing cluster contains powered-on virtual machines.

Option Description

Creating a new cluster In the New Cluster wizard, enable EVC for AMD hosts and select the AMD
Opteron Gen. 3 (no 3DNow!) EVC mode.

Editing a cluster without powered-on  In the Cluster Settings dialog box, edit the VMware EVC settings and select
virtual machines the AMD Opteron Gen. 3 (no 3DNow!) EVC mode.

Editing a cluster with powered-on The AMD Opteron Gen. 3 (no 3DNow!) EVC mode cannot be enabled while
virtual machines there are powered-on virtual machines in the cluster.
a Power-off any running virtual machines in the cluster, or migrate them
out of the cluster using vMotion.

Migrating the virtual machines out of the cluster with vMotion allows
you to delay powering off the virtual machines until a more convenient
time.

b In the Cluster Settings dialog box, edit the VMware EVC settings and
select the AMD Opteron Gen. 3 (no 3DNow!) EVC mode.

¢ If you migrated virtual machines out of the cluster, power them off and
cold migrate them back into the cluster.

d Power on the virtual machines.

You cannow add hosts with AMD processors without 3DNow! instructions to the cluster and preserve vMotion
compatibility between the new hosts and the existing hosts in the cluster.

CPU Compatibility Masks

CPU compatibility masks allow per-virtual machine customization of the CPU features visible to a virtual
machine.

vCenter Server compares the CPU features available to a virtual machine with the CPU features of the
destination host to determine whether to allow or disallow migrations with vMotion.

Default values for the CPU compatibility masks are set by VMware to guarantee the stability of virtual
machines after a migration with vMotion.

In some cases, where a choice between CPU compatibility or guest operating system features (such as NX/XD)
exists, VMware provides check-box options to configure individual virtual machines through the virtual
machine’s Advanced Settings option. For more control over the visibility of CPU features, you can edit the
virtual machine’s CPU compatibility mask at the bit level.

CautioN Changing the CPU compatibility masks can result in an unsupported configuration. Do not manually
change the CPU compatibility masks unless instructed to do so by VMware Support or a VMware Knowledge
base article.
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CPU compatibility masks cannot prevent virtual machines from accessing masked CPU features in all
circumstances. In some circumstances, applications can detect and use masked features even though they are
hidden from the guest operating system. In addition, on any host, applications that use unsupported methods
of detecting CPU features rather than using the CPUID instruction can access masked features. Virtual
machines running applications that use unsupported CPU detection methods might experience stability
problems after migration.
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View CPUID Details for an EVC Cluster

The feature set exposed by an EVC cluster corresponds to the feature set of a particular type of processor.
Processor feature sets can be described by a set of feature flags that you can examine using the CPUID
instruction.

You can view the CPUID feature flags currently exposed by the hosts in an EVC cluster using the Current
CPUID Details dialog box.

Procedure
1  Display the cluster in the inventory.
Right-click the cluster and select Edit Settings.

In the left panel, select VMware EVC.

B~ W DN

To view the CPUID feature flags currently enforced by EVC, click Current CPUID Details.

The Current CPUID Details dialog box displays the CPUID feature flags that EVC is enforcing for the hosts in
this cluster. For more information on CPUID feature flags, see Intel Processor Identification and the CPUID
Instruction (available from Intel), or CPUID Specification (available from AMD).

About Migration Compatibility Checks

During migration, the Migrate Virtual Machine wizard checks the destination host for compatibility with the
migrating virtual machine using a number of criteria.

When you select a host, the Compatibility panel at the bottom of the Migrate Virtual Machine wizard displays
information about the compatibility of the selected host or cluster with the virtual machine’s configuration.

If the virtual machine is compatible, the panel displays the message, Validation succeeded. If the virtual
machine is not compatible with either the host’s or cluster’s configured networks or datastores, the
compatibility window can display both warnings and errors:

B Warning messages do not disable migration. Often the migration is justified and you can continue with
the migration despite the warnings.

B Errors can disable migration if there are no error-free destination hosts among the selected destination
hosts. In this case, the Next button is disabled.

For clusters, the network and datastore configurations are taken into account when checking compatibility
issues. For hosts, the individual host’s configuration is used. A possible problem might be that vMotion is not
enabled on one or both hosts.

A specific host CPU feature’s effects on compatibility are dependent on whether ESXi exposes or hides them
from virtual machines.

B Features that are exposed to virtual machines are not compatible when they are mismatched.
B Features that are not exposed to virtual machines are compatible regardless of mismatches.

Specific items of virtual machine hardware can also cause compatibility issues. For example, a virtual machine
using an enhanced vmxnet virtual NIC cannot be migrated to a host running a version of ESXi that does not
support enhanced vmxnet.
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Migrate a Powered-Off or Suspended Virtual Machine in the vSphere
Client

You can use the Migration wizard to migrate a powered-off virtual machine or suspended virtual machine.
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Procedure

1
2

Select the virtual machine that you want to migrate in the inventory.
Right-click on the virtual machine and select Migrate from the pop-up menu.

Select the migration type and click Next.

Option Description

Change host Move the virtual machine to another host.

Change datastore Move the virtual machine’s configuration file and virtual disks.

Change both host and datastore Move the virtual machine to another host and move its configuration file and
virtual disks.

To move the virtual machine to another host, select the destination host or cluster for this virtual machine
migration and click Next.

Any compatibility problem appears in the Compatibility panel. Fix the problem, or select another host or
cluster.

Possible targets include hosts and DRS clusters with any level of automation. If a cluster has no DRS
enabled, select a specific host in the cluster rather than selecting the cluster itself.

Select the destination resource for the virtual machine migration.

If you chose to move the virtual machine’s configuration file and virtual disks, select a disk format.

Option Description
Same as Source Use the format of the original virtual disk.
Thin provisioned Use the thin format to save storage space. The thin virtual disk uses just as

much storage space as it needs for its initial operations. When the virtual disk
requires more space, it can expand up to its maximum allocated capacity.

Thick Allocate a fixed amount of hard disk space to the virtual disk. The virtual
disk in the thick format does not change its size and from the beginning
occupies the entire datastore space provisioned to it.

Disks are converted from thin to thick format or thick to thin format only when they are copied from one
datastore to another. If you leave a disk in its original location, the disk format is not converted, regardless
of the selection made here.
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7 Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine filesinthe a (Optional) Apply a virtual machine storage profile for the virtual
same location on a datastore. machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list shows which datastores are compatible and which are
incompatible with the selected virtual machine storage profile.

b Select a datastore and click Next.

Store all virtual machine filesinthe a (Optional) Apply a virtual machine storage profile for the virtual
same datastore cluster. machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list shows which datastores are compatible and which are
incompatible with the selected virtual machine storage profile.

b  Select a datastore cluster.

¢ (Optional) If you do not want to use Storage DRS with this virtual
machine, select Disable Storage DRS for this virtual machine and select
a datastore within the datastore cluster.

d Click Next.

Store virtual machine configuration a Click Advanced.

files and disks in separate locations. |,  For the virtual machine configuration file and for each virtual disk, click
Browse and select a datastore or datastore cluster.

¢ (Optional) Apply a virtual machine storage profile from the VM Storage
Profile drop-down menu.

The list shows which datastores are compatible and which are
incompatible with the selected virtual machine storage profile.

d (Optional) If you selected a datastore cluster and do not want to use
Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the datastore cluster.

e Click Next.

8  Review the page and click Finish.

vCenter Server moves the virtual machine to the new host. Event messages appear in the Events tab. The data
displayed on the Summary tab shows the status and state throughout the migration. If errors occur during
migration, the virtual machines revert to their original states and locations.

Migrate a Powered-On Virtual Machine with vMotion in the vSphere
Client

You can use the Migration wizard to migrate a powered-on virtual machine from one host to another using
vMotion technology. To relocate the disks of a powered-on virtual machine, migrate the virtual machine using
Storage vMotion.

Prerequisites

Before migrating a virtual machine with vMotion, ensure that your hosts and virtual machines meet the
requirements for migration with vMotion.

B “Host Configuration for vMotion,” on page 153

B Virtual Machine Configuration Requirements for vMotion in the vSphere Client
Procedure

1  Select the virtual machine that you want to migrate in the inventory.

2 Right-click on the virtual machine and select Migrate from the pop-up menu.
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Select Change host and click Next.

Select a destination host or cluster for the virtual machine.

Any compeatibility problem appears in the Compatibility panel. Fix the problem, or select another host or

cluster.

Possible targets include hosts and fully automated DRS clusters. You can select a non-automated cluster

as a target. You are prompted to select a host within the non-automated cluster.

Select a resource pool and click Next.

Select the migration priority level and click Next.

Option

Description

High Priority

On hosts running ESX/ESXi version 4.1 or later, vCenter Server attempts to
reserve resources on both the source and destination hosts to be shared
among all concurrent migrations with vMotion. vCenter Server grants a
larger share of host CPU resources to high priority migrations than to
standard priority migrations. Migrations always proceed regardless of the
resources that have been reserved.

On hosts running ESX/ESXi version 4.0 or earlier, vCenter Server attempts
to reserve a fixed amount of resources on both the source and destination
hosts for each migration. High priority migrations do not proceed if
resources are unavailable.

Standard Priority

On hosts running ESX/ESXi version 4.1 or later, vCenter Server reserves
resources on both the source and destination hosts to be shared among all
concurrent migration with vMotion. vCenter Server grants a smaller share
of host CPU resources to standard priority migrations than to high priority
migrations. Migrations always proceed regardless of the resources that have
been reserved.

On hosts running ESX/ESXi version 4.0 or earlier, vCenter Server attempts
to reserve a fixed amount resources on the source and destination hosts for
each migration. Standard priority migrations always proceed. However, the
migration might proceed more slowly or fail to complete if sufficient
resources are not available.

Review the page and click Finish.

A task is created that begins the virtual machine migration process.

Migrate a Virtual Machine with Storage vMotion in the vSphere Client

Use migration with Storage vMotion to relocate a virtual machine’s configuration file and virtual disks while
the virtual machine is powered on.

You cannot change the virtual machine’s execution host during a migration with Storage vMotion.

Select the virtual machine that you want to migrate in the inventory.

Right-click on the virtual machine and select Migrate from the pop-up menu.

Procedure

1

2

3 Select Change datastore and click Next.

188

VMware, Inc.



4  Select a disk format.

Chapter 13 Migrating Virtual Machines in the vSphere Client

Option

Description

Same as Source

Use the format of the original virtual disk.

Thin provisioned

Use the thin format to save storage space. The thin virtual disk uses just as
much storage space as it needs for its initial operations. When the virtual disk
requires more space, it can expand up to its maximum allocated capacity.

Thick

Allocate a fixed amount of hard disk space to the virtual disk. The virtual
disk in the thick format does not change its size and from the beginning
occupies the entire datastore space provisioned to it.

5  Select the datastore location where you want to store the virtual machine files.

Option

Action

Store all virtual machine files in the
same location on a datastore.

a

(Optional) Apply a virtual machine storage profile for the virtual
machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list shows which datastores are compatible and which are
incompatible with the selected virtual machine storage profile.

Select a datastore and click Next.

Store all virtual machine files in the
same datastore cluster.

(Optional) Apply a virtual machine storage profile for the virtual
machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list shows which datastores are compatible and which are
incompatible with the selected virtual machine storage profile.

Select a datastore cluster.

(Optional) If you do not want to use Storage DRS with this virtual
machine, select Disable Storage DRS for this virtual machine and select
a datastore within the datastore cluster.

Click Next.

Store virtual machine configuration

files and disks in separate locations.

Click Advanced.
For the virtual machine configuration file and for each virtual disk, click
Browse and select a datastore or datastore cluster.

(Optional) Apply a virtual machine storage profile from the VM Storage
Profile drop-down menu.

The list shows which datastores are compatible and which are
incompatible with the selected virtual machine storage profile.
(Optional) If you selected a datastore cluster and do not want to use
Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the datastore cluster.

Click Next.

6  Review the page and click Finish.

Limits on Simultaneous Migrations

vCenter Server places limits on the number of simultaneous virtual machine migration and provisioning
operations that can occur on each host, network, and datastore.

Each operation, such as a migration with vMotion or cloning a virtual machine, is assigned a resource cost.
Each type of resource, such as host, datastore, or network, has a maximum cost that it can support at any one
time. Any new migration or provisioning operation that would cause a resource to exceed its maximum cost
does not proceed immediately, but is queued until other operations complete and release resources. Each of
the network, datastore, and host limits must be satisfied for the operation to proceed.

VMware, Inc.
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Network Limits

Network limits apply to migrations with vMotion only. Network limits depend on both the version of ESXi
and the network type.

Table 13-1 lists network limits for migration with vMotion.

Table 13-1. Network Limits for Migration with vMotion

Operation ESX/ESXi Version Network Type Maximum Cost
vMotion 3.x 1GigE and 10GigE 2
vMotion 4.0 1GigE and 10GigE 2
vMotion 4.1,5.0 1GigE 4
vMotion 41,50,51 10GigE 8

All migrations with vMotion have a network resource cost of 1.

Datastore Limits

Datastore limits apply to migrations with vMotion and with Storage vMotion. A migration with vMotion
involves one access to the datastore. A migration with storage vMotion involves one access to the source
datastore and one access to the destination datastore.

Table 13-2 lists datastore limits for migration with vMotion and Storage vMotion. Table 13-3 lists the datastore
resource costs for migration with vMotion and Storage vMotion.

Table 13-2. Datastore Limits for Migration with vMotion and Storage vMotion

Operation ESX/ESXi Version Maximum Cost
vMotion/Storag ~ 3.x 8

e vMotion

vMotion/Storag 4.0 8

e vMotion

vMotion/Storag 4.1, 5.0, 5.1 128

e vMotion

Table 13-3. Datastore Resource Costs for vMotion and Storage vMotion

Operation ESX/ESXi Version Datastore Resource Cost
vMotion 3.x 1

vMotion 4.0 1

vMotion 4.1 1

Storage vMotion 3.x 1

Storage vMotion 4.0 1

Storage vMotion 4.1,5.0,5.1 16

Host Limits

Host limits apply to migrations with vMotion, Storage vMotion, and other provisioning operations such as
cloning, deployment, and cold migration.

Table 13-4 lists the host limits for migrations with vMotion, migrations with Storage vMotion, and provisioning
operations. Table 13-5 lists the host resource cost for these operations.
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Table 13-4. Host Limits for vMotion, Storage vMotion, and Provisioning Operations

Operation ESX/ESXi Version Maximum Cost
vMotion 3.x,4.0,4.1,5.0,5.1 2,2,8,8, 8, respectively
Storage vMotion 3.x,4.0,4.1,5.0,5.1 2

other provisioning operations 3.x,4.0,4.1,5.0,5.1 8

Table 13-5. Host Resource Costs for vMotion, Storage vMotion, and Provisioning Operations

Operation ESX/ESXi Version Host Resource Cost
vMotion 3.x 4
vMotion 4.0 4
vMotion 4.1,5.0,5.1 1
Storage vMotion 3.x 4
Storage vMotion 4.0 4
Storage vMotion 4.1,5.0,51 4
other provisioning operations 3.x,4.0,4.1,5.0,5.1 1
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Using vCenter Maps

A vCenter map is a visual representation of your vCenter Server topology. Maps show the relationships
between the virtual and physical resources available to vCenter Server.

Maps are available only when the vSphere Client is connected to a vCenter Server system.

The maps can help you determine such things as which clusters or hosts are most densely populated, which
networks are most critical, and which storage devices are being utilized. vCenter Server provides the following

map views.

Virtual Machine Displays virtual machine-centric relationships.
Resources

Host Resources Displays host-centric relationships.

Datastore Resources Displays datastore-centric relationships.
vMotion Resources Displays hosts available for vMotion migration.

You can use a map view to limit or expand the scope of a map. You can customize all map views, except
vMotion Resources maps. If you are accessing map views using the navigation bar, all vCenter Server resources
are available for display. If you are using the Maps tab of a selected inventory item, only items related to that
item are displayed. For virtual machine inventory items, the vMotion Resources view is the only map view
available on the Maps tab.

You can customize a map view by selecting or deselecting objects in the inventory pane or by selecting or
deselecting options in the Map Relationships area.

You can reposition the map by dragging it (click and hold anywhere on the map and drag the map to the new
location). A grey box in the overview area represents the section of the total map that is viewable and moves
as you drag the map. You can resize the grey box to zoom in or out of a section of the map.

You can double-click any object in a map to switch to the Map tab for that item (providing a Map tab is available
for that type of object).

Right-click on any object in a map to access its context menu.
This chapter includes the following topics:

B “Set the Maximum Number of Map Objects,” on page 194
B “vCenter vMotion Maps,” on page 194

B “vyCenter Map Icons and Interface Controls,” on page 194
B “View vCenter Maps,” on page 195

B “Print vCenter Maps,” on page 196

B “Export vCenter Maps,” on page 196
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Set the Maximum Number of Map Objects

In large environments, maps can be slow to load and difficult to read. You can set the maximum number of
objects maps can display so that maps load more quickly and are easier to read.

Procedure

1  In the vSphere Client, select Edit > Client Settings > Maps tab.

2 Enter the maximum number of objects you want maps to display.
3 Click OK.

When a user attempts to view a map that has more objects than the specified limit, the user encounters a
message that provides the option to cancel the map or to proceed with displaying it.

vCenter vMotion Maps

vMotion resource maps provide a visual representation of hosts, datastores, and networks associated with the
selected virtual machine.

vMotion resource maps also indicate which hosts in the virtual machine’s cluster or datacenter are compatible
with the virtual machine and are potential migration targets. For a host to be compatible, it must meet the
following criteria.

B Connect to all the same datastores as the virtual machine.
B Connect to all the same networks as the virtual machine.
B Have compatible software with the virtual machine.

B Have a compatible CPU with the virtual machine.

Note The vMotion map provides information as to whether vMotion might be possible, and if not, what an
administrator might do to remedy the situation. It does not guarantee that a particular vMotion migration will
be successful.

Hosts marked with a red X are unsuitable candidates for migration. A lack of edges connecting that host and
the virtual machine's networks and datastores indicate that the host is unsuitable because of networking or
datastore incompatibility. If the unsuitability is because of CPU or software incompatibility, the information
appears in a tooltip when the pointer hovers over the host in question.

It might take a few seconds for the map to retrieve load, CPU, and software information. The state of the map's
information retrieval process appears in the lower-left corner of the map. As information arrives, the map is
updated. A host that looks like a good vMotion candidate (displayed as green) might become a bad candidate
(displayed as red) as information is collected.

vCenter Map Icons and Interface Controls

Resource maps are visual representations of your datacenter topology. Each icon in a resource map represents
a managed object or its current state. Controls in the Maps tab enable you to work with the current resource
map.

Map Icons

The icons in a resource map represent the objects in the inventory and their current state. Table 14-1 describes
the map icons.
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Table 14-1. Resource Map Icons

Icon

Description

&

Host icon.

g

A host that is compatible for vMotion migration. The color of the circle varies in intensity based
on the load of the current host. Heavily used hosts are pale; low-load hosts are saturated green.

=

A host that is not compatible for vMotion migration.

-

3

Virtual machine icon. When the virtual machine is powered on, the icon contains a green
triangle.

R

Network icon.

S

Datastore icon.

Map Interface Controls

Use the controls in the Maps tab to customize map relationships, refresh map views, and move the focus of
the current map. Table 14-2 describes the controls located on the Maps tab.

Table 14-2. Resource Map Interface Controls

Map Interface Panel

Description

Overview panel

Thumbnail graphic of the full-scale map.

Map Relationships panel

Displayed when more than one map view is available. The Map Relationships panel lets you
customize map relationships for hosts and virtual machines. Use the checkboxes to enable or
disable relationships for the selected object and display them in the current resource map.

Refresh link

Maps do not auto-refresh. Click Refresh to synchronize your map with the current state of the
inventory and to center the map view.

Inventory panel

When selecting through the Inventory navigation bar, a selected item stays highlighted to
indicate map focus.

When selecting through the Maps navigation bar, all items in the inventory are listed with a
check box. You can select or deselect any inventory items you do not want included in the map.

View vCenter Maps

Resource maps enable you to view the relationships among hosts, clusters, and virtual machines. You can view
aresource map for an entire vCenter Server system or for a specific object, such as a datacenter or cluster. Maps
for specific objects show only the object relationships for that object.

Procedure

1  Display the object in the inventory.
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Select the object and click the Maps tab.

For example, to display the resource map for your entire vCenter Server system, select the

vCenter Server in the inventory panel. To display the resource map for a host, select the host in the

inventory panel.

Print vCenter Maps

You can print resource maps to any standard printer.

Perform this procedure on the vSphere Client Map tab.

Procedure

1  Select File > Print Maps > Print.

2 In the printer Name list, select the printer.
3 Click Print.

Export vCenter Maps

196

Exporting a resource map saves the map to an image file.

Perform this procedure on the vSphere Client Map tab.

Procedure

1
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If necessary, view the resource map.

Select File > Export > Export Maps.

Navigate to the location to save the file.

Type a name for the file and select a file format.

Click Export.
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Automating Management Tasks in the
vSphere Web Client by Using vCenter
Orchestrator

VMware vCenter™ Orchestrator is a development- and process-automation platform that provides a library
of extensible workflows. By using the workflow library you can create and run automated, configurable
processes to manage the vSphere infrastructure as well as other VMware and third-party technologies.

Orchestrator exposes every operation in the vCenter Server API and so that you can integrate all of these
operations into your own automated processes.

If you have a running vCenter Orchestrator server, and you have configured it to work with the vCenter Server
instances registered with your vSphere Web Client, you can use the vSphere Web Client to run and schedule
workflows on the objects in your vSphere infrastructure.

This chapter includes the following topics:

B “Concepts of Workflows,” on page 197

B “Performing Administration Tasks on the vSphere Objects,” on page 198

B “Discover Non-Registered Orchestrator Servers,” on page 199

B “Configure the Default vCenter Orchestrator,” on page 199

B “Managing Associations of Workflows with vSphere Inventory Objects,” on page 200
B “Managing Workflows,” on page 201

B “Workflows for Managing Inventory Objects in the vSphere Web Client,” on page 207

Concepts of Workflows

A workflow is a series of actions and decisions that you run sequentially. Orchestrator provides a library of
workflows that perform common management tasks according to best practices.

Basics of Workflows

Workflows consist of a schema, attributes, and parameters. The workflow schema is the main component of a
workflow as it defines all the workflow elements and the logical connections between them. The workflow
attributes and parameters are the variables that workflows use to transfer data. Orchestrator saves a workflow
token every time a workflow runs, recording the details of that specific run of the workflow.

The vSphere Web Client allows you run and schedule workflows on selected objects from your vSphere
inventory. You cannot create, delete, edit and manage workflows in the vSphere Web Client. You develop and
manage workflows in the Orchestrator client. For more information about the Orchestrator client, see Using
the VMuware vCenter Orchestrator Client. For information about developing workflows, see Developing with
VMuware vCenter Orchestrator.
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Input Workflow Parameters

Most workflows require a certain set of input parameters to run. An input parameter is an argument that the

workflow processes when it starts. The user, an application, or another workflow or an action passes input
parameters to a workflow, for the workflow to process when it starts.

For example, if a workflow resets a virtual machine, the workflow requires as an input parameter the name of

the virtual machine to reset.

Output Workflow Parameters

Workflow's output parameters represent the result from the workflow run. Output parameters can change
when a workflow or a workflow element runs. While they run, workflows can receive the output parameters
of other workflows as input parameters.

For example, if a workflow creates a snapshot of a virtual machine, the output parameter for the workflow is
the resulting snapshot.

Workflow Presentation

When you start a workflow in the vSphere Web Client, the client loads the workflow presentation. You provide
the input parameters of the workflow in the workflow presentation.

User Interaction

Some workflows require interactions from users during their run and suspend either until the user provides

the required information or until the workflow times out.

Performing Administration Tasks on the vSphere Objects

By using the Orchestrator view in the vSphere Web Client you can perform your administration tasks such as
running and scheduling workflows, and viewing the list of available workflows.

From the Orchestrator view in the vSphere Web Client, you can perform the following tasks:

B Select a default Orchestrator server.

B Manage workflows. Managing workflows includes the following tasks:

Associating workflows with selected vSphere inventory objects such as virtual machines, ESXi hosts,
clusters, resource pools, and folders.

Exporting and importing current associations of workflows with vSphere inventory objects for
backup purposes or to import them in another vSphere Web Client instance.

Editing associations of workflows with vSphere inventory objects such as virtual machines, ESXi
hosts, clusters, resource pools, folders, and so on.

Viewing information about workflow runs, as well as about workflows waiting for user interaction.

Running and scheduling workflows on vSphere objects.

To run workflows on selected vSphere inventory objects, you must select a default Orchestrator server. You
should also associate the workflows of the default Orchestrator server with vSphere inventory objects that you
want to manage.
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Discover Non-Registered Orchestrator Servers

If you install Orchestrator together with vCenter Server and if at the time of Orchestrator installation vCenter
Server is not up and running, the Orchestrator server cannot be registered as a vCenter Server extension and
is not automatically discovered in the vSphere Web Client.

To enable the usage of Orchestrator servers that were not registered as vCenter Server extension and configure
one of them as a default server, you must first discover the Orchestrator servers.

Prerequisites

Log in as a member of the Administrators group to be able to configure the default Orchestrator server.

Procedure
1  Log in to the vSphere Web Client.
2 In the object navigator, click vCenter Orchestrator.
3  Click the Summary tab.
A list of the available vCenter Orchestrator servers appears.
4  Click Discover.

The Orchestrator servers that were not registered as vCenter Server extensions are displayed in the list of
Orchestrator servers.

What to do next

You can configure the default Orchestrator server to use.

Configure the Default vCenter Orchestrator

If you have configured more than one Orchestrator server to work with a vCenter Server instance that is
registered with your vSphere Web Client, you should configure the default Orchestrator server to use with the
vCenter Server instance.

You cannot run workflows on the objects in a vCenter Server instance if it is not added as a vCenter Server
host to the Orchestrator server.

Prerequisites

Log in as a member of the Administrators group to be able to configure the default Orchestrator server.

Procedure
1 Login to the vSphere Web Client.
2 In the object navigator, click vCenter Orchestrator.
3 Click vCO Servers.
A list of the available vCenter Orchestrator servers appears.
4  Right-click a vCenter Orchestrator server and select Edit configuration.

5 Inthe Edit vCenter Orchestrator connections dialog box, select the default Orchestrator server to manage
your vCenter Server instance.

6 Click OK.

You successfully configured a default vCenter Orchestrator server in the vSphere Web Client.
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Managing Associations of Workflows with vSphere Inventory Objects

If you want to see more workflows displayed in the pop-up menu when you right-click a vSphere inventory
object, and run these workflows on more object types, you can associate workflows with the different vSphere
object types.

You can add and edit associations, as well as export and import XML files containing the associations of
workflows with vSphere objects.

Workflows associated with inventory object types are listed in the pop-up menu that appears when you right-
click the inventory objects and in the Actions menu.

Only users from the Orchestrator Administrator group have the rights to manage the associations of workflows
with vSphere inventory objects.

Associate Workflows with vSphere Inventory Object Types

200

You can associate workflows with a vSphere object type to run the workflows directly on the inventory objects
of that type.

Workflows associated with inventory object types are listed in the pop-up menu that appears when you right-
click an inventory object, and in the Actions menu.

Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure
1  In the object navigator, click vCenter Orchestrator.
2 Click the Manage tab.

3 %
Click the Add icon to add a new workflow.

4  Select the Orchestrator server from the vCO Servers tree, and navigate through the workflow library to
find the workflow to add.

5 Click Add.

The workflow appears in the list of selected workflows on the right.
6  (Optional) Enable multi-selection.

Multi-selection allows you to select multiple vSphere objects of the same type when you run the workflow.
7 Under Available types, select the vSphere object types with which you want to associate the workflow.
8 Click OK.

Edit the Associations of Workflows with vSphere Objects

You can associate a workflow with different objects from the vSphere inventory and also edit the associations
of workflows with the objects from the vSphere inventory.

Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.
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Procedure

1  In the object navigator, click vCenter Orchestrator.
Click the Manage tab.

Right-click the workflow to edit and select Edit.

Change the association properties.
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Click OK.

Export the Associations of Workflows with vSphere Objects

You can transfer the associations of workflows with objects in the vSphere inventory from one
vSphere Web Client to another by using an XML file.

Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure
1  In the object navigator, click vCenter Orchestrator.
2 Click the Manage tab.

3
Click the Export icon L=,

4  Select a location where you want to save the XML file, and click Save.

Import the Association of Workflows with vSphere Objects

You can import an XML file that contains the association of workflows with objects in the vSphere inventory.

Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure
1 In the object navigator, click vCenter Orchestrator.
2 Click the Manage tab.

3
Click the Import icon 4=,

4  Browse to select the XML file to import and click Open.

Orchestrator compares the two associated workflow sets and imports the missing workflow associations.

Managing Workflows

You can view different information about Orchestrator workflows, run and schedule workflows and manage
them by using the vSphere Web Client.

You can perform some management tasks on the Orchestrator workflows from the vCenter Orchestrator view
in the vSphere Web Client. You can also perform some of the tasks by right-clicking a vSphere inventory object
and selecting All vCenter Orchestrator Actions.
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Workflow management tasks include:

B Running workflows on vSphere inventory objects, such as virtual machines, ESXi hosts, clusters, resource
pools, and folders.

B Viewing information about workflow runs.
B Viewing information about workflows waiting for user interaction.
B Searching for a specific workflow from the list of available workflows.

B Scheduling workflows.

Run Workflows on vSphere Inventory Objects

You can automate management tasks in vSphere by running Orchestrator workflows directly on objects from
the vSphere inventory.

Prerequisites

B Verify that you have at least one running Orchestrator server configured to work with the
vCenter Server instance that is registered with your vSphere Web Client.

B Verify that you have workflows associated with the vSphere inventory objects. See “Associate Workflows
with vSphere Inventory Object Types,” on page 200.

Procedure
1 Click vCenter.
2 Under Inventory Lists, click an inventory category.

3 Right-click the object that you want to run the workflow on, and navigate to All vCenter Orchestrator
Actions.

All available workflows that you can run on the selected inventory object are listed.
4  Click the workflow that you want to run.
5 Provide the required workflow parameters.
6  (Optional) Schedule the workflow to run at a specified time.
a  Inthe Task name text box, type the name of the scheduled task.
b  (Optional) In the Description text box, type a description of the scheduled task.
¢ Schedule the date and time of the workflow run.
d  Specify the recurrence options.

7  Click Finish.

View Information About Workflow Runs

You can view information about the workflow runs for each connected Orchestrator server. The available
information includes the workflow name, start and end date, state of the workflow, and user who started the
workflow.

Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure

1  In the object navigator, click vCenter Orchestrator.
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2 Click vCO Servers.
A list of the available vCenter Orchestrator servers appears.
3 Click a vCenter Orchestrator server, and click the Monitor tab.

The list of workflow runs appears.

What to do next

You can review the list of workflow runs, cancel a running workflow, or respond to a workflow that requires
interaction.

View Information About the Runs of a Specific Workflow

You can view information about the runs of a single workflow such as start and end date, state of the workflow,
and user who has started the workflow.

Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure
1 In the object navigator, click vCenter Orchestrator.
2 Under Inventory Lists, click Workflows.
A list of the available workflows appears.
3 Click the name of a workflow, and click the Monitor tab.

A list of workflow runs appears.

What to do next

You can review the list of workflow runs, cancel a running workflow, or respond to a workflow that requires
interaction.

View Workflows that Are Waiting for User Interaction
You can view the workflows that are waiting for a user interaction.

Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure

1 In the object navigator, click vCenter Orchestrator.

2 Under Inventory lists, click Waiting for interaction.

A list of workflows that are waiting for a user interaction appears.
What to do next

You can provide values for the required parameters of workflows that are waiting for a user interaction.
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Searching for Workflows
You can browse for workflows in the inventory of the Orchestrator server or filter the available workflows by
a search keyword to find a particular workflow.
Browse the Inventory of the Orchestrator Server

You can view the available workflows in the inventory of each connected Orchestrator server. You can search
for a particular type of workflow by browsing the workflow categories.

Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure
1  In the object navigator, click vCenter Orchestrator.
2 Click vCO Servers.
A list of the available vCenter Orchestrator servers appears.
3 Double-click a vCenter Orchestrator server.
4  Click Categories.
5 Double-click Library.

Note Library is the default main workflow category. An Orchestrator server can have additional custom
workflow categories.

6  Click Categories.
A list of available workflow categories appears.

7 Double-click a workflow category to browse the available workflows and its subcategories.

Find a Workflow
If you have a large number of workflows, you can filter them by a search keyword to find a specific workflow.
Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure

1 In the object navigator, click vCenter Orchestrator.

2 Click Workflows.

3 In the Filter text box, type a search term or the name of the workflow that you are searching for.

A list displays workflows that contain the search term in the workflow name or description.
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Scheduling Workflows

You can create tasks to schedule workflows, edit scheduled tasks, suspend scheduled tasks, and resume
suspended scheduled tasks.

Schedule a Workflow

You can schedule a workflow to run at a specified time. You can also set the recurrence for a scheduled
workflow.

Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure

1  In the object navigator, click vCenter Orchestrator.

Under Inventory Lists click Workflows.

Right-click the workflow that you want to schedule and select Schedule a workflow.
Provide the required workflow parameters.

Click Start/Schedule.

In the Task name text box, type the name of the scheduled task.

(Optional) In the Description text box, type a description of the scheduled task.

Schedule the date and time of the workflow run.

O 0 NN o O ks W N

Specify the recurrence options.

—_
)

Click Finish.

Edit the Schedule of a Workflow

You can modify the schedule of a workflow and set it to run at an earlier or later time.

Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure

1  In the object navigator, click vCenter Orchestrator.

2 Click Scheduled workflows.

A list of the scheduled workflows appears.

Right-click the workflow whose schedule you want to edit and select Edit.

In the Task name text box, type the new name of the scheduled task.
(Optional) In the Description text box, type a description of the scheduled task.
Edit the scheduled date and time of the workflow run.

Specify the recurrence options.

x® NN o O s~ W

Click Finish.
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Run a Scheduled Workflow

You can manually run a scheduled workflow before it runs automatically.

When you run a workflow manually, the schedule is not affected. After the manual run, the workflow runs
again at the scheduled time.

Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure
1  In the object navigator, click vCenter Orchestrator.
2 Click Scheduled workflows.
A list of the scheduled workflows appears.
3 Click Scheduled workflows.
4  Right-click the workflow that you want to run and select Run now.
What to do next
You can view information about the workflow run in the Recent Tasks pane or in the Orchestrator server menu.
See “View Information About Workflow Runs,” on page 202.
Suspend a Scheduled Task
You can suspend a scheduled workflow run. You can also resume suspended scheduled tasks.
Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure
1  In the object navigator, click vCenter Orchestrator.
2 Click Scheduled workflows.
A list of the scheduled workflows appears.
3 Right-click the workflow whose schedule you want to suspend and select Suspend.

The state of the scheduled task changes to Suspended.

Resume a Suspended Scheduled Task
You can resume a scheduled task that has been suspended.
Prerequisites

Verify that you have at least one running Orchestrator server configured to work with the vCenter Server
instance that is registered with your vSphere Web Client.

Procedure

1  In the object navigator, click vCenter Orchestrator.
2 Click Scheduled workflows.

A list of the scheduled workflows appears.
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3 Right-click the workflow whose schedule you want to resume from suspension and select Resume.

The state of the scheduled task changes to Pending.

Workflows for Managing Inventory Objects in the vSphere Web Client

The default workflows for managing vSphere inventory objects are the workflows included in the vCenter
Server 5.1 plug-in workflow library. The vCenter Server 5.1 plug-in workflow library contains workflows that
you can use to run automated processes related to the vCenter Server and host management.

Workflows in the vSphere Web Client are accessible only when you have at least one running Orchestrator
server configured to work with the vCenter Server instance that is registered with your vSphere Web Client.

The common workflow to access the available workflows is the following:
1  Register a vCenter Server instance with the vSphere Web Client.

For instructions about how to register vCenter Server with the vSphere Web Client see “Register a vCenter
Server System with the vSphere Web Client,” on page 26.

2 Configure the Orchestrator server to work with the vCenter Server instance you have registered with the
vSphere Web Client.

You can configure Orchestrator to work with a vCenter Server instance by adding the vCenter Server
instance as a host in the Orchestrator plug-in for vCenter Server. For instructions about configuring the
vCenter Server plug-in, see Installing and Configuring VMuware vCenter Orchestrator.

3 Inthe vSphere Web Client, configure the default Orchestrator server to use.

For instructions about configuring the default Orchestrator server, see “Configure the Default vCenter
Orchestrator,” on page 199.

4  (Optional) To see more workflows when you right-click an object from your vSphere inventory, you can
associate workflows with different object types.

For instructions, see “Associate Workflows with vSphere Inventory Object Types,” on page 200.

5 Right-click a vSphere inventory object, such as a virtual machine, host, cluster, folder, datastore, resource
pool, and so on, and select All vCenter Orchestrator Actions.

Note Only a predefined set of vCenter Server workflows are available by default in the pop-up menu. You
can associate additional workflows with each vSphere object. See “Associate Workflows with vSphere
Inventory Object Types,” on page 200.

Cluster and Compute Resource Workflows

With cluster and compute resource workflows, you can create, rename or delete a cluster, and enable or disable
high availability on a cluster.

Add DRS virtual machine  Adds a DRS virtual machine group to a cluster.
group to cluster

Add virtual machines to Adds a virtual machine list to an existing DRS virtual machine group.

DRS group
Create cluster Creates a new cluster in a host folder.
Delete cluster Deletes a cluster.

Disable DRS on cluster Disables DRS on a cluster.

Disable HA on cluster Disables high availability on a cluster.
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Enable DRS on cluster
Enable HA on cluster

Remove virtual machine
DRS group from cluster

Remove virtual
machines from DRS

group

Rename cluster

Enables DRS on a cluster.
Enables high availability on a cluster.

Removes a DRS virtual machine group from a cluster.

Removes virtual machines from a cluster DRS group.

Renames a cluster.

Guest Operation Files Workflows

With guest operation files workflows, you can manage files in a guest operating system.

Check for directory in
guest

Check for file in guest

Copy file from guest to
Orchestrator

Copy file from
Orchestrator to guest

Create directory in guest

Create temporary
directory in guest

Create temporary file in
guest

Delete directory in guest
Delete file in guest

List path in guest

Move directory in guest

Move file in guest

Verifies that a directory exists in a guest virtual machine.

Verifies that a file exists in a guest virtual machine.

Copies a specified file from a guest file system to an Orchestrator server.

Copies a specified file from an Orchestrator server to a guest file system.

Creates a directory in a guest virtual machine.

Creates a temporary directory in a guest virtual machine.

Creates a temporary file in a guest virtual machine.

Deletes a directory from a guest virtual machine.
Deletes a file from a guest virtual machine.
Shows a path in a guest virtual machine.

Moves a directory in a guest virtual machine.

Moves a file in a guest virtual machine.

Guest Operation Processes Workflows

With guest operation processes workflows, you can get information and control the running processes in a

guest operating system.

Get environment
variables from guest

Get processes from
guest

Run program in guest

Stop process in guest

Returns a list with environmental variables from a guest. An interactive session
returns the variables of the user who is currently logged in.

Returns a list with the processes running in the guest operating system and the
recently completed processes started by the API.

Starts a program in a guest operating system.

Stops a process in a guest operating system.
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Custom Attributes Workflows

With custom attributes workflows, you can add custom attributes to virtual machines or get a custom attribute
for a virtual machine.

Add custom attribute to Adds a custom attribute to a virtual machine.
a virtual machine

Add custom attribute to Adds a custom attribute to a selection of virtual machines.
multiple virtual

machines

Get custom attribute Gets a custom attribute for a virtual machine in vCenter Server.

Datacenter Workflows

With datacenter workflows, you can create, delete, reload, rename, or rescan a datacenter.

Create datacenter Creates a new datacenter in a datacenter folder.

Delete datacenter Deletes a datacenter.

Reload datacenter Forces vCenter Server to reload data from a datacenter.

Rename datacenter Renames a datacenter and waits for the task to complete.

Rescan datacenter Scans the hosts in a datacenter and initiates a rescan on the host bus adapters
HBAs to discover new storage.

Datastore and Files Workflows

With datastore and files workflows, you can delete a list of files, find unused files in a datastore, and so on.

Delete all files Deletes a list of files.
Delete all unused Searches all datastores in the vCenter Server environment and deletes all
datastore files unused files.

Export unused datastore Searches all datastores and creates an XML descriptor file that lists all unused

files files.
Find unused files in Searches the vCenter Server environment for all unused disks (* . vmdk), virtual
datastores machines (*.vmx), and template (*.vmtx) files that are not associated with any

vCenter Server instances registered with Orchestrator.

Get all configuration, Creates a list of all virtual machine descriptor files and a list of all virtual
template, and disk files machine disk files, for all datastores.
from virtual machines

Log all datastore files Creates a log for every virtual machine configuration file and every virtual
machine file found in all datastores.

Log unused datastore Searches the vCenter Server environment for unused files that are registered
files on virtual machines and exports a log of the files in a text file.
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Datacenter Folder Management Workflows
With datacenter folder management workflows, you can create, delete, or rename a datacenter folder.
Create datacenter folder Creates a datacenter folder.
Delete datacenter folder Deletes a datacenter folder and waits for the task to complete.

Rename datacenter Renames a datacenter folder and waits for the task to complete.
folder

Host Folder Management Workflows

With host folder management workflows, you can create, delete, or rename a host folder.

Create host folder Creates a host folder.
Delete host folder Deletes a host folder and waits for the task to complete.
Rename host folder Renames a host folder and waits for the task to complete.

Virtual Machine Folder Management Workflows

With virtual machine folder management workflows, you can create, delete, or rename a virtual machine

folder.

Create virtual machine Creates a virtual machine folder.

folder

Delete virtual machine Deletes a virtual machine folder and waits for the task to complete.
folder

Rename virtual machine  Renames a virtual machine folder and waits for the task to complete.
folder

Basic Host Management Workflows

With basic host management workflows, you can put a host into maintenance mode, make a host exit
maintenance mode, move a host to a folder or a cluster, and reload data from a host.

Enter maintenance Puts the host into maintenance mode. You can cancel the task.

mode

Exit maintenance mode Exits maintenance mode. You can cancel the task.

Move host to cluster Moves an existing host into a cluster. The host must be part of the same
datacenter, and if the host is part of a cluster, the host must be in maintenance
mode.

Move host to folder Moves a host into a folder as a standalone host. The host must be part of a

ClusterComputeResource in the same datacenter and the host must be in
maintenance mode.

Reload host Forces vCenter Server to reload data from a host.
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Host Power Management Workflows

With host power management workflows you can reboot or shut down a host.

Reboot host

Shut down host

Reboots a host. If the Orchestrator client is connected directly to the host, it
does not receive an indication of success in the returned task, but rather loses
the connection to the host if the operation succeeds.

Shuts down a host. If the Orchestrator client is connected directly to the host,
it does not receive an indication of success in the returned task, but rather loses
the connection to the host if the operation succeeds.

Host Registration Management Workflows

With host registration management workflows, you can add a host to a cluster, disconnect or reconnect a host

from a cluster, and so on.

Add host to cluster

Add standalone host
Disconnect host
Reconnect host

Reconnect host with all
information

Remove host

Networking Workflows

Adds a host to the cluster. This workflow fails if it cannot authenticate the SSL
certificate of the host.

Registers a host as a standalone host.
Disconnects a host from vCenter Server.
Reconnects a disconnected host by providing only the host information.

Reconnects a disconnected host by providing all information about the host.

Removes a host and unregisters it from vCenter Server. If the host is part of a
cluster, you must put it in maintenance mode before attempting to remove it.

With networking workflows you can add a port group to distributed virtual switch, create a distributed virtual
switch with a port group, and so on.

Add port group to
distributed virtual switch

Attach host system to
distributed virtual switch

Create distributed virtual
switch with port group

Adds a new distributed virtual port group to a specified distributed virtual
switch.

Adds a host to a distributed virtual switch.

Creates a new distributed virtual switch with a distributed virtual port group.

Distributed Virtual Port Group Workflows

With distributed virtual port group workflows you can update or delete a port group, and reconfigure the port

group.

Connect virtual machine
NIC number to
distributed virtual port
group

Delete distributed virtual
port group
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Reconfigures the network connection of the specified virtual machine NIC
number to connect to the specified distributed virtual port group. If no NIC
number is specified, the number zero is used.

Deletes a specified distributed virtual port group.
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Set teaming options

Update distributed
virtual port group

Provides an interface to manage the teaming options for a distributed virtual
port group.

Updates the configuration of a specified distributed virtual port group.

Distributed Virtual Switch Workflows

With distributed virtual switch workflows, you can create, update or delete a distributed virtual switch, and
create, delete, or update a private VLAN.

Create distributed virtual
switch

Create private VLAN

Delete distributed virtual
switch

Delete private VLAN

Update distributed
virtual switch

Update private VLAN

Creates a distributed virtual switch in the specified network folder with aname
and uplink port names that you specify. You must specify at least one uplink
port name.

Creates a VLAN on the specified distributed virtual switch.

Deletes a distributed virtual switch and all associated elements.
Deletes a VLAN from a specified distributed virtual switch. If a secondary
VLAN exists, you should first delete the secondary VLAN.

Updates the properties of a distributed virtual switch.

Updates a VLAN on the specified distributed virtual switch.

Standard Virtual Switch Workflows

With standard virtual switch workflows you can create, update, or delete a standard virtual switch, and create,

delete, or update port groups in standard virtual switches.

Add port group in
standard virtual switch

Create standard virtual
switch

Delete port group from
standard virtual switch

Delete standard virtual
switch

Retrieve all standard
virtual switches

Update port group in
standard virtual switch

Update standard virtual
switch

Update VNIC for port
group in standard virtual
switch

Adds a port group in a standard virtual switch.

Creates a standard virtual switch.

Deletes a port group from a standard virtual switch.

Deletes a standard virtual switch from a host's network configuration.

Retrieves all standard virtual switches from a host.

Updates the properties of a port group in a standard virtual switch.

Updates the properties of a standard virtual switch.

Updates a VNIC associated with a port group in a standard virtual switch.
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Resource Pool Workflows

With resource pool workflows you can create, rename, reconfigure or delete a resource pool, and get resource

pool information.

Create resource pool

Create resource pool
with specified values

Delete resource pool

Get resource pool
information

Reconfigure resource
pool

Rename resource pool

Storage Workflows

Creates a resource pool with the default CPU and memory allocation values.
To create a resource pool in a cluster, the cluster must have VMware DRS
enabled.

Creates a resource pool with CPU and memory allocation values that you
specify. To create a resource pool in a cluster, the cluster must have VMware
DRS enabled.

Deletes a resource pool and waits for the task to complete.

Returns CPU and memory information about a given resource pool.

Reconfigures CPU and memory allocation configuration for a given resource
pool.

Renames a resource pool and waits for the task to complete.

With storage workflows you can perform storage-related operations.

Add datastore on
iSCSI/FC/local SCSI

Add datastore on NFS
Add iSCSI target

Create VMFS for all
available disks

Delete datastore

Delete iSCSI target

Disable iSCSI adapter

Display all datastores
and disks

Enable iSCSI adapter

List all storage adapters
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Creates a datastore on a Fibre Channel, iSCSI or local SCSI disk. Only disks that
are not currently in use by an existing VMFS are applicable to new datastore
creation. The new datastore allocates the maximum available space of the
specified disk.

Adds a datastore on an NFS server.

Adds iSCSI targets to a vCenter Server host. The targets can be of the type
Send or Static.

Creates a VMFS volume for all available disks of a specified host.

Deletes datastores from a vCenter Server host.

Deletes already configured iSCSI targets. The targets can be of type Send or
Static.

Disables the software iSCSI adapter of a specified host.

Displays the existing datastores and available disks on a specified host.

Enables an iSCSI adapter.

Lists all storage adapters of a specified host.
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Storage DRS Workflows

With storage DRS workflows you perform storage-related operations, such as creating and configuring a
datastore cluster, removing a datastore from cluster, adding storage to a cluster, and so on.

Add datastore to cluster Adds datastores to a datastore cluster. Datastores must be able to connect to
all hosts to be included in the datastore cluster. Datastores must have the same
connection type to reside within a datastore cluster.

Change Storage DRS per  Sets Storage DRS settings for each virtual machine.
virtual machine
configuration

Configure datastore Configures datastore cluster setting values for automation and runtime rules.
cluster

Create simple datastore Creates a simple datastore cluster with default configuration. The new

cluster datastore cluster contains no datastores.

Create Storage DRS Creates a scheduled task for reconfiguring a datastore cluster. Only automation
scheduled task and runtime rules can be set.

Create virtual machine Creates an anti-affinity rule to indicate that all virtual disks of certain virtual
anti-affinity rule machines must be kept on different datastores.

Create VMDK anti- Creates a VMDK anti-affinity rule for a virtual machine that indicates which
affinity rule of its virtual disks must be kept on different datastores. The rule applies to the

virtual disks of the selected virtual machine.

Remove datastore Removes a datastore cluster. Removing a datastore cluster also removes all of
cluster the settings and the alarms for the cluster from the vCenter Server system.
Remove datastore from Removes a datastore from a datastore cluster and puts the datastore in a
cluster datastore folder.

Remove Storage DRS Removes a scheduled Storage DRS task.

scheduled task

Remove virtual machine Removes a virtual machine anti-affinity rule for a given datastore cluster.
anti-affinity rule

Remove VMDK anti- Removes a VMDK anti-affinity rule for a given datastore cluster.
affinity rule

Basic Virtual Machine Management Workflows

With basic virtual machine management workflows you can perform basic operations on virtual machines, for
example, create, rename or delete a virtual machine, upgrade virtual hardware, and so on.

Create custom virtual Creates a virtual machine with the specified configuration options and
machine additional devices.

Create simple Creates a simple virtual machine. The network used is a Distributed Virtual
dvPortGroup virtual Port Group.

machine

Create simple virtual Creates a virtual machine with the most common devices and configuration
machine options.

Delete virtual machine Removes a virtual machine from the inventory and datastore.
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Get virtual machines by Returns a list of virtual machines from all registered vCenter Server hosts that
name match the provided expression.
Mark as template Converts an existing virtual machine to a template, not allowing it to start. You

can use templates to create virtual machines.
Mark as virtual machine Converts an existing template to a virtual machine, allowing it to start.

Move virtual machine to Moves a virtual machine to a specified virtual machine folder.

folder
Move virtual machine to Moves a virtual machine to a resource pool. If the target resource pool is not in
resource pool the same cluster, you must use the migrate or relocate workflows.

Move virtual machines to Moves several virtual machines to a specified virtual machine folder.
folder

Move virtual machinesto  Moves several virtual machines to a resource pool.
resource pool

Register virtual machine Registers a virtual machine. The virtual machine files must be placed in an
existing datastore and must not be already registered.

Reload virtual machine Forces vCenter Server to reload a virtual machine.

Rename virtual machine Renames an existing virtual machine on the vCenter Server system or host and
not on the datastore.

Set virtual machine Changes performance settings such as shares, minimum and maximum values,
performance shaping for network, and disk access of a virtual machine.

Unregister virtual Removes an existing virtual machine from the inventory.

machine

Upgrade virtual machine  Upgrades the virtual machine hardware to the latest revision that the host

hardware (force if supports. This workflow forces the upgrade to continue, even if VMware Tools

required) is out of date. If the VMware Tools is out of date, forcing the upgrade to
continue reverts the guest network settings to the default settings. To avoid
this situation, upgrade VMware Tools before running the workflow.

Upgrade virtual machine  Upgrades the virtual hardware to the latest revision that the host supports. An
input parameter allows a forced upgrade even if VMware Tools is out of date.

Wait for task and answer ~ Waits for a vCenter Server task to complete or for the virtual machine to ask a
virtual machine question  question. If the virtual machine requires an answer, accepts user input and
answers the question.

Clone Workflows

With clone workflows you can clone virtual machines with or without customizing the virtual machine
properties.

Clone virtual machine Clones virtual machines by using properties as input parameters.
from properties

Clone virtual machine, Clones a virtual machine without changing anything except the virtual
no customization machine UUID.
Customize virtual Customizes a virtual machine by using properties as input parameters.

machine from properties

VMware, Inc. 215



vCenter Server and Host Management

216

Linked Clone Workflows

With linked clone workflows, you can perform linked clone operations such as restoring a virtual machine

from a linked clone, creating a linked clone, and so on.

Restore virtual machine
from linked clone

Set up virtual machine
for linked clone

Create a linked clone of a
Linux machine with
multiple NICs

Create alinked clone of a
Linux machine with a
single NIC

Create a linked clone of a
Windows machine with
multiple NICs and
credential

Create alinked clone of a
Windows machine with a
single NIC and credential

Create a linked clone
with no customization

Removes a virtual machine from a linked clone setup.

Prepares a virtual machine to be link cloned.

Creates a linked clone of a Linux virtual machine, performs the guest operating
system customization, and configures up to four virtual network cards.

Creates a linked clone of a Linux virtual machine, performs the guest operating
system customization, and configures one virtual network card.

Creates a linked clone of a Windows virtual machine and performs the guest
operating system customization. Configures up to four virtual network cards
and a local administrator user account.

Creates a linked clone of a Windows virtual machine and performs the guest
operating system customization. Configures one virtual network card and a
local administrator user account.

Creates the specified number of linked clones of a virtual machine.

Linux Customization Clone Workflows

With Linux customization workflows you can clone a Linux virtual machine and customize the guest operating

system.

Clone a Linux machine
with multiple NICs

Clone a Linux machine
with a single NIC

Tools Clone Workflows

Clones a Linux virtual machine, performs the guest operating system
customization, and configures up to four virtual network cards.

Clones a Linux virtual machine, performs the guest operating system
customization, and configures one virtual network card.

With tools clone workflows you can obtain customization information about the operating system of the virtual

machine, information needed to update a virtual device, and so on.

Get a virtual Ethernet
card to change the
network

Get Linux customization

Get multiple virtual
Ethernet card device
changes

Returns anew ethernet card to update a virtual device. Contains only the device
key of the given virtual device and the new network.

Returns the Linux customization preparation.

Returns an array of VirtualDeviceConfigSpec objects for add and remove
operations on VirtualEthernetCard objects.
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Get NIC setting map

Get Windows
customization for
Sysprep with credentials

Get Windows
customization for
Sysprep with
Unattended.txt

Get Windows
customization for

Sysprep
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Returns the setting map for a virtual network card by using
VimAdapterMapping.

Returns customization information about the Microsoft Sysprep process, with
credentials. Workflows for cloning Windows virtual machines use this
workflow.

Returns customization information about the Microsoft Sysprep process by
using an Unattended.txt file. Workflows for cloning Windows virtual machines
use this workflow.

Returns customization information about the Microsoft Sysprep process.
Workflows for cloning Windows virtual machines use this workflow.

Windows Customization Clone Workflows

With Windows customization clone workflows you can clone Windows virtual machines and customize the

guest operating system.

Customize a Windows
machine with single NIC
and credential

Clone a thin provisioned
Windows machine with
single NIC and credential

Clone a Windows
machine Sysprep with
single NIC and credential

Clone a Windows
machine with multiple
NICs and credential

Clone a Windows
machine with single NIC

Clone a Windows
machine with single NIC
and credential

Performs guest operating system customization, configures one virtual
network card and a local administrator user account on a Windows virtual
machine.

Clones a Windows virtual machine performing the guest operating system
customization. Specifies virtual disk thin provisioning policy and configures
one virtual network card and a local administrator user account. Sysprep tools
must be available on the vCenter Server system.

Clones a Windows virtual machine performing the guest operating system
customization. Configures one virtual network card and a local administrator
user account. Sysprep tools must be available on vCenter Server.

Clones a Windows virtual machine performing the guest operating system
customization. Configures the local administrator user account and up to four
virtual network cards. Sysprep tools must be available on the vCenter Server
system.

Clones a Windows virtual machine performing the guest operating system
customization and configures one virtual network card. Sysprep tools must be
available on the vCenter Server system.

Clones a Windows virtual machine performing the guest operating system
customization. Configures one virtual network card and a local administrator
user account. Sysprep tools must be available on the vCenter Server system.

Device Management Workflows

With device management workflows you can manage the devices that are connected to a virtual machine or

to a host datastore.

Add CD-ROM

Add disk
Change RAM
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Adds a virtual CD-ROM to a virtual machine. If the virtual machine has no IDE
controller, the workflow creates one.

Adds a virtual disk to a virtual machine.

Changes the amount of RAM of a virtual machine.
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Convert disks to thin
provisioning

Convert independent
disks

Disconnect all
detachable devices from
a running virtual
machine

Mount floppy disk drive

Converts thick-provisioned disks of virtual machines to thin-provisioned
disks.

Converts all independent virtual machine disks to normal disks by removing
the independent flag from the disks.

Disconnects floppy disks, CD-ROM drives, parallel ports, and serial ports from
a running virtual machine.

Mounts a floppy disk drive FLP file from the ESX datastore.

Move and Migrate Workflows

With move and migrate workflows, you can migrate virtual machines.

Mass migrate virtual
machines with storage
vMotion

Mass migrate virtual
machines with vMotion

Migrate virtual machine
with vMotion

Move virtual machine to
another vCenter Server
system

Quick migrate multiple
virtual machines

Quick migrate virtual
machine

Relocate virtual machine
disks

Other Workflows

Uses Storage vMotion to migrate a single virtual machine, a selection of virtual
machines, or all available virtual machines.

Uses vMotion, Storage vMotion, or both vMotion and Storage vMotion to
migrate a single virtual machine, a selection of virtual machines, or all available
virtual machines.

Migrates a virtual machine from one host to another by using the
MigrateVM_Task operation from the vSphere APL

Moves a list of virtual machines to another vCenter Server system.

Suspends the virtual machines if they are powered on and migrates them to
another host using the same storage.

Suspends the virtual machine if it is powered on and migrates it to another host
using the same storage.

Relocates virtual machine disks to another host or datastore while the virtual
machine is powered off by using the RelocateVM_Task operation from the
vSphere APL

With other workflows, you can enable and disable Fault Tolerance (FT), extract virtual machine information,
and find orphaned virtual machines.

Disable FT
Enable FT

Extract virtual machine
information

Find orphaned virtual
machines

Disables Fault Tolerance for a specified virtual machine.
Enables Fault Tolerance for a specified virtual machine.

Returns the virtual machine folder, host system, resource pool, compute
resource, datastore, hard drive sizes, CPU and memory, network, and IP
address for a given virtual machine. Might require VMware Tools.

Lists all virtual machines in an orphaned state in the Orchestrator inventory.
Lists the VMDK and VMTX files for all datastores in the Orchestrator inventory
that have no association with any virtual machines in the Orchestrator
inventory. Sends the lists by email (optional).
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Power Management Workflows

With power management workflows, you can power on and off virtual machines, reboot the guest operating

system of a virtual machine, suspend a virtual machine, and so on.

Power off virtual
machine and wait

Reboot guest OS

Reset virtual machine
and wait

Resume virtual machine
and wait

Set guest OS to standby
mode

Shut down and delete
virtual machine

Shut down guest OS and
wait
Start virtual machine and
wait

Suspend virtual machine
and wait

Snapshot Workflows

Powers off a virtual machine and waits for the process to complete.

Reboots the virtual machine's guest operating system. Does not reset
nonpersistent virtual machines. VMware Tools must be running.

Resets a virtual machine and waits for the process to complete.

Resumes a suspended virtual machine and waits for the process to complete.
Sets the guest operating system to standby mode. VMware Tools must be
running.

Shuts down a virtual machine and deletes it from the inventory and disk.
Shuts down a guest operating system and waits for the process to complete.

Starts a virtual machine and waits for VMware Tools to start.

Suspends a virtual machine and waits for the process to complete.

With snapshot workflows, you can perform snapshot-related operations.

Create a snapshot

Create snapshots of all
virtual machines in a
resource pool

Remove all snapshots

Remove excess
snapshots

Remove old shapshots

Remove snhapshots of a
given size

Revert to current
snapshot

Revert to snapshot and
wait
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Creates a snapshot.

Creates a snapshot of each virtual machine in a resource pool.

Removes all existing snapshots without reverting to a previous snapshot.

Finds virtual machines with more than a given number of snapshots and
optionally deletes the oldest snapshots. Sends the results by email.

Gets all snapshots that are older than a given number of days and prompts the
user to select which ones to delete.

Gets all snapshots that are larger than a given size and prompts the user to
confirm deletion.

Reverts to the current snapshot.

Reverts to a specific snapshot. Does not delete the snapshot.
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VMware Tools Workflows

With VMware Tools workflows, you can perform VMware Tools-related tasks on virtual machines.

Mount VMware tools
installer

Set console screen
resolution

Turn on time
synchronization

Unmount VMware tools
installer

Upgrade VMware tools

Upgrade VMware tools at
next reboot

Mounts the VMware Tools installer on the virtual CD-ROM.

Sets the console window's resolution. The virtual machine must be powered
on.

Turns on time synchronization between the virtual machine and the ESX server
in VMware Tools.

Unmounts the VMware Tools CD-ROM.
Upgrades VMware Tools on a virtual machine.

Upgrades VMware Tools on a virtual machine without performing an
automatic reboot.
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